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Preface

Code Generation describes how to use the code generation components of NaturalONE to generate
Natural modules in Eclipse.

This documentation is intended for developers who are familiar with NaturalONE and want to
use the code generation components to create Natural subprograms and their corresponding data
areas locally.

Code Generation covers the following topics:

Contains information about this release of the CodeGeneration andNatural
Construct components for NaturalONE.

Release Notes

Describes how to use the Code Generation wizards to generate and
regenerate Natural subprograms and their associated modules.

Using the Code Generation
Component

Describes how to use the Natural Construct client generation wizards to
generate and regenerateNatural Construct subprograms and their associated

Using Natural Construct

modules. It also describes how tomaintainNatural Construct (for example,
to define a new model, model user interface or code frame).

Note: You must have Natural Construct installed in a server environment
to use this component.

Describes the user exits generated by the code generation and Natural
Construct wizards, and how to define them.

Defining User Exits

Describes how to generate an Ajax page for a subprogram generated by
either the Object-Browse-Subp or Object-Maint-Subp wizards.

Generating an Ajax Page for
Generated Subprograms

v
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I Release Notes

These Release Notes pertain to the Code Generation and Natural Construct components of
NaturalONE version 8.2. The following topics are covered:

What's New in Version 8.2.1

What's New in Version 8.2.2

What's New in Version 8.2.3

What's New in Version 8.2.4

What's New in Version 8.2.5

What's New in Version 8.2.6

What's New in Version 8.2.7

1
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1 What's New in Version 8.2.1

■ Enhancements ................................................................................................................................. 4
■ Fixes .............................................................................................................................................. 4
■ Known Issues ................................................................................................................................... 5
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This section describes the new features for the CodeGeneration andNatural Construct components
in version 8.2.1. The following topics are covered:

Enhancements

This section describes the new features for theCodeGeneration andNatural Construct components.
The following topics are covered:

■ Natural Server View
■ Natural Construct Integration

Natural Server View

TheAdd from Serverwizard has been replaced with standardNatural Server view functionality.
You can now add server resources to a local project directly from theNatural Server view. For
information, see Download Natural Construct Resources to a Local Project.

Natural Construct Integration

This release of Code Generation for NaturalONE provides Natural Construct integration. You can
now define and generate many of the standard Natural Construct modules on the client. You can
also access features of the Natural Construct Administration subsystem, such as defining a new
model or code frame. For information, see Natural Construct Administration.

Notes:

1. To use the Natural Construct component, a current version of Natural Construct must be
available on the server.

2. The online help and documentation for the Natural Construct component was not finalized
before this release.

Fixes

This section describes the bug fixes in this release of the Code Generation and Natural Construct
components. The following topics are covered:

Code Generation4
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■ Test Subprograms in Projects that Reference the Construct Runtime Project

Test Subprograms in Projects that Reference the Construct Runtime Project

When testing a subprogram in a project that contains generated objects that reference the Construct
runtime project, the runtime project was not searched and an error was displayed. This problem
has been fixed.

Known Issues

This section describes the known issues in this release of theCodeGeneration andNatural Construct
components. The following topics are covered:

■ Check Predict for Additional Metadata Option

Check Predict for Additional Metadata Option

When the Check Predict for additional metadata option is selected on the Code Generation >
Natural preferences panel, somewizardsmay appear to respond slowlywhen you select a button.
This happenswhenPredict data is being downloadedusing the connectiondefined in theProperties
window for the Natural project. If you have a slow network connection, sometimes it may appear
as if Eclipse is frozen.

5Code Generation
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2 What's New in Version 8.2.2

■ Enhancements for the Natural Construct Component ............................................................................... 8
■ Known Issues ................................................................................................................................... 9
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This section describes the new features for the CodeGeneration andNatural Construct components
in version 8.2.2. The following topics are covered:

Enhancements for the Natural Construct Component

This section describes the new features for theNatural Construct component. The following topics
are covered:

■ New GUI Controls, Nodes, and Attributes in the Client Generation Framework
■ Use an Existing Model UI File to Create a New Model UI File
■ Perform Actions on Natural Construct Resources
■ Set New Natural Construct Preferences
■ Select Generation/Regeneration Options
■ View Code Frame Editor Statements in Outline View
■ Generate NATdoc Documentation

New GUI Controls, Nodes, and Attributes in the Client Generation Framework

There are new nodes, attributes andGUI controls for the client generation framework. For inform-
ation, see Page Node, Dialog Node, and GUI Controls.

Use an Existing Model UI File to Create a New Model UI File

A new option is available to copy an existing model user interface file and use it to create a new
model UI file. For information, see Copy a Model UI File.

Perform Actions on Natural Construct Resources

You can now use theNatural Server view to perform standard actions on Natural Construct re-
sources on the server. For information, see Perform Standard Actions on Natural Construct Re-
sources.

Set New Natural Construct Preferences

TheConstructPreferenceswindownowallowsyou todefine generation anddownloadpreferences.
For information, see Set Construct Preferences.

Code Generation8
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Select Generation/Regeneration Options

When generating or regenerating Natural Construct resources, you can select options in the new
Generation Optionswindow. For information, see Generation Options.

View Code Frame Editor Statements in Outline View

When editing a code frame in the code frame editor, theOutline view nowdisplays themain code
frame lines in a tree view, using the condition codes to determine the parent/child relationships.
For information, see View a Code Frame in the Outline View.

Generate NATdoc Documentation

While using the client generationwizards to generate subprograms, thewizards can also generate
NATdoc documentation that can be used for Eclipse help. For information, see Generate NATdoc
Documentation.

Known Issues

This section describes the known issues in this release of theCodeGeneration andNatural Construct
components. The following topics are covered:

■ Support for NATdoc Generation and Custom Models

Support for NATdoc Generation and Custom Models

To support the generation of NATdoc documentation, Natural Construct 5.3.1 SP9 now uses the
last condition code defined for a model to determine whether NATdoc documentation will be
generated. If you have custom models that use all 75 condition codes, you will encounter issues
using the NATdoc feature.

9Code Generation
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3 What's New in Version 8.2.3

■ Enhancements for the Code Generation Component .............................................................................. 12
■ Enhancements for the Natural Construct Component .............................................................................. 12
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This section describes the new features for the CodeGeneration andNatural Construct components
in version 8.2.3. The following topics are covered:

Enhancements for the Code Generation Component

This section describes the new features for theCodeGeneration andNatural Construct components.
The following topics are covered:

■ Changes to the REQUEST-DOCUMENT Client Code Generator

Changes to the REQUEST-DOCUMENT Client Code Generator

You can now define which special characters are translated in and out of data being passed via
theREQUEST-DOCUMENTsubprogram. The search and replace values are now initialized outside
of the REQUEST-DOCUMENT code within a module called CDXMLSU2. This makes it easier to
make site-wide changes to substitution characters for all generated REQUEST-DOCUMENT sub-
programs. For information, see Define XML Substitution Characters.

Note: To provide customizations for a single REQUEST-DOCUMENT subprogram, use the
re-located substitution user exit.

To incorporate changes to the REQUEST-DOCUMENT Client code generator, the CDXMLSU2
andCDRDOCA2are suppliedwith the client and server runtimes (SYSTEM library). If theConstruct
runtime project is currently installed in your client environment, you must update the project to
install the newmodules. For information, seeUpdate the Construct Runtime Project to the Latest
Version.

Enhancements for the Natural Construct Component

This section describes the new features for theNatural Construct component. The following topics
are covered:

■ New Options for Tables in the Client Generation Framework

Code Generation12
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■ Online Help Available for all Browse/Browse-Select Wizards

New Options for Tables in the Client Generation Framework

There are new options for the cstTable control in the client generation framework. For example,
you can now detect empty rows within a table and/or create tables with multi dimensions. For
information, see cstTable.

Online Help Available for all Browse/Browse-Select Wizards

Online help is now available for all panels used by the Browse/Browse-Select series of wizards.

13Code Generation
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4 What's New in Version 8.2.4

■ Prerequisites .................................................................................................................................. 16
■ General Enhancements .................................................................................................................... 16
■ Enhancements for the Natural Construct Component .............................................................................. 16

15



This section describes the new features for the CodeGeneration andNatural Construct components
in version 8.2.4. The following topics are covered:

Prerequisites

This version of Code Generation requires Natural Business Services version 5.3.1 SP 11.

General Enhancements

This section describes the new features for both Code Generation components. The following
topics are covered:

Generate an Ajax Page for an Object-Browse or Object-Maint Subprogram

You can now generate an Ajax page for any subprogram generated by the following wizards:

■ Object Browse (Object-Browse-N1 generator)
■ Object-Browse-Subp
■ Object Maint (Object-Maint-N1 generator)
■ Object-Maint-Subp

For information, see Generating an Ajax Page for Generated Subprograms.

Enhancements for the Natural Construct Component

This section describes the new features for theNatural Construct component. The following topics
are covered:

■ Create Reusable Dialogs and Pages for the Client Generation Framework
■ Set Up Server Calls
■ Set New Natural Construct Preferences
■ Documentation and Online Help Available for the Object-Browse-Subp and Object-Maint-Subp Wizards
■ Changes to the Object-Browse-Select-Subp Wizard

Code Generation16
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■ New Attribute for cstTable Control

Create Reusable Dialogs and Pages for the Client Generation Framework

The Natural Construct client generation framework now supports reusable dialogs and pages.
These user interface (UI) files eliminate the duplication of UI code when more than one wizard
uses the same dialog or page, as well as reduce future maintenance requirements. You can now
create dialog (.cstmdldg) and page (.cstmdlpg) UI code as separate files that can be included in
multiple model UI files. This allows changes to the dialog or page UI code to be automatically re-
flected in any client generation wizard that includes the dialog or page UI file. For information,
see Reusable Dialog and Page UI Files.

Set Up Server Calls

Using the client generation framework, you can now set values for fields in the parameter data
area (PDA) when a wizard panel is left or entered. You can also set values or derive other data
from the server when a button (cstDeriveServerButton GUI control) is selected on a wizard panel.
For information, see Set Up a Server Call.

Set New Natural Construct Preferences

The Construct Preferenceswindow now allows you to set preferences to cache the results of the
server call by the clear subprogram when starting a client generation wizard. This allows the
wizard to start faster on subsequent calls to the same clear subprogram. For information, see Set
Construct Preferences.

You can also use the new Installation preference window to control whether the Natural server
is checked for a Natural Construct installation at startup or whether UI functions are visible or
not (for example, context menu actions andNatural Server view nodes), based on the availability
of Natural Construct on the Natural server. For information, see Set Installation Preferences.

Documentation andOnline Help Available for the Object-Browse-Subp andObject-Maint-SubpWizards

Documentation and online help is now available for all panels used by the Object-Browse-Subp
and Object-Maint-Subp wizards.

■ For information about the Object-Browse-Subp wizard, seeObject-Browse-Subp Wizard.
■ For information about the Object-Maint-Subp wizard, seeObject-Maint-Subp Wizard.

17Code Generation
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Changes to the Object-Browse-Select-Subp Wizard

When you selectNext on the first specification panel for the Object-Browse-Select-Subp wizard
and the name of the object-browse subprogram has changed, a call is now made to retrieve the
appropriate methods based on the new subprogram. In addition, the second specification panel
now contains a button that will issue this call to refresh the list of methods.

Note: Natural Business Services version 5.3.1 SP 11 is required for this functionality.

New Attribute for cstTable Control

Anew attribute is available for the cstTable control in the client generation framework. This attrib-
ute, called editOnly, limits users to the edit action for rows in a table; they cannot add or delete
rows. For information, see cstTable.
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■ General Enhancements .................................................................................................................... 20
■ Enhancements for the Natural Construct Component .............................................................................. 20
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This section describes the new features for the CodeGeneration andNatural Construct components
in version 8.2.5. The following topics are covered:

General Enhancements

This section describes the new features for both Code Generation components. The following
topics are covered:

■ Generate Modules into Folders
■ New User Exits for the Request-Document Wizard

Generate Modules into Folders

You can now specify a folder name when using the Velocity-based, Construct, and Ajax code
generation wizards. For information, see:

■ For each Velocity-based wizard, see the applicable subsection in Using the Code Generation
Component

■ For each Construct wizard, see the applicable subsection in either this guide (CommonWizard
Specifications and Development Tasks) or Natural Construct Generation

■ For the Ajax Main Program wizard, seeGenerate an Ajax Main Program from an Adapter File

New User Exits for the Request-Document Wizard

Two new user exits are available for the Request-Document wizard to allow modifications to the
standard search and replace array. For information, seeUser Exits for the REQUEST-DOCUMENT
Subprogram.

Enhancements for the Natural Construct Component

This section describes the new features for theNatural Construct component. The following topics
are covered:

■ Changes to the Construct Runtime Project

Code Generation20
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■ Documentation and Online Help Available for the Object-Browse-Dialog and Object-Maint-Dialog
Wizards

Changes to the Construct Runtime Project

The version information for the local Construct runtime project can now be compared with the
version information delivered in the Construct runtime project and the project can be updated
when required. By default, the version information is checked at startup and when generating/re-
generating new items and you are prompted whether to update the project when the information
has changed. In addition, a new context menu item allows you to add the Construct runtime
project to your workspace manually. For information, see Add the Construct Runtime Project.

To change the default functionality, a new option is available in the Preferenceswindow for
Construct. This option allows you to define whether the project version information is checked
or not and when it is checked. For information, see Set Construct Preferences.

Documentation and Online Help Available for the Object-Browse-Dialog and Object-Maint-Dialog
Wizards

Documentation and online help is now available for all panels used by the Object-Browse-Dialog
and Object-Maint-Dialog wizards.

■ For information about the Object-Browse-Dialog wizard, seeObject-Browse-Dialog Wizard.
■ For information about the Object-Maint-Dialog wizard, seeObject-Maint-Dialog Wizard.

21Code Generation
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6 What's New in Version 8.2.6

■ Enhancements ................................................................................................................................ 24
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This section describes the changes to theCodeGeneration component in version 8.2.6. The following
topics are covered:

Enhancements

This section describes the changes in this release of the CodeGeneration component. The following
topics are covered:

■ Set New Natural Construct Preferences
■ Changes to the Construct Runtime Project

Set New Natural Construct Preferences

The Construct Preferenceswindow now allows you to specify whether code will be formatted
using Struct functionality after generating (or regenerating) using Construct. For information, see
Set Construct Preferences.

Changes to the Construct Runtime Project

This section describes the changes to the Construct runtime project in this version. The following
topics are covered:

■ Build the Construct Runtime Project in a non-Construct Server Environment
■ Enhanced Context Menu and Options

Build the Construct Runtime Project in a non-Construct Server Environment

You can now build the Construct runtime project in server environment that does not have Nat-
ural Construct installed. For information, see Build the Construct Runtime Project in a non-Con-
struct Server Environment.

Enhanced Context Menu and Options

The context menu for the Construct runtime project was enhanced. It is now easier to add, update,
replace or build the project. You can also exclude resources from the update or replace processing,
whichwill protect any changes you'vemade to thesemodules frombeing overwritten. For inform-
ation, see Construct Runtime Project.
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7 What's New in Version 8.2.7

This version contains several error corrections. New functionality is not provided.
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II Using the Code Generation Component

This section describes the CodeGeneration component suppliedwithNaturalONE. The following
topics are covered:

Introduction

Create a REQUEST-DOCUMENT Client

Create an Object-Maintenance Process

Create an Object-Browse Process

Create an Object Skeleton Subprogram

Regenerate Subprograms and Associated Modules

Set Preferences

Customize the Code Generators

27
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8 Introduction

■ Access the Code Generators ............................................................................................................. 30
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This section describes the Code Generation component supplied with NaturalONE and how to
access the code generators. The Code Generation component provides wizards that generate the
following modules:

DescriptionCode GeneratorModules

UsesREQUESTDOCUMENTandPARSE
XML statements to call an external Web
service and interpret the response.

REQUEST-DOCUMENT
Client

REQUEST-DOCUMENT subprogram
and corresponding parameter data
areas

Updates all entities within a Natural
object.

Object MaintObject-maintenance subprogram and
corresponding parameter data areas

Provides the browse functionality for a
Natural object.

Object BrowseObject-browse subprogram and
corresponding parameter data areas

Provides a starting point to create an
object subprogram.

Object SkeletonObject skeleton subprogram

The generated subprograms include a full range of user exits. For information about defining user
exits, see Defining User Exits.

Notes:

1. To install the code generators for NaturalONE, you must select Service Development in the
installation tree for the installer.

2. Although the modules are not generated by Natural Construct, the source code is protected in
the editor lines.

Access the Code Generators

Note: The code generators must be initiated from an existing NaturalONE project in the
NaturalONE perspective. For information, see the NaturalONE documentation.

To access the code generators:

1 Open the context menu in theNavigator view for the NaturalONE project into which you
want to generate the modules.

Or:

Open the context menu in theNavigator view for the library into which youwant to generate
the modules.

2 Select Code Generation.

The code generators are displayed. For example:

Code Generation30
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For information on using the client generation wizards for Natural Construct to generate
modules locally, see Using Natural Construct.
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9 Create a REQUEST-DOCUMENT Client

■ Introduction .................................................................................................................................... 34
■ Generate the REQUEST-DOCUMENT Subprogram ............................................................................... 34
■ User Exits for the REQUEST-DOCUMENT Subprogram ......................................................................... 39
■ Define XML Substitution Characters .................................................................................................... 40
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Introduction

The REQUEST-DOCUMENT Client code generator allows Natural to access Web services by
generating a REQUEST-DOCUMENT subprogram based on a Web service WSDL and XSD. In
addition, the generator creates a subprogram for each operation (method) in the WSDL and
parameter data areas (PDAs) containingparameters that represent the request and response portions
of the Web service operation.

The generated REQUEST-DOCUMENT subprogram uses Natural REQUEST DOCUMENT and
PARSE XML statements to call the Web service and interpret the response. The subprogram then
maps the input parameters to an XML file, which is sent to the Web service via a REQUEST
DOCUMENT statement. The response is verified and parsed in the REQUEST-DOCUMENT
subprogram and the data is placed into the appropriate output parameters of the PDA. In addition,
the generated error PDA informs users of any errors.

Awizard also performs a pre-analysis of theWSDL. If an associated operation requires more than
three dimensions, the operation will be disabled on the selection panel because Natural can only
handle up to three dimensions. The pre-analysis wizard also checks for cyclic types (a type that
is defined in the WSDL and then referenced by another type in the same WSDL). If a cyclic type
is found, all operations that reference it will also be disabled.

You can use a REQUEST-DOCUMENT subprogram to perform various functions, such as retrieve
the current exchange rate for orders, verify that a postal code and address match, or retrieve in-
ventory information from another application (within or outside the company). The generated
subprogram supports Unicode characters, binary arrays and complex structures (arrays of ANY,
detailed arrays, etc.).

Note: To use this feature, the Natural nucleus/profile must be set up to correctly handle
XML. For information, see Activate REQUEST DOCUMENT Statement and Activate PARSE
XML Statement in the Natural documentation.

Generate the REQUEST-DOCUMENT Subprogram

To generate a REQUEST-DOCUMENT subprogram and data areas:

1 Open the context menu in theNavigator view for the NaturalONE project into which you
want to generate the modules.

Or:

Open the context menu in theNavigator view for the library into which youwant to generate
the modules.

Code Generation34
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2 Select Code Generation > New Request Document Client.

TheDefine Request Document Client Details panel is displayed. For example:

Using this panel, you can optionally:

ProcedureTask

Type the name of the project in Project or select Browse to
display a window listing the existing projects for selection. The
project must currently exist.

Select another NaturalONE project
into which to generate the
REQUEST-DOCUMENT client
modules.

Type the name of the folder in Folder or selectBrowse to display
a window listing the existing folders for selection. The folder
must currently exist within the selected NaturalONE project.

Note: This option allows you to generate modules into more
complex library structures (for example, "Natural-Libraries/my

Select a folder into which to generate
the REQUEST-DOCUMENT client
modules.

library (MYLIB)/SRC"). When this option is not specified, the
modules will be generated into the basic library folder (for
example, "Natural-Libraries/MYLIB/SRC",
"Natural-Libraries/MYLIB/Subprograms", etc.).

35Code Generation
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ProcedureTask

Type the prefix in Natural module prefix.

Several Natural modules are created during generation, such
as PDAs, subprogram(s), and LDA(s). This prefix will be used

Assign a prefix to the generated
Natural module names.

as the first character in the module names to help identify them
as belonging to this REQUEST-DOCUMENT client.

SelectOverwrite if exists.Replace an existing subprogramwith
the same name in the same library
with the one you are creating.

3 Type the location of theNatural library intowhich to generate the subprogram and associated
modules in Library.

The library must currently exist.

Or:

Select Browse to display a window listing the existing libraries for selection.

Note: The libraries listed for selection are based on the current project.

4 Type a valid WSDL path (HTTP location) inWSDL location.

Or:

Select Browse to display a window listing WSDL locations for selection.

The code generator will scan the selected WSDL file for each Web service operation and
generate a separate subprogram for each one.

Notes:

1. WSDLs that use SOAP RPC encoding (http://schemas.xmlsoap.org/soap/encoding) are not
supported. SOAP RPC encoding does not conform to the Web Service Interoperability
standards (WS-I). Formore information, refer to http://www.ws-i.org/Profiles/BasicProfile-1.0-
2004-04-16.html#refinement16448072.

2. By default, Refresh is selected and the code generator will retrieve the operations defined
for the Web service. If you do not want the operations retrieved, deselect Refresh.

5 Select Finish to generate the REQUEST-DOCUMENT client with all default operations.

Or:

SelectNext to select which operations to generate.

Code Generation36
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The wizard reads the specifiedWSDL, determines which operations it contains, and displays
theSelectWebServicesOperationspanel, showing the operations defined for theWeb service.
Each operation is represented by a line in a table. For this example, "http://ws.fraud-
labs.com/fraudlabswebservice.asmx?wsdl" was used as the WSDL location:

Note: You can obtain a free licence key to use thisWeb service at http://www.fraudlabs.com.

The Select Web Service Operations panel displays the following details for each operation:

■ Whether a subprogram will be generated (yes)
■ Which operation will be generated (FraudLabs)
■ Which binding will be used (SOAP)
■ What the generated subprogram will be named (FRAUDLAB)

Using this panel, you can optionally:

ProcedureTask

Deselect the operation(s) inGenerate and a REQUEST-DOCUMENT
subprogram will not be generated for that operation. A subprogram
will only be generated for each operation that is selected inGenerate.

Note: A minimum of one operation must be selected.

Suppress the generation of one
or more operations.

37Code Generation
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ProcedureTask

Select another type of binding in Binding.

Note: The wizard defaults to the binding that is appropriate for the
specified WSDL. We recommend that you do not change the default
binding.

Change the type of binding
used.

Type the new name in Subprogram.Change the name of the
subprogram to be generated.

Select Select All. This option allows you to quickly select all
operations.

Select all operations.

SelectDeselect All. This option allows you to quickly deselect all
operations.

Note: A minimum of one operation must be selected.

Deselect all operations.

SelectUse Unicode instead of Alpha fields for data areas. Select this
option if the Web service passes Unicode data. With Natural, this is

Use Unicode format instead of
alphanumeric format for
variables in the data areas. determinedbywhether theNatural server is configured to useUnicode

variables. If the Natural server is not configured to use Unicode, do
not select this option and the generator will generate a
REQUEST-DOCUMENT client that contains no Unicode variables.

Note: This option defaults to the value defined for theGenerate
Unicode Dynamics option in the Preferenceswindow forNatural.
For information, see Set Natural Preferences.

Note: If desired, a Generation Progresswindow can be displayed during generation.
For information, see Set Code Generation Preferences.

6 Select Finish.

After generation, the generated modules are displayed in theNavigator view. For example:

The generated subprogram is displayed in the editor view. For example:
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7 Save the generated modules.

At this point, you can:

■ Use the NaturalONE Testing option to test the subprogram. For information, see Test a
Subprogram Directly in Application Testing.

■ Define user exits for the subprogram. For information, see User Exits for the REQUEST-
DOCUMENT Subprogram.

■ Edit generated source code that is not within user exits. For information about the protected
lines in the generated source code, see Using the Source Editor in Using NaturalONE.

■ Use NaturalONE functionality to upload all generated modules to the server.

User Exits for the REQUEST-DOCUMENT Subprogram

TheOutline view for the REQUEST-DOCUMENT subprogram displays the available user exits.
For example:

39Code Generation

Create a REQUEST-DOCUMENT Client



You can use these exits to define additional processing.

Notes:

1. All user exits are empty when generated.

2. For information about defining user exits, see Defining User Exits.

Define XML Substitution Characters

The generated REQUEST-DOCUMENT subprogram translates special characters (such as xml
tags) in and out of the data it passes. To determine the substitutions for these characters, the RE-
QUEST-DOCUMENTsubprogramuses theCDXMLSU2 subprogramandCDRDOCA2parameter
data area (PDA) in the SYSTEMlibrary. TheREQUEST-DOCUMENTsubprogramcallsCDXMLSU2
to set up the XML substitution characters. Both of these modules are shipped with the Construct
runtime project.

Note: For information about adding this project, see Add the Construct Runtime Project.

The following example shows CDXMLSU2 in the editor view:
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Tip: Within the editor, you can quickly find locations that must be changed by searching
for "/* CUSTOMIZE".

To change settings for the XML substitution characters, use the GENERATE-CODE user exit. For
example:
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In this example, the LOCAL-DATAuser exit defines theNatural format for the #DOUBLE-QUOTE
and #MAX-REPLACEMENTS values and the size of the #REPLACEMENT-TABLE array. The
GENERATE-CODEuser exit resizes the #REPLACEMENT-TABLE array and defines the logic and
substitution values for #DOUBLE-QUOTE.

This section covers the following topics:

■ Add XML Substitution Characters
■ Modify XML Substitution Characters
■ Delete XML Substitution Characters

Add XML Substitution Characters

To add xml substitution characters:

1 Select and open CDXMLSU2 in the Construct runtime project.

2 Increase the size of the #MAX-REPLACEMENTSvalue for the #REPLACEMENT-TABLE array
by "n" in the LOCAL-DATA user exit, where "n" is the number of substitution characters you
are adding.

3 Assign the #SEARCH-STRING and #REPLACE-STRING values and indexes for each substi-
tution character you are adding.

4 Stow the CDXMLSU2 subprogram in the SYSTEM library.
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Modify XML Substitution Characters

To modify xml substitution characters:

1 Select and open CDXMLSU2 in the Construct runtime project.

2 Change the #SEARCH-STRING and #REPLACE-STRING values and indexes for each substi-
tution character you are modifying.

3 Stow the CDXMLSU2 subprogram in the SYSTEM library.

Delete XML Substitution Characters

To delete xml substitution characters:

1 Select and open CDXMLSU2 in the Construct runtime project.

2 Decrease the size of the #MAX-REPLACEMENTS value for the #REPLACEMENT-TABLE
array by "n" in the LOCAL-DATAuser exit, where "n" is the number of substitution characters
you are deleting.

3 Delete the #SEARCH-STRINGand #REPLACE-STRINGvalues and indexes for each substitu-
tion character you are deleting.

4 Stow the CDXMLSU2 subprogram in the SYSTEM library.
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This section describes theObjectMaint code generator, which creates a subprogram thatmaintains
complex data objects and updates all entities within an object. The generator also creates the local
and parameter data areas.

Generate the Object Maint Subprogram

To generate an object-maintenance subprogram and data areas:

1 Open the context menu in theNavigator view for the NaturalONE project into which you
want to generate the modules.

Or:

Open the context menu in theNavigator view for the library into which youwant to generate
the modules.

2 Select Code Generation > New Object Maint.

TheDefine Object Maint Details panel is displayed. For example:

Using this panel, you can optionally:
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ProcedureTask

Type the name of the project in Project or selectBrowse to display
a window listing the existing projects for selection. The project
must currently exist.

Select another NaturalONE project
into which to generate the object
maint modules.

Type the name of the folder in Folder or select Browse to display
awindow listing the existing folders for selection. The foldermust
currently exist within the selected NaturalONE project.

Note: This option allows you to generate modules into more
complex library structures (for example, "Natural-Libraries/my

Select a folder into which to
generate the object-maintenance
modules.

library (MYLIB)/SRC"). When this option is not specified, the
modules will be generated into the basic library folder (for
example, "Natural-Libraries/MYLIB/SRC",
"Natural-Libraries/MYLIB/Subprograms", etc.).

Type a brief description in Description.Provide a description of the object
maint subprogram.

3 Type the location of theNatural library intowhich to generate the subprogram and associated
modules in Library.

The library must currently exist.

Or:

Select Browse to display a window listing the existing libraries for selection.

Note: The libraries listed for selection are based on the current project.

4 Type the name of the object maint subprogram in Name.

5 Select the DDM for the object maint subprogram in DDM.

Tip: The DDMs are typically located in the SYSTEM library.

6 Select Finish to generate the objectmaint subprogramand associatedmoduleswith the default
values.

Or:

SelectNext to change the default specification values.

The Change Defaults panel is displayed. For example:
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This panel displays the default specification values for the subprogram to be generated. Using
this panel, you can optionally:

ProcedureTask

Type the description in Object description.Change the description of the subprogram to be
generated.

Type the name in Object name.Change the name of the object.

Select the field in Primary key.Change the primary key field used for maintenance
operations.

7 Select Finish to generate the object maint subprogram and associated modules.

Or:

SelectNext to change the default parameter values.

The Change Advanced Defaults panel is displayed. For example:
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This panel displays the default parameter values for the subprogram to be generated. Using
this panel, you can optionally:

ProcedureTask

Type the name in Object PDA.Change the name of the parameter data area
(PDA) for the object.

Type the name in Object LDA.

Note: The local data area is only required when the
hash-locking option is used for record locking.

Change the name of the local data area
(LDA) for the object.

Type the name in Restricted PDA.Change the name of the restricted parameter
data area (PDA) for the object.

Select the hold field inHold field. Formore information,
see Record-Locking Options.

Note: By default, the hash-locking mechanism is used to
lock data. If you select a hold field, theHash locking field
is automatically deselected.

Use a hold field to lock data formaintenance
operations.

Note: If desired, a Generation Progresswindow can be displayed during generation.
For information, see Set Code Generation Preferences.

8 Select Finish.
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After generation, the subprogram and associated modules are displayed in theNavigator
view. For example:

These modules are:

DescriptionModule

Parameter data area for the object maint subprogramMYOBDM1.NSA

Object maint subprogramMYOBJM.NSN

Local data area for the object maint subprogramMYOBLM1.NSL

Restricted parameter data area for the object maint subprogramMYOBPM1.NSA

The subprogram is displayed in the editor view. For example:
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9 Save the subprogram and associated modules.

At this point, you can:

■ Use the NaturalONE Testing option to test the subprogram. For information, see Test a
Subprogram Directly in Application Testing.

■ Define user exits for the subprogram. For information, seeUser Exits for the Object Maint
Subprogram.

■ Edit generated source code that is not within user exits. For information about the protected
lines in the generated source code, see Using the Source Editor in Using NaturalONE.

■ Use NaturalONE functionality to upload all generated modules to the server.

Record-Locking Options

In a client/server environment, data retrieved for maintenance is not locked initially. Instead, the
objectmaint subprogram retrieves the data again and locks it prior to updating, storing, or deleting
data from the database.

To ensure changes are not overwritten by another user during this process, the subprogrammust
determine whether the data has changed since the initial retrieval. To do this, the object maint
subprogram has two record-locking options:

■ Hash-locking

This method is the most reliable. The subprogram retrieves the initial data and hashes it to a
number. When it retrieves the data to lock it, the subprogram hashes it to a number again. Lo-
gical variables are stored in alphanumeric format in the local data area to process the hashed
values. All data must hash to the same value as when it was requested. If it does, data has not
changed and the changes are allowed.

■ Timestamp

The timestamp (or counter) method is the traditional record-locking mechanism. This method
assumes that every time data changes, the timestamp also changes. Thismethod ismore efficient
than the hash-locking method because the subprogram only has to check one field, but this as-
sumption can be incorrectwhen the file is notmaintained by anObjectMaint-generated subpro-
gram (for example, a programmer-coded subprogram may not change the timestamp when
data is modified).

If the file is not normally maintained through an Object Maint-generated subprogram, the hash-
locking option should be used. If the file is only maintained through an Object Maint-generated
subprogram, the timestamp option should be used (as it is more efficient). For more information,
see Natural Construct Object Models.
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User Exits for the Object Maint Subprogram

TheOutline view for the object-maintenance subprogram displays the available user exits. For
example:

Code Generation52

Create an Object-Maintenance Process



You can use these exits to define additional processing.

Notes:
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1. All user exits are empty when generated.

2. For information about defining user exits, see Defining User Exits.

Code Generation54

Create an Object-Maintenance Process



11 Create an Object-Browse Process

■ Introduction .................................................................................................................................... 56
■ Generate the Object-Browse Subprogram ............................................................................................ 56
■ User Exits for the Object-Browse Subprogram ....................................................................................... 61

55



Introduction

The Object-Browse code generator creates the browse subprogram for an object, as well as three
parameter data areas:

DescriptionData Area

Defines the returned row data.Object PDA

Defines the search key values.Object key PDA

Contains private data used internally by the browse object to maintain context.Restricted PDA

Generate the Object-Browse Subprogram

To generate an object-browse subprogram and data areas:

1 Open the context menu in theNavigator view for the NaturalONE project into which you
want to generate the modules.

Or:

Open the context menu in theNavigator view for the library into which youwant to generate
the modules.

2 Select Code Generation > New Object Browse.

TheDefine Object Browse Details panel is displayed. For example:
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Using this panel, you can optionally:

ProcedureTask

Type the name of the project in Project or selectBrowse to display
a window listing the existing projects for selection. The project
must currently exist.

Select another NaturalONE project
into which to generate the
object-browse modules.

Type the name of the folder in Folder or select Browse to display
awindow listing the existing folders for selection. The foldermust
currently exist within the selected NaturalONE project.

Note: This option allows you to generate modules into more
complex library structures (for example, "Natural-Libraries/my

Select a folder into which to
generate the object-browsemodules.

library (MYLIB)/SRC"). When this option is not specified, the
modules will be generated into the basic library folder (for
example, "Natural-Libraries/MYLIB/SRC",
"Natural-Libraries/MYLIB/Subprograms", etc.).

Type a brief description in Description.Change or provide a description of
the object-browse subprogram.

3 Type the location of theNatural library intowhich to generate the subprogram and associated
modules in Library.

The library must currently exist.
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Or:

Select Browse to display a window listing the existing libraries for selection.

Note: The libraries listed for selection are based on the current project.

4 Type the name of the object-browse subprogram in Name.

5 Select the DDM for the object-browse subprogram in DDM.

Tip: The DDMs are typically located in the SYSTEM library.

6 SelectNext.

The Change Defaults panel is displayed. For example:

This panel displays the default specification values for the subprogram to be generated. Using
this panel, you can optionally:
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ProcedureTask

Type the description in Object description.Provide a description of the subprogram to be
generated.

Type the name in Object PDA.Change the name of the object PDA.

Type the name in Object key PDA.Change the name of the object key PDA.

Type the name in Restricted PDA.Change the name of the restricted PDA.

Select the field in Primary key.

Note: This option is only available when the primary
key is not known (for example, DB2 files). For Adabas
files, the primary key is the ISN.

Define the primary key field used for browse
operations.

7 Select Finish.

After generation, the subprogram and associated modules are displayed in theNavigator
view. For example:

These modules are:

DescriptionModule

Object PDAMYOBDA1.NSA

Object-browse subprogramMYOBJB.NSN

Object key PDAMYOBKA1.NSA

Restricted PDAMYOBPA1.NSA

The subprogram is displayed in the editor view. For example:
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Note:

8 Save the subprogram and associated modules.

At this point, you can:

■ Use the NaturalONE Testing option to test the subprogram. For information, see Test a
Subprogram Directly in Application Testing.

■ Define user exits for the subprogram. For information, seeUser Exits for theObject-Browse
Subprogram.

■ Edit generated source code that is not within user exits. For information about the protected
lines in the generated source code, see Using the Source Editor in Using NaturalONE.

■ Use NaturalONE functionality to upload all generated modules to the server.
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User Exits for the Object-Browse Subprogram

TheOutline view for the object-browse subprogramdisplays the available user exits. For example:

You can use these exits to define additional processing.

Notes:

1. All user exits are empty when generated.

2. For information about defining user exits, see Defining User Exits.
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Generate the Object Skeleton Subprogram

To generate an object skeleton subprogram:

1 Open the context menu in theNavigator view for the NaturalONE project into which you
want to generate the module.

Or:

Open the context menu in theNavigator view for the library into which youwant to generate
the module.

2 Select Code Generation > New Object Skeleton.

TheDefine Object Skeleton Details panel is displayed. For example:

Using this panel, you can optionally:
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ProcedureTask

Type the name of the project in Project or select Browse to display
awindow listing the existing projects for selection. The projectmust
currently exist.

Select another NaturalONE
project into which to generate the
subprogram.

Type the name of the folder in Folder or select Browse to display
a window listing the existing folders for selection. The folder must
currently exist within the selected NaturalONE project.

Note: This option allows you to generate modules into more
complex library structures (for example, "Natural-Libraries/my

Select a folder into which to
generate the subprogram.

library (MYLIB)/SRC").When this option is not specified,modules
will be generated into the basic library folder (for example,
"Natural-Libraries/MYLIB/SRC",
"Natural-Libraries/MYLIB/Subprograms", etc.).

Type a brief description in Description.Change or provide a description
of the subprogram.

3 Type the location of theNatural library intowhich to generate the subprogram and associated
modules in Library.

The library must currently exist.

Or:

Select Browse to display a window listing the existing libraries for selection.

Note: The libraries listed for selection are based on the current project.

4 Type the name of the subprogram in Name.

5 SelectNext.

The Enter the Subprogram Parameters panel is displayed. For example:
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Use this panel to define input/output and state parameters for the subprogram to be generated.

6 Type the parameters for your subprogram in Subprogram parameters.

7 Select Finish to generate the subprogram with the DEFAULT method.

Or:

SelectNext to define other methods.

The Enter the SubprogramMethods panel is displayed. For example:
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This panel displays the defaultmethods for the subprogram to be generated. Using this panel,
you can optionally:

ProcedureTask

For information, see Add a Method.Add a method to the subprogram.

Select the method in theMethod list and select Remove.Remove a method from the subprogram.

8 Select Finish.

After generation, the subprogram is displayed in theNavigator view. For example:

The subprogram is displayed in the editor view. For example:
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9 Save the subprogram.

At this point, you can:

■ Use the NaturalONE Testing option to test the subprogram. For information, see Test a
Subprogram Directly in Application Testing.

■ Define user exits for the subprogram. For information, seeUser Exits for theObject Skeleton
Subprogram.

■ Edit generated source code that is not within user exits. For information about the protected
lines in the generated source code, see Using the Source Editor in Using NaturalONE.

■ Use NaturalONE functionality to upload all generated modules to the server.

Add a Method

To add a method to the subprogram:

1 Select Add.

TheMethod details section is displayed. For example:
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By default, method1 is displayed in theMethod section.

2 Type the name of the new method in Name.

3 Type a brief description of the method in Description.

User Exits for the Object Skeleton Subprogram

TheOutline view for the object skeleton subprogramdisplays the available user exits. For example:

You can use these exits to define additional processing.

Notes:
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1. All user exits are empty when generated.

2. For information about defining user exits, see Defining User Exits.

Code Generation70

Create an Object Skeleton Subprogram



13 Regenerate Subprograms and Associated Modules

■ Regenerate a Subprogram and Associated Modules .............................................................................. 72
■ Regenerate Multiple Subprograms ...................................................................................................... 73
■ Compare Differences ....................................................................................................................... 75

71



You can regenerate any subprogram that was generated using a supplied code generator, as well
as all data areas, associated subprograms, and user exits that were generatedwith the subprogram.
You can also select more than one project, folder, or object to regenerate multiple modules.

This section covers the following topics:

Regenerate a Subprogram and Associated Modules

There are twomethods of regenerating a subprogram,which are represented by two contextmenu
options:

■ Regenerate

The selected subprogram and all associated modules are regenerated without showing the
generator panels.

■ Regeneration using Wizard

The first wizard panel is displayed. You can edit the settings and select Finish on the last panel
to regenerate the selected subprogram and all associated modules.

To regenerate a subprogram and associated modules:

1 Open the context menu for the subprogram in theNavigator view.

2 Select Code Generation > Regenerate.

The selected subprogram and all associated modules are regenerated without displaying the
wizard panel(s).

Or:

Select Code Generation > Regenerate Using Wizard.

The code generator reads the subprogram specifications and displays the wizard panels,
which are the same as those displayed when the subprogram was first generated.

Note: For information on the specification panels, see the section describing that code
generator.

After selecting Finish, theGeneration Progresswindow is displayed, indicating the results
of the regeneration. For example:
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If any of the Natural modules have changed since the subprogram was first generated, the
compare option is enabledwhen you select themodule. For information, seeCompare Differ-
ences.

Note: TheGeneration Progresswindow is only displayed when the option is set in the
Preferenceswindow. For information, see Set Code Generation Preferences.

3 Select Save to save the regenerated subprogram and associated modules.

You can now upload all modules to the server using standard NaturalONE functionality.

Regenerate Multiple Subprograms

This section describes how to regenerate more than one subprogram and associated modules.

To regenerate multiple subprograms:

1 Open the context menu for the subprograms in theNavigator view.

You can select one or more projects, libraries, or individual subprograms using standard se-
lection techniques.

2 Select Regenerate.
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First, a progresswindow is displayed as thewizard locates and loads the regeneratable objects.
Next, a selection window is displayed to choose the objects you want to regenerate. For ex-
ample:

Use this panel to:

ProcedureTask

Type a prefix in Filter. For example, if you type "ZIP",
only the resources beginning with ZIP are selected.

Filter the list of resources for selection.

Type the generator ID in Generator ID.Use a different code generator to regenerate
the resource.

SelectDeselect All.Deselect all resources.

3 Select Finish.

TheGeneration Progresswindow is displayed, showing the progress of the generation process.
For example:
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Compare Differences

TheGeneration Progresswindow displays the results of regeneration. If the generated modules
have changed since the previous generation, Different is displayed in the Status column and you
can display a window in which you can compare the regenerated code with the original.

Note: You cannot compare two modules that are identical.

To compare the regeneration differences:

1 Select the module for which you want to compare the differences.

2 Select Compare.

The Compare Generationwindow is displayed. For example:
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This window displays the results of the new (Generated) and previous (Original) generation
and indicates the differences.

3 Decide what to do about the differences.

4 Select Commit to save the changes.
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Set Code Generation Preferences

This section describes how to set common generation preferences for Code Generation.

To set Code Generation preferences:

1 Select Preferences on theWindowmenu.

The Preferenceswindow is displayed.

2 Expand the Software AG root node.

3 Select Code Generation.

The Code Generation preferences are displayed. For example:

Using this window, you can:

ProcedureTask

Select Enable custom templates and use Browse to select
the root folder for custom templates (by default, the
custom-templates folder).

Note: Do not change the underlying folder structure for
the root folder or the code generatorwill not be able to find
the custom templates.

Enable customized templates and select
the folder containing the templates.
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ProcedureTask

SelectDisplay generation dialog after generating.Display theGeneration Progresswindow
after generation.

DeselectDisplay generation dialog after regenerating.Not display theGeneration Progress
window after regeneration.

4 SelectOK to save the preferences.

Set Logging Preferences

This section describes how to set preferences for logging.

To set logging preferences:

1 Select Preferences on theWindowmenu.

The Preferenceswindow is displayed.

2 Expand the Software AG root node.

3 Select Code Generation > Logging.

The Logging preferences are displayed. For example:

Using this window, you can:
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ProcedureTask

Select Browse and search for the log4j.properties file.

Note: If the log4.properties file is not specified, the
<workspacename>/.naturalone folderwill be searched for the file;
the log4.properties file is optional.

Assign a log4j.properties file to use
for logging.

Deselect Append to Natural console.Not append the Code Generation
console view to the NaturalONE
Console view.

Type the location in Logger.Change the location of the logger
file.

Select the logger level in Level. The logger levels are:Change the logger level.

■ INFO

Over all process Start/Finish. For example: "Regeneration started
for CUSTOMERMAINT" or "Regeneration succeeded for
CUSTOMERMAINT".

■ DEBUG

Low-level process Start/Finish. For example: "User exitsmerged
successfully".

■ TRACE

Very low-level information: For example: "User exit replaced:
original:'...' new:'...'" or "WSDL to PDA processing field:
MyField".

Type the pattern in Pattern.Change the logger pattern.

4 SelectOK to save the preferences.

Set Natural Preferences

This section describes how to set preferences for Natural.

To set Natural preferences:

1 Select Preferences on theWindowmenu.

The Preferenceswindow is displayed.

2 Expand the Software AG root node.

3 Select Code Generation > Natural.
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TheNatural preferences are displayed. For example:

Using this window, you can:

ProcedureTask

Select Check Predict for additional metadata.

Note: If this option is selected, three options in the Predict Settings
section are disabled. If this option is not selected, use these options
to simulate the Predict data.

Check Predict for additional
metadata.

Select Include relationships.

Note: To enable this option, select Check Predict for additional
metadata.

Include relationship data from
Predict (if available on the
server).

Deselect Create periodic occurrences at the group level.

For example, a DDM containing a periodic group (PE) named
INCOME with four occurrences can be represented as follows:

Not create periodic occurrences
at the group level.
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ProcedureTask

■ At a group level

For example:

2 INCOME (1:4)
3 SALARY (P5)
3 CURRENCY (A3)

■ Not at a group level

For example:

2 INCOME
3 SALARY(P5/4)
3 CURRENCY (A3/4)

Select Include C* variables in view.

If this option is selected, the C* variables are generated into the code
to determine the number of occurrences of a periodic group. For
example:

Include all C* variables in the
view.

2 C*INCOME
2 INCOME
3 SALARY(P5/4)
3 CURRENCY (A3/4)

Type the number inWhennot found in Predict, periodic group (PE)
occurrences.

The number of occurrences of a periodic group is not storedwith the
DDM and the maximum number of occurrences could be too large

Change the maximum number
of occurrences for a periodic
group when not found in
Predict.

to use. To solve this problem, you can define the maximum number
of PE occurrences in this field.

Note: If Check Predict for additional metadata is not selected, or if
0 is returned from Predict, the value in this field will be used.

Type the number inWhen not found in Predict, multiple value
(MU) occurrences.

The number of occurrences of a multiple-valued field is not stored
with the DDM and themaximumnumber of occurrencesmay be too

Change the maximum number
of occurrences for a
multiple-valued field when not
found in Predict.

large to use. To solve this problem, you can define the maximum
number of MU occurrences in this field.

Note: If Check Predict for additional metadata is not selected, or if
0 is returned from Predict, the value in this field will be used.
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ProcedureTask

Select Allow lowercase search key values for Object Browse.

By default, the object browse subprogram will convert the starting
values for all supplied alphanumeric key components to upper case.

Allow search keys to be entered
in lower case for an
object-browse subprogram.

If this option is selected, the ALLOW-LOWER-CASE option is
generated for all keys and the input values can include lower case
characters. For example, if the database contains both upper case and
lower case values for the BUSINESS-NAME field (for example,
iXpress and IBM) and you select this option, either lower case or
upper case input values can be used in a search (for example, "I*" for
iXpress and "I*" for IBM).

Type a new number inMaximum number of fields.

AREQUEST-DOCUMENTsubprogram can generate a large amount
of code, which may cause memory errors. To avoid this, you can use

Change the maximum number
of fields generated for a
REQUEST-DOCUMENT
subprogram.

this option to place restrictions on theREQUEST-DOCUMENTClient
code generator.

SelectGenerate Unicode dynamics.

This option allows the REQUEST-DOCUMENT subprogram to send
and receive Unicode data.

Generate the dynamics to
support Unicode fields.

Note: The Natural server must be configured for Unicode.

Select Allow GetByISN.

This option is available for Adabas files. If this option is selected,
data can be retrieved using the ISN.Although extra code is generated,
performance speed will be enhanced.

Allow the GetByISN option for
an Object Maint subprogram.

DeselectWhen an SQL database type is found, generate for DB2.Suppress the generation of DB2
code for SQL database types.

4 SelectOK to save the preferences.
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The code generators supplied with NaturalONE use Velocity templates, which are embedded in
the .jar file created during the build process. To customize the templates, you can copy the embed-
ded templates from the .jar file to your custom-templates folder and modify the template there.
Velocitywill check this folder first for the template. If it exists, it will be used by the code generator.

Export the Supplied Templates

To export the supplied templates:

1 Select Export on the Filemenu.

The Exportwindow is displayed.

2 Expand the Software AG root node.

3 Select Code Generation Templates.

For example:
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4 SelectNext.

The Select Templates for Export panel is displayed. For example:

This panel displays the default target folder for the templates, aswell as the templates available
for export.

Note: You can change the default target folder in the Preferenceswindow for Code
Generation. For information, see Set Code Generation Preferences.

5 Select the templates you want to export.

■ To select all templates in a template node, select the node (for example, if you select the
Common Templates root node, all templates within that node will be selected).

■ To select individual templates, expand a template root node and select the template.

For example:
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6 Select Finish.

The templates are exported to the selected target folder.

Note: You cannot change the functionality of the internal Java code, you can only
modify the templates.

Customize a Supplied Template

To customize a template:

1 Select the template in the custom-templates > cst folder.

For example:
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Note: Custom templates are stored in the folder specified in the Preferenceswindow
for Code Generation. For information, see Set Code Generation Preferences.

2 Open the template you want to modify.

For example:

3 Modify the template.

4 Save the changes.
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III Using Natural Construct

This section describes theNatural Construct component suppliedwithNaturalONE. The following
topics are covered:

Introduction

Natural Construct Generation

Natural Construct Administration

Set Natural Construct Preferences
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The Natural Construct component for NaturalONE provides access from Eclipse to Natural
Construct on the server. This access includes the modeling functionality in the SYSCST library, as
well as Eclipse wizards corresponding to a subset of the most commonNatural Construct models
in your server installation. The Eclipse wizards collect the model specifications and pass this in-
formation to the Natural server to generate the code, which is then returned to the local project
that was selected as the target on a wizard panel.

This type of code generation is different from the local, non-server based generation implemented
using Velocity templates (for example, REQUEST-DOCUMENT Client, Object Maint, Object
Browse, and Object Skeleton; seeUsing the Code Generation Component). The Natural Construct
component allows you to use Natural Construct models on the server in NaturalONE, as well as
create Eclipse wizards for them (including customized ones).

Note: To install theNatural Construct component forNaturalONE, youmust selectDesigner
> NaturalONE > Natural Construct in the installation tree for the installer.

This section covers the following topics:

Supplied Client Generation Wizards

The Natural Construct component for NaturalONE supplies client generation wizards for the
following Natural Construct models on the server:

GeneratesModel

Browse program that reads a file in logical order and displays record
values on the screen.

BROWSE

Browse-select program that reads a file in logical order, displays record
values on the screen, and allows the user to specify which set of
commands are executed.

BROWSE-SELECT

Browse-select helproutine that enables the user to select a field value
from a list of valid values.

BROWSE-SELECT-HELPR

Browse-select subprogram that is invoked as a sub-function of another
program. For example, you can use a browse-select subprogram to

BROWSE-SELECT-SUBP

perform the Browse action for a maintenance program, in which case,
the maintenance program invokes the subprogram without disturbing
the current state of the panel.

Browse subprogram that is invoked as a sub-function of another
program.

BROWSE-SUBP

Driver program that executes a helproutine or subprogram for testing
purposes.

DRIVER

Maintenance program that maintains a file using a unique key and,
optionally, a related secondary file. The Maint wizard generates the

MAINT
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GeneratesModel

code necessary to scroll through the MU/PE fields of a primary file or
the records of a secondary file.

Menu program that presents users with several choices in the form of
a menu. The user enters a code for one of the choices to invoke a
predefined function.

MENU

Object-browse dialog component of an object-maintenance process that
works with the object-browse subprogram to provide the browse
functionality for a Natural object.

OBJECT-BROWSE-DIALOG

Object-browse-select subprogram and corresponding parameter data
areas that provide the browse functionality for a Natural object. This

OBJECT-BROWSE-SELECT-SUBP

model is similar to the OBJECT-BROWSE-SUBP model, except the
generated object-browse-select subprogram can accommodate a
client/server environment and a subprogramproxy can be used to access
the generated code as a business service.

Object-browse subprogram and corresponding parameter data areas
that provide the browse functionality for a Natural object.

OBJECT-BROWSE-SUBP

Object-maintenancedialog component of an object-maintenanceprocess.
The dialog component (Natural program) communicates with the user

OBJECT-MAINT-DIALOG

and invokes methods (data actions) implemented by the
object-maintenance subprogram.

Object-maintenance subprogram and corresponding parameter data
areas that update all entities within a Natural object.

OBJECT-MAINT-SUBP

Quit program that releases resources used by an application. It displays
a confirmationwindow that overlays the host panel and gives users the

QUIT

option of quitting an application entirely or resuming where they left
off.

Startup program (often named Menu) that initializes global variables
and invokes the main menu program.

STARTUP

Requirements

To use theNatural Construct code generation features inNaturalONE, the following requirements
must be met:

■ Your NaturalONE environment must be mapped to a server in theNatural Server view that
contains a version of Natural Construct 5.3, service pack 8 or higher.

■ Projects in yourworkspacemust be connected to the server containingNatural Construct; projects
mapped to the local Natural runtime environment cannot be used to generateNatural Construct
modules.

The target Natural project must be configured to a remote environment. If you select a Natural
project that is mapped to a local environment, an error will be displayed. When you change the
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target project to a valid remote project, the clear subprogramwill be called using the connection
settings for the valid project.

■ TheNatural >Runtime setting in the Propertieswindow for the project must point to theNat-
ural Server connection containing the Natural Construct installation. For example:

Perform Standard Actions on Natural Construct Resources

You can use theNatural Server view to copy/paste, delete, or move Natural Construct resources
on the server. The action will be performed in the mapped environment for the selected node(s).

This section covers the following topics:

■ Perform Actions on Code Frames
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■ Perform Actions on Models

Perform Actions on Code Frames

To perform actions on one or more code frames:

1 Open the context menu for the code frame(s) in theNatural Server view.

For example:

2 Select one of the actions listed.

The available actions are:

DescriptionAction

Removes the selected code frame(s) from the current mapped environment and adds it to a
target mapped environment. For information, seeMove a Code Frame.

Move

Copies the selected code frame(s) to the clipboard in anticipation of a Paste action. For
information, see Copy a Code Frame.

Copy

Removes the selected code frame(s) from the current mapped environment. For information,
see Delete a Code Frame.

Delete
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Move a Code Frame

This section describes how to move one or more code frame(s) from the current mapped environ-
ment to a target mapped environment.

Note: A code frame cannot be moved within the same mapped environment.

To move one or more code frames:

1 Open the context menu for the code frame(s) in theNatural Server view.

2 SelectMove.

TheMove Objectswindow is displayed. For example:

This window lists the connection nodes for the available mapped environments.

3 Expand the connection node for the environment into which you want to move the code
frame(s).

4 Select the Construct or Code-Frames root node.

5 SelectOK.

A progresswindow is displayedwhile the code frame(s) is removed from the currentmapped
environment and copied to the target mapped environment.

Copy a Code Frame

This section describes how to copy one or more code frames to the clipboard and then paste the
frame(s) into a target mapped environment.

To copy one or more code frames:

1 Open the context menu for the code frame(s) in theNatural Server view.

2 Select Copy.
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3 Open the context menu for the Construct or Code-Frames root node into which you want to
copy the code frame(s).

4 Select Paste.

The frame(s) is copied to the target mapped environment.

Delete a Code Frame

This section describes how to remove one or more code frames from the current mapped environ-
ment.

To delete one or more code frames:

1 Open the context menu for the code frame(s) in theNatural Server view.

2 SelectDelete.

A confirmation window is displayed to confirm the action.

3 Select Yes.

The frame(s) is removed from the current mapped environment.

Perform Actions on Models

To perform actions on one or more Natural Construct models:

1 Open the context menu for the model(s) in theNatural Server view.

For example:
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2 Select one of the actions listed.

The available actions are:

DescriptionAction

Removes the selected Construct model from the current mapped environment and adds it to
a target mapped environment. For information, seeMove a Construct Model.

Move

Copies the selectedmodel(s) to the clipboard in anticipation of a Paste action. For information,
see Copy a Construct Model.

Copy

Removes the selected model(s) from the current mapped environment. For information, see
Delete a Construct Model.

Delete

Move a Construct Model

This section describes how tomove one ormoremodel(s) from theModels root node in the current
mapped environment to a target mapped environment.

Note: A Construct model cannot be moved within the same mapped environment.

To move one or more Construct models:

1 Open the context menu for the model(s) in theNatural Server view.
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2 SelectMove.

TheMove Objectswindow is displayed. For example:

This window lists the connection nodes for the available mapped environments.

3 Expand the connection node for the environment into which you want to move the model(s).

4 Select the Construct orModels root node into which you want to move the model(s).

5 SelectOK.

A progress window is displayed while the model(s) is removed from the current mapped
environment and copied to the target mapped environment.

Copy a Construct Model

This section describes how to copy one ormoremodels to the clipboard and then paste themodel(s)
into a target mapped environment.

To copy one or more Construct models:

1 Open the context menu for the model(s) in theNatural Server view.

2 Select Copy.

3 Open the context menu for the Construct orModels root node into which you want to copy
the model(s).

4 Select Paste.

The model(s) is copied to the target mapped environment.
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Delete a Construct Model

This section describes how to remove one or more models from the current domain.

To delete one or more Construct models:

1 Open the context menu for the model(s) in theNatural Server view.

2 SelectDelete.

A confirmation window is displayed to confirm the action.

3 Select Yes.

The model(s) is removed from the current mapped environment.

Use the Dependencies View

When aConstruct resource (for example, a Constructmodel, code frame, etc.) is open in the editor,
theDependenciesviewdisplays dependencies between that resource and otherConstruct resources
and/or Natural resources. This section describes the child nodes contributed to the view by the
Construct-related resources. The following topics are covered:

■ Construct Resources
■ Related Natural Resources

Notes:

1. Select to sort the resources alphabetically.

2. Select to export a textual representation of the visible nodes in the view to a file.

3. When a supporting resource cannot be found locally using the project steplib chain and project
references, "<Unknown>" is displayedwith the name of the resource (see above). If the unknown
module(s) is not shippedwith the Construct runtime project, eithermanually download it from
the server or create it locally. If the module(s) is shipped with the Construct runtime project,
add the project. For information, see Add the Construct Runtime Project.

4. For more information about the Dependencies view, see the description of the source editor
in Using NaturalONE.
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Construct Resources

When a Construct resource is open in the editor, the root node displays the name of the resource.

In caller mode ( ), child nodes are contributed to theDependencies view for each resource that
depends on that Construct resource. For example, when a code frame is open in the editor, the
child nodes display any Construct models or other code frames that depend on that code frame:

In this example, threeConstructmodels (BROWSE-SUBP, BROWSE-HELPR, andBROWSE)depend
on the CSCA8 code frame.

In callee mode ( ), Construct and Natural nodes are contributed to the view for each resource
the Construct resource depends on. For example, when a Construct model is open in the editor,
the child nodes will display any code frames, PDAs, subprograms and Construct models that this
model depends on. For example:

In this example, the Construct model named BROWSE depends on two code frames (CSCC9 and
CSCA8), a PDA named CUSCPDA in the C53 library and many subprograms.
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Related Natural Resources

When a Natural subprogram is open in the editor, the root node displays the name of the subpro-

gram, as well as the name of the library in which it is located. In caller mode ( ), child nodes are
contributed to the Dependencies view for each Construct-related resource that depends on this
subprogram (such as a Construct model, code frames, etc.). For example:

In callee mode ( ), a Construct model node is contributed to the view if the subprogram was
generated by a Construct model. For example:

Construct Runtime Project

To avoid compile errors for Construct-generated modules in the server environment, Natural
Construct on the server is delivered with all the required runtime/compile time modules in the
SYSTEM library. Since thesemodules are combinedwith othermodules and products in SYSTEM,
the Natural Construct component on the client delivers the required modules in the Construct
runtime project. The modules in this project will eliminate compile and parsing errors caused by
missing Natural Construct resources and will provide more detailed information in theDepend-
encies view.

This section covers the following topics:

■ Add the Construct Runtime Project
■ Update the Construct Runtime Project to the Latest Version
■ Replace the Construct Runtime Project with the Latest Version
■ Exclude Modules from the Update or Replace Process
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■ Add Customized Modules to the Construct Runtime Project
■ Build the Construct Runtime Project in a non-Construct Server Environment

Add the Construct Runtime Project

When Natural code is generated by a Code Generation wizard, the wizards verify whether the
required runtime/compile-time modules are available in the local environment. If they are not, a
window is displayed prompting you to add the Construct runtime project to your workspace. For
example:

If you select Yes, the project is added to the workspace and referenced from the current project.

You can also add the Construct runtime project to your workspace manually.

To add the Construct runtime project manually:

1 Open the context menu for any node in theNavigator view.

2 Select Code Generation > Construct Runtime > Add Runtime Project.

For example:
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The project is added to theNavigator view. For example:
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The current version of the Construct runtime project is defined in the .construct file. For example:

Note: The information in the .construct file is used internally and should not be modified.

The local version information is compared to the version information delivered in the Construct
runtime project at startup and during generation and regeneration. If the version has changed on
the server, the local project will be updated.

Update the Construct Runtime Project to the Latest Version

This section describes how to update an existing Construct runtime project to the latest version
of the project. Updatedmodules in the shipped version are copied to theworkspace (and overwrit-
ten when necessary).

Caution: Any customizations of the Construct runtime project modules will be lost unless
you exclude themodules from the update processing. For information, see ExcludeModules
from the Update or Replace Process.

To update the Construct runtime project to the latest version:

1 Open the context menu for the ConstructRuntime project in theNavigator view.

2 Select Code Generation > Construct Runtime > Update to Latest Version.

For example:
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Replace the Construct Runtime Project with the Latest Version

This section describes how to replace an existing Construct runtime project with the latest shipped
version of the project. All modules in the shipped version are copied to the workspace (and over-
written when necessary).

Caution: Any customizations of the Construct runtime project modules will be lost unless
you exclude themodules from the replace processing. For information, see ExcludeModules
from the Update or Replace Process.

To replace the Construct runtime project with the latest version:

1 Open the context menu for the ConstructRuntime project in theNavigator view.
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2 Select Code Generation > Construct Runtime > Replace with Latest Version.

Exclude Modules from the Update or Replace Process

This section describes how to exclude (and subsequently include) Construct runtime project re-
sources frombeing overwritten during the update or replace process. You can use this functionality
to protect changes to these modules from being overwritten during the update or replace process.

Notes:

1. Excluding a folder automatically excludes all its child folders and files.

2. You cannot exclude the Construct runtime project itself or the .construct file.

To exclude modules in the Construct runtime project from the update or replace processing:

1 Open the context menu for a Construct runtime resource in theNavigator view.

2 Select Code Generation > Construct Runtime > Exclude. For example:

The selected resource is added to the .construct-excludes file in the project. For example:
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Excluded resourceswill never be updated or replacedwith the latest shipped version (triggered
automatically at startup, generation, regeneration or by selecting theUpdate to Latest Version
or Replace with Latest Version context menu actions).

Note: You can view the .construct-excludes file to determine which resources are cur-
rently excluded, but you should never modify the file manually.

To include modules in the Construct runtime project update or replace processing:

1 Open the context menu for the excluded Construct runtime resource in theNavigator view.

2 Select Code Generation > Construct Runtime > Include.

The selected resource is removed from the .construct-excludes file andwill nowbe overwritten
during an update or replace process.

Add Customized Modules to the Construct Runtime Project

If you have customized any of the required modules on the server, you must add these customiz-
ations to the local Construct runtime project. This project is imported from an archived file called
ConstructRuntime.zip in the installation folder for the Natural Construct component.

To add customized modules to the Construct runtime project:

1 Make a backup copy of the ConstructRuntime.zip file.

2 Import the ConstructRuntime.zip file into your workspace.

3 Open the zip file and copy the customized modules into the Construct runtime project.

4 Export themodifiedConstruct runtimeproject fromyourworkspace to theConstructRuntime.zip
file.
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Your customizations will overwrite the supplied Construct runtime project in the Natural
Construct installation folder.

The customizedConstruct runtime project now can be used as the basis for loading runtime projects
in a customized environment.

Build the Construct Runtime Project in a non-Construct Server Environment

TheConstruct runtime project allowsConstruct-generatedmodules to be compiled inNaturalONE
and executed in a non-Construct Natural server environment. If Natural Construct is installed on
the server (including the compiled version only), a Construct-generated application can be compiled
and/or executed on that server. If Natural Construct is not installed on the server (for example, in
a NaturalOne local server environment), a Construct-generated application can be compiled on
that server if the Construct runtime project has been installed.

The Construct runtime project is copied to the environment defined in the Propertieswindow for
the project (for example, Projectname > Properties > Natural > Runtime).

For a Construct-generated application to compile in a NaturalOne local environment:

■ The referenced application DDMs must be copied into the NaturalOne local environment.
■ The Construct runtime project must be available in the workspace and referenced.
■ The SYSTEM library must be in the steplib chain.

The runtime folder does not require a Construct physical file. If Construct help is being used, the
Construct physical file must be installed on the server and both the runtime and the CST-Help
folders should be updated on the server.

Notes:

1. To build the Construct runtime project, it must first be available locally. For information, see
Add the Construct Runtime Project.

2. If your non-Construct server environment is running on a mainframe, ensure that the ESIZE
value is a minimum of 120 during the build.

To build the Construct runtime project in a non-Construct server environment:

1 Open the context menu for the ConstructRuntime project in theNavigator view.

2 Select Code Generation > Construct Runtime > Build Construct Runtime Project.

TheDefine the Build Details panel is displayed. For example:
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3 Select Finish.

The Construct runtime project is built with all defaults.

Or:

Select one or more of the following options:

DescriptionOption

Select this option to include all global data area files.

The wizard ignores any global data areas. To include them, select Include
GDA files.

Note: To ensure compatibility with existing compiled files, and to avoid GDA
timestamp errors, the Construct CDGDA global data area is also excluded by
default. If you want this file uploaded and compiled, edit the .excludes file in
the project. For more information, see the NaturalONE documentation.

Include GDA files

Select this option to execute the CVUSRCOP utility, which copies the Natural
utility routines to the SYSTEM library after the Construct runtime project has

Execute CVUSRCOP
after successful build

been successfully built on the server. Formore information, seeNatural Business
Services Installation on Mainframes.

4 Select Finish.

The Construct runtime project is built with the selected options.
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This section describes how to use the Natural Construct client generation wizards to generate
Natural modules, as well as how to define user exits for additional processing that is preserved
during regeneration. The following topics are covered:

Access the Client Generation Wizards

Note: The Natural Construct client generation wizards must be initiated from an existing
NaturalONE project in the NaturalONE perspective. In addition, at least one library must
be defined in your local project. For information, see the NaturalONE documentation.

To access the client generation wizards:

1 Open the context menu in theNavigator view for the NaturalONE project in which youwant
to generate the modules.

Or:

Open the context menu in theNavigator view for the library in which you want to generate
the modules.

Note: You can also access the wizards using standard NaturalONE functionality (i.e.,
through the Filemenu or using theNew toolbar option.

2 Select Code Generation > New Using Construct Model.

A list of the supplied client generation wizards is displayed. For example:
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3 Select the wizard you want to use.

TheProgress Informationwindow is displayed, indicating progress as themodel specification
PDA is initialized by the model's clear subprogram on the server to set the model defaults
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(the same process initiated when you enter "NCSTG" from a character-basedNatural connec-
tion). For example:

The clear subprogram will only be called if all the following conditions are true:

■ The selected target project is valid and connected to a remote Natural environment.
■ The generation mode is set to "New" (not regeneration).
■ The clear subprogramhas never been called or the last successful call to the clear subprogram
targeted a different project.

Generate the Modules

When initialization is complete, the first specification panel for the selected client generation
wizard is displayed. For example:
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The module parameters are grouped by topic and Browse buttons are available when selecting
existing resources. After specifying the first parameter on a panel, messages are displayed indic-
ating the next required parameter. TheNext button will only be enabled when all required para-
meters have been specified on the current panel have been specified; the Finish button will only
be enabled when all required parameters have been specified for the current wizard.

To generate a module:

1 Specify all required parameters and any optional parameters on the first panel for the selected
wizard.

2 SelectNext.

Or:

Select Finish.

The generation process begins. By default, progress is detailed in messages displayed near
the bottom of the panel. Once generation is complete, the code is downloaded to the client.
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The generated source is displayed in the editor and the available user exits are displayed in
theOutline view.

3 Save the generated module(s).

4 Use standard NaturalONE functionality to upload the generated module(s) to the server.

The following table lists the suppliedwizards andwhere you can find information on the specific-
ation parameters for each wizard:

InformationWizard

Browse/Browse-Select Wizards.BROWSE

Browse/Browse-Select Wizards.BROWSE-SELECT

Browse/Browse-Select Wizards.BROWSE-SELECT-HELPR

Browse/Browse-Select Wizards.BROWSE-SELECT-SUBP

Browse/Browse-Select Wizards.BROWSE-SUBP

Driver Model, Natural Construct Generation.DRIVER

Maint Model, Natural Construct Generation.MAINT

Menu Model, Natural Construct Generation.MENU

Object-Browse-Dialog Wizard.OBJECT-BROWSE-DIALOG

Object-Browse-Select-Subp WizardOBJECT-BROWSE-SELECT-SUBP

Object-Browse-Subp Wizard.OBJECT-BROWSE-SUBP

Object-Maint-Dialog Wizard.OBJECT-MAINT-DIALOG

Object-Maint-Subp Wizard.OBJECT-MAINT-SUBP

Quit Model, Natural Construct Generation.QUIT

Startup Model, Natural Construct Generation.STARTUP

Notes:

1. During generation, the wizard determines whether the Construct runtime project is available
locally, and if it is not, prompts you to add it. For information, see Add the Construct Runtime
Project.

2. To change the default generation options and/or set other generation options, see Generation
Options.

3. If the generated module is a subprogram, you can test it using the NaturalONE Testing option.
For information, see Test a Subprogram Directly in Application Testing.

4. For information about defining user exits, see Defining User Exits.
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Generation Options

In addition to the standard navigation buttons available at the bottom of the wizard panels, an
Options button is available to define generation options.

To define generation options:

1 SelectOptions on the wizard specification panel.

TheGeneration Optionswindow is displayed. For example:

Using this window, you can:

ProcedureTask

DeselectDisplay generation statusmessages. The generation
status messages indicate which module is being invoked at
each stage of the generation process.

Disable the display of generation status
messages.

SelectDisplay generation statusmessages as text. By default,
the messages are displayed with arrows "-->" (starting) and
"<--" (ending).

Display the generation statusmessages
as text (for example, "starting" and
"ending").

Select Include embedded statements in generated code.
Embedded statements indicate where the lines of code being

Write embedded statements to the
source buffer as part of the generated
module. written originated and the name of the code frame, generation

subprogram, or sample subprogram that produced the code.

2 SelectOK to save the generation options.
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Common Wizard Specifications and Development Tasks

The specification parameters listed on the wizard panels correspond with those on panels for the
Natural Construct models on the server. This section describes the common specifications for the
Natural Construct wizards and how to perform common development tasks.

Notes:

1. For an example of using a client generation wizard to generate a module, see Example of Gen-
erating a Program.

2. For information about specific parameters for the wizards, see the applicable model in the
Natural Construct Generation guide.

This section covers the following topics:

■ Browse/Browse-Select Wizards
■ Object-Browse-Dialog Wizard
■ Object-Browse-Select-Subp Wizard
■ Object-Browse-Subp Wizard
■ Object-Maint-Dialog Wizard
■ Object-Maint-Subp Wizard
■ Specify Common Parameters
■ Change the Window Settings
■ Change the Dynamic Attribute Characters
■ Specify International Parameters
■ Specify Screen Parameters
■ Select a Message Number

Browse/Browse-Select Wizards

This section describes the specification parameters for the Browse and Browse-Select series of
wizards. The following topics are covered:

■ Specify Standard Parameters
■ Specify Additional Parameters
■ Specify Map Details
■ Specify Field Details
■ Specify Restriction Parameters
■ Specify Prefix Helproutine Parameters
■ Specify #ACTION Parameters
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■ Specify Additional Subprogram Parameters

Note: The Browse-Select series of wizards are used for screen examples throughout this
section.

Specify Standard Parameters

The Specify Standard Parameters panel is displayed when the wizard is invoked; it is similar for
all Browse and Browse-Select wizards.

To specify standard parameters:

1 Open the context menu in theNavigator view for the NaturalONE project in which youwant
to generate the modules.

Or:

Open the context menu in theNavigator view for the library in which you want to generate
the modules.

2 Select Code Generation > New Using Construct Model > BrowseWizardName.

The Specify Standard Parameters panel for the selected wizard is displayed. For example:
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3 Define the following parameters:

DescriptionParameter

Name of the library in which to store the generated modules. Either type the name
or select Browse to display the available libraries for selection.

Library

Name of themodule to be generated. This namemust be alphanumeric, amaximum
of eight characters in length, and cannot contain blanks.

Module

Name of the global data area (GDA) used by the module to be generated. To allow
inter-program communication, generatedmodules require a small number of global
variables. The supplied CDGDA global data area contains the global variables

Global data area

required to test a generated module. Before creating a new application, copy this
GDA from the SYSTEM library and rename it to match your naming conventions.
Then add any additional global variables your application may require.

Title for the module to be generated. The title is used internally to identify modules
for the List Generated Modules function on the Generation main menu. You can
customize the title for your application.

Title
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DescriptionParameter

Brief description of what the generated module will do. This field is used internally
for documentation purposes.

Description

First heading displayed on the generated panel. This heading is centered at the top
of the generated panel and intensified.

First heading

Optionally, you can define:

ProcedureTask

Type the name of the project in Project or select Browse to display
awindow listing the existing projects for selection. The projectmust
currently exist.

A different NaturalONE project
into which to generate the
module(s).

Type the name of the folder in Folder or select Browse to display a
window listing the existing folders for selection. The folder must
currently exist within the selected NaturalONE project.

Note: This option allows you to generatemodules intomore complex
library structures (for example, "Natural-Libraries/my library

A folder into which to generate
the module(s).

(MYLIB)/SRC"). When this option is not specified, the modules will
be generated into the basic library folder (for example,
"Natural-Libraries/MYLIB/SRC",
"Natural-Libraries/MYLIB/Subprograms", etc.).

Type the name of the GDA block inWith block. You need only
specify the lowest level block name; the corresponding path name

A GDA block for use with the
specified GDA.

is determined automatically. For more information about GDA
blocks, see the Natural documentation.

Type the heading inSecondheading. This heading is centered under
the first heading and intensified.

A second heading for display on
the generated panel(s).

See Generation Options.Generation options for the
module(s).

4 SelectNext.

The Specify Additional Parameters panel is displayed. For example:

123Code Generation

Natural Construct Generation



Specify Additional Parameters

To specify additional parameters:

1 Define the following parameters:

DescriptionParameter

Name of the Predict view used by the generated browse module. Either type the name
or select Browse to display the available views for selection. The view must be defined
in Predict.

Predict view
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DescriptionParameter

Name of the primary key by which scrolling takes place. Either type the name or select
Browse to display the available primary keys for selection. This key must be defined as

Primary key

a descriptor, superdescriptor, or subdescriptor in the Predict file definition. Keys
containing MUs (multiple-valued fields) and PEs (periodic groups) are supported. If
this key does not exist in the corresponding Predict file, a message is displayed.

Note: For DB2 users, add the combination of fields as a superdescriptor in Predict if you
want to use more than one field to determine the sort sequence of the records being
browsed.

Optionally, you can define:

ProcedureTask

Type the DDM name in Natural DDM. If this field is not specified,
the DDM name defaults to the primary file name. The Predict
definition of the primary file determines which fields are included
in the DEFINE DATA section of your generated code. The format of
the generated code in the DEFINE DATA section has the following
structure:

1 Primary-file-name VIEW OF Data-definition-module
2 fields pulled from Predict of Primary-file-name

The name of the data definition
module (DDM) corresponding
to the primary file.

Type the primary file view name in Program view. This view must
be defined in the LOCAL-DATA user exit or a local data area (LDA).

If this field is not specified, a view is generated containing all fields
in the Predict view. The MAX.OCCURS value in Predict determines
how many occurrences of MU/PE fields are included on the panel.

The name of the view for the
primary file for the generated
module.

Type the number of panels in Horizontal panels. The default is 1
panel.

The number of panels used for
the generated module.

Type the maximum number of pages in Backward scroll pages. The
default is 10, which indicates that users can scroll forward and

Themaximumnumber of pages
the generatedmodule can scroll.

backward within a 10-page range. If they scroll forward 11 pages,
page 1 is forced out of the range and they cannot scroll back to it.

Note: ANatural Construct-generated browsemodule does not allow
backward scrolling over data that has not been previously scrolled
through in a forward direction.

SelectWildcard support. Numeric key values are input into an
alphanumeric field, which allows the user to enter "*", ">", or "<"

An option to enable wildcard
processing in the generated
module.

Select Export data support. The work file can then be used in other
environments and on other platforms (for example, in a PC

An option to enable records to
be exported to a work file in

spreadsheet application). To write data from the generated report toaddition to, or instead of, the
screen. a work file, select the EXPORT-DATA user exit and define the
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ProcedureTask

parameters to export to the work file. The work file number and
delimiter character (used to delimit fields on the report) can be
customized for your site.

Note: If you select this field and do not define the EXPORT-DATA
user exit, a default WRITE WORK FILE statement that includes all
fields in the view will be generated.

SelectHardcopy support.An option to enable the
hardcopy facility in the
generated module.

SelectWindow support. By default, the window size is adjusted to
its content. The window is placed on the screen so that the field from
which the user invoked it remains visible.

An option to enable the module
output to be displayed in a
window, rather than a panel.

Type the starting value inMinimum key value. The combination of
the minimum and maximum key values creates a logical window

A starting value for the browse.

within the file. The program will not browse before or after these
values.

The minimum key value must be a constant. The specified constant
is placed into a variable called #MIN-KEY-VALUE, which can be
overridden in the START-OF-PROGRAM user exit.

Type the ending value inMaximum key value. The maximum key
value must be a constant and greater than or equal to the minimum

An ending value for the browse.

key value. The specified constant is placed into a variable called
#MAX-KEY-VALUE, which you can override in the
START-OF-PROGRAM exit.

Note: You can set the minimum and maximum values as variables
within user exit code. For example, if the first three characters of
personnel ID represent the department code, you can restrict the
browse to a specific department based on where the browse was
called from or who was calling it. To do this, use the
START-OF-PROGRAM user exit to look up and retrieve the current
user's department code (assuming it is stored) and then use this
information to populate a variable that overrides the
#MIN-KEY-VALUE and #MAX-KEY-VALUE values (created when
constants are populated through the specifications). If Smith belongs
to department 555, for example, you can populate theminimumvalue
with 555 and the maximum value with 55599999 to retrieve all data
for department 555.

Select Common Parameters. For information, see Specify Common
Parameters.

Common parameters for the
generated module, such as
support for direct command
processing, message numbers,
and password checking.
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ProcedureTask

SelectWindowParameters. For information, seeChange theWindow
Settings.

Window parameters for the
generated module.

See Generation Options.Generation options for the
module(s).

2 Select Finish.

The module is generated using the current specifications. When generation is complete, the
available user exits are displayed in theOutline view.

Or:

SelectNext.

The Specify Map Details panel is displayed. For example:
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Specify Map Details

Optionally, you can define details for either an external or internal map.

To specify map details:

1 Define the following optional parameters:

DescriptionParameter

Name of the layout map used for the generated module. Either type the name or
select Browse to display the available maps for selection. If a map is specified, it
should be a short map that is displayed at the bottom of the panel. The CDLAYSC1
layout map is supplied for Browse models. If you do not specify a layout map,
Natural Construct places the input fields sequentially at the bottom of the panel.

The map is included as part of the END OF PAGE processing to input values that
control scrolling. The map must adhere to the following conventions:

Input using map

■ The map definition includes the #SCR-CV control variable.
■ The #KEY-CV control variable is defined for all input fields that are part of the
browse key.

■ The input fields used to reposition the browse key, aswell as any additional input
fields, are definedwithin the #INPUT structure in the global data area (GDA) for
the browse module.

When more than one horizontal panel is required, use a different map for each
panel. Include an asterisk (*) in the map name (for example, MYMAP*) and the
asterisk will be replaced by the panel number during generation (for example,
MYMAP1,MYMAP2,MYMAP3). If more than nine horizontal panels are used, the
map name cannot exceed six bytes.

To support an action/selection column for browse-select modules, include the
column on themap as an array called #ACTIONS.Attach the #ACTION-CV control
variable to #ACTIONS. To display a list of available actions on the generated panel,
include the CDDIALDA.#KD-LINE1 andCDDIALDA.#KD-LINE2 variables on the
map.

Number of lines reserved for input prompts (typically 1, 2, or 3).Reserved input
lines

Enables/disables a single prompt to be displayed for all fields (for example, Date:____
__ __). This option applieswhen the key is a superdescriptor or redefined in Predict.

Single prompt

Enables/disables one prompt to be displayed for each field (for example, Year:____
Month:__Day:__). This option applieswhen the key is a superdescriptor or redefined
in Predict.

Multiple prompts

Up to eight additional input fields for the browse module. For information, see
Specify Field Details.

Internal map
non-key fields
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2 Select Finish.

The module is generated using the current specifications. When generation is complete, the
available user exits are displayed in theOutline view.

Or:

SelectNext.

The following panel is displayed:

Panel DisplayedWizard

Specify Restriction ParametersBrowse

Specify Additional Subprogram ParametersBrowse-Helpr and Browse-Subp

Specify #ACTION ParametersBrowse-Select, Browse-Select-Helpr, and
Browse-Select-Subp

Specify Field Details

Optionally, you can specify up to eight additional input fields for a browse module. These fields
are displayed at the bottomof the generated panel and allow the user to displaymore information.
For example, you can create an additional input field called Detail (format L) to display additional
record details. Users can select the Detail field to display the information.

Note: The additional input fields do not have to be in the Predict file definition.

This section covers the following topics:

■ Add a Non-Key Field
■ Delete a Non-Key Field
■ Edit a Non-Key Field

Add a Non-Key Field

To add a non-key field:

1 Select Add on the Specify Map Details panel.

The Specify Field Detailswindow is displayed. For example:
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2 Define the following parameters for the additional field:

DescriptionParameter

Name of the additional input field.Field name

Natural format and length for the field.Natural format/length

Starting occurrence of an array variable to place on the generated panel.

Note: The Starting and Ending occurrence values define the range of
occurrences of an array variable to place on the panel. If you specify a range
with different first and last values, a single prompt precedes all elements in
the range. (For multiple prompts, specify each occurrence separately.)

Starting occurrence

Ending occurrence of an array variable to place on the generated panel.Ending occurrence

Text displayed for the field on the generated browse panel. Intensified text
must be enclosed within angle (<>) brackets (or whatever attribute character

Prompt text

is set for intensify).If you do not specify a field prompt, Natural Construct
creates a prompt using the internal name of the input field.

Enables/disables the display of the prompt text.Prompt off

Change the default dynamic attribute characters. For information, see Change
the Dynamic Attribute Characters.

Dynamic Attributes
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DescriptionParameter

Panel number for the field for the first dimension. If a panel number is not
specified, the prompt is displayed on all panels.

Panel number

Enables/disables the display of the input field on a new line.New line

One ormore session parameters for the additional input field, such asAttribute
Definition (AD) or Edit Mask (EM). For example:

AD=I SG=ON EM='>'X HE='HELPR'

Session parameters

3 SelectOK to add the field.

Delete a Non-Key Field

To delete a non-key field:

1 Select the field you want to delete on the Specify Map Details panel.

2 SelectDelete.

The field is removed from the Internal map non-key fields table.

Edit a Non-Key Field

To edit a non-key field:

1 Select the field you want to edit on the Specify Map Details panel.

2 Select Edit.

Or:

Double-click on the row in the Internal map non-key fields section.

The Specify Field Detailswindow is displayed, showing the current settings for the field.

3 Edit the field settings.

4 SelectOK to save the changes.
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Specify Restriction Parameters

For a browse program, you can optionally limit the generated module to only browse records
prefixed by a global variable. If the prefix is a department code, for example, you can restrict the
browse to only those orders prefixed by a particular department code by setting the value of the
code as a function of a user ID and storing the value in the global data area.

For a browse helproutine or subprogram, you can limit the browse by passing the prefix portion
of the key. To display only the lines for a particular order, for example, you can pass the order
number (N6) to the subprogram and enter "N6" in theNatural format field on the Specify Addi-
tional Subprogram Parameters panel. On the Specify Restriction Parameters panel, mark the
Restrict browse with prefix field and enter "6" in theNumber of characters (bytes) field.

The following example displays the Specify Restriction Parameters panel for the Browse-Select
wizard:
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To specify restriction parameters:

1 Define the following optional parameters:

DescriptionParameter

Enables/disables the restriction of the browse by prefix. When this option is
selected, the browse is limited to values for which the primary key is prefixed
by or equal to the specified value.

Note: If you select this option, you must also specify either the number of
characters or number of components to use as the prefix and provide a field
name.

Restrict browse with
prefix

Number of bytes of the primary key to use as the prefix..

Note: You can specify either the number of characters or the number of
components, but not both.

Number of
characters (bytes)

Number of compound key components to use as the prefix. You can then use
the Prefix helproutine parameters options to assign the helproutine parameters.

Note: You can specify either the number of characters or the number of
components, but not both.

Number of
components

Name of the field containing the prefix value. The valuemust be a valid Natural
field name.

When generating a browse helproutine or subprogram, the prefix portion of the
key is assumed to be equal to #PDA-KEY (i.e., the value of the key passed to the
helproutine or subprogram). To override this default:

Field name

1. Enter the name of a variable in Field name.

2. Define the variable in the LOCAL-DATA user exit.

3. Assign a value to the field in the ASSIGN-PREFIX-VALUE user exit.

The assigned value (instead of #PDA-KEY) will then be used as the value for
the prefix portion of the key.

Enables/disables the protection of the prefix portion of the primary key for the
input field. When this option is selected, the prefix is displayed but cannot be
changed.

Note: To use this option, the primary keymust be a superdescriptor, a compound
IMS key, or redefined in Predict.

Protect prefix

Enables/disables the display of the prefix portion of the primary key. When this
option is selected, the prefix portion of the primary key is not displayed.

Note: To use this option, the primary keymust be a superdescriptor, a compound
IMS key, or redefined in Predict.

Suppress prefix
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DescriptionParameter

Up to two restriction helproutine parameters. For information, see Specify Prefix
Helproutine Parameters.

Note: This option only applies whenNumber of components is specified.

Helproutine
parameters

2 Select Finish.

The modules are generated using the current specifications. When generation is complete,
the available user exits are displayed in theOutline view.

3 Save the generated modules.

At this point, you can:

■ Use the NaturalONE Testing option to test a subprogram. For information, see Test a Sub-
program Directly in Application Testing.

■ Define user exits for the subprogram. For information, see Defining User Exits.
■ Edit generated source code that is not within user exits. For information about the protected
lines in the generated source code, see Using the Source Editor in Using NaturalONE.

■ Use NaturalONE functionality to upload all generated modules to the server.

Specify Prefix Helproutine Parameters

WhenNumber of components is specified on the Specify Restriction Parameters panel, you can
optionally attach a helproutine to the prefix of the primary key. This section covers the following
topics:

■ Add a Prefix Helproutine Parameter
■ Delete a Prefix Helproutine Parameter
■ Edit a Prefix Helproutine Parameter

Add a Prefix Helproutine Parameter

To add a prefix helproutine parameter:

1 Select Add on the Specify Restriction Parameters panel.

The Add Prefix Helproutine Parameterswindow is displayed. For example:

Code Generation134

Natural Construct Generation



2 Define the following parameters for the additional field:

DescriptionParameter

Name of the helproutine for the prefix. To attach a helproutine to the prefix of the
primary key, enter the name of the helproutine in this field. You can specify a
helproutine for each component.

Helproutine

Parameter for the helproutine for each component. Define the help parameters in
the LOCAL-DATA user exit.

Parameter name

3 SelectOK to add the helproutine.

Delete a Prefix Helproutine Parameter

To delete a prefix helproutine parameter:

1 Select the helproutine you want to delete on the Specify Restriction Parameters panel.

2 SelectDelete.

The helproutine is removed from the Prefix helproutine parameters table.

Edit a Prefix Helproutine Parameter

To edit a prefix helproutine parameter:

1 Select the helproutine you want to delete on the Specify Restriction Parameters panel.

2 Select Edit.

The Edit Prefix Helproutinewindow is displayed, showing the current settings for the hel-
proutine.
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Or:

Double-click on the row in the Prefix helproutine parameters section.

3 Edit the helproutine settings.

4 SelectOK to save the changes.

Specify #ACTION Parameters

For Browse-Select, Browse-Select-Helpr, and Browse-Select-Subp wizards, theSpecify #ACTION
Parameters panel is displayed after the SpecifyMapDetails panel. This panel defines the charac-
teristics of the action/selection field. For example:

To specify #ACTION parameters:

1 Define the following optional parameters:
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DescriptionParameter

Natural format and length of the action/selection field. The default is A1.Action format/length

Total number of action lines displayed on the generated panel. This number
corresponds to the maximum number of database records. The default is 14
lines.

Total action lines

Line number on which the action column begins. This number corresponds
to the first line containing database information (after the panel and field
heading lines). The default is 7.

Starting line

Determines whether each record requires more than one line. For example:

Address: Number-Street
City, Province
Country, Postal Code

Multiple screen lines

Number of the column in which the action/selection fields are displayed
(when not using an external map). This number determines the placement
of the action/selection entries. The default is 3.

Starting column

Enables a PF-key for the Add action (by default, PF4).

When generating a browse-select panel, you must decide how users will
add records to a file: by entering "A" in the Action field or by pressing an

Add action as PF-key

Add PF-key. The first method is effective when adding records to existing
files containing one or more records; the second method allows the user to
select theAddPF-keywhile the cursor is positioned anywhere on the screen
and add a record to an empty file.

Actions enabled for the generated browse-select panel. By default, no actions
are supported.

Actions supported

The parameters in this section are used to build the screen layout when not
using a predefined map.

Screen layout

Number of field heading lines. The default is one line.Field heading lines

Determines whether field headings are displayed with a line under them.
By default, field headings are underlined.

Underline headings

Number of blank lines between the field headings and the data region. The
default is one line.

Blank lines after headings

Number of lines reserved at the bottom of the panel for input keys and
additional fields. The default is one for input keys, plus the number of lines
for additional input fields that begin on new lines.

Note: Do not include the Direct Command line in the calculation of this
value.

Input key lines

2 Select Finish.

The module is generated using the current specifications. When generation is complete, the
available user exits are displayed in theOutline view.
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Or:

3 SelectNext.

The following panel is displayed:

Panel DisplayedWizard

Specify Restriction ParametersBrowse-Select

Specify Additional Subprogram ParametersBrowse-Select-Helpr or Browse-Select-Subp

Specify Additional Subprogram Parameters

The SpecifyAdditional SubprogramParameters panel is displayed after the SpecifyMapDetails
panel for Browse-Helpr and Browse-Subp wizards and after the Specify #ACTION Parameters
panel for Browse-Select-Helpr and Browse-Select-Subp wizards.

When generating a helproutine, the following information is displayed on the Specify Additional
Subprogram Parameters panel:

When generating a subprogram, the following information is displayed on the SpecifyAdditional
Subprogram Parameters panel:
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Use this panel to override the format and/or length of the passed parameter or pass an additional
parameter to the helproutine. The key for the browse-select may differ from the key for the calling
program. If the key differs, indicate the format and length of the passed key on this panel. Also
indicate the name of any additional helproutine parameter, as well as its format and length.

Use the top portion of this panel to specify the format and length of the help field (if it is different
from that of the primary browse key).

When generating a helproutine, use the bottomportion of this panel to specify additional paramet-
ers. If no additional parameters are specified, the generated helproutine only has one parameter
(#PDA-KEY), which contains the contents of the input field to which the helproutine is attached.
If the helproutine changes the value of #PDA-KEY, the altered value is displayed in the input field
when the helproutine returns control to the INPUT statement.

To specify additional subprogram parameters:

1 Define the following parameters:

DescriptionParameter

Name of the primary key. By default, #PDA-KEY is displayed.Field name

Natural format and length of the passed field (if it is different from that
of the key being browsed). This format becomes the format for the
#PDA-KEY field.

Natural format and length

Component parameters

Name of the additional parameter.Field name

Natural format and length of the additional parameter. Any valid
combination of format, length, and decimal positions under Natural is
allowed.

Natural format and length

Array dimensions. To declare the additional parameter as an array, enter
the array dimensions in the 1, 2, and 3 fields.

Array index 1, 2, and 3
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2 Select Finish.

The module is generated using the current specifications. When generation is complete, the
available user exits are displayed in theOutline view.

Or:

SelectNext.

TheSpecifyRestrictionParameterspanel is displayed. For information, see SpecifyRestriction
Parameters.

Object-Browse-Dialog Wizard

This section describes the specification parameters for the Object-Browse-Dialog wizard. This
wizard generates a character-based user interface to use with object-browse subprograms.

Because a browsemodule can be transformed into an object-browse subprogramand object-browse
dialog program, and because the browse module has different PF-keys and actions and contains
both UI and data access, you must consider how the Object-Browse-Dialog wizard works with a
transformed object-browse subprogram versus one that was not transformed. If a browse module
was transformed, the object-browse dialog program was generated automatically and there is no
need to create one (but you can regenerate the dialog program). To differentiate between the two
types in this section, thesemodules are referred to as a transformed object-browse dialog program
versus an object-browse dialog program.

This section covers the following topics:

■ Specify Standard Parameters
■ Specify Additional Parameters
■ Specify Specific Parameters

Note: For more information, refer to Object-Browse-Dialog Model, Natural Construct Object
Models.

Specify Standard Parameters

The Specify Standard Parameters panel is displayed when the wizard is invoked; it is similar for
all Object-Browse wizards.

To specify standard parameters:

1 Open the context menu in theNavigator view for the NaturalONE project in which youwant
to generate the modules.

Or:
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Open the context menu in theNavigator view for the library in which you want to generate
the modules.

2 Select Code Generation > New Using Construct Model > Object-Browse-Dialog.

The Specify Standard Parameters panel is displayed. For example:

3 Define the following parameters:
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DescriptionParameter

Name of the library in which to store the generated modules. Either type the name or
select Browse to display the available libraries for selection.

Library

Name of the dialog program to be generated. This name must be alphanumeric, a
maximum of eight characters in length, and cannot contain blanks.

Module

Title for the dialog program to be generated. The title is used internally to identifymodules
for the List GeneratedModules function on theGenerationmainmenu. You can customize
the title for your application.

Title

Brief description of what the generated module will do. This field is used internally for
documentation purposes.

Description

Optionally, you can define:

ProcedureTask

Type the name of the project in Project or select Browse to display
a window listing the existing projects for selection. The project
must currently exist.

A different NaturalONE project
into which to generate the
module(s).

Type the name of the folder in Folder or select Browse to display
awindow listing the existing folders for selection. The foldermust
currently exist within the selected NaturalONE project.

Note: This option allows you to generate modules into more
complex library structures (for example, "Natural-Libraries/my

A folder intowhich to generate the
module(s).

library (MYLIB)/SRC"). When this option is not specified, the
moduleswill be generated into the basic library folder (for example,
"Natural-Libraries/MYLIB/SRC",
"Natural-Libraries/MYLIB/Subprograms", etc.).

Type the heading in First heading. This heading is centered at the
top of the generated panel and intensified.

A first heading for display on the
generated panel(s).

Type the heading in Second heading. This heading is centered
under the first heading and intensified.

A second heading for display on
the generated panel(s).

SelectDo not populate first input screen. This option indicates
whether default data is automatically entered into fields on the

An option to suppress the
population of fields with default
data on the first input screen. first input screen. It can be used to provide consistency between

Natural Construct-generated browse and object-browsemodules.
By default, the first input screen is not populated for a transformed
object-browse dialog program and is populated for a generated
object-browse dialog program.

SelectGenerate a page title (when not on inputmap). This option
indicateswhether to automatically code the page title when amap

An option to generate a page title
when not on input map.

is not being used. By default, the page title is coded for a
transformed object-browse dialog program and is not coded for a
generated object-browse dialog program.

See Specify International Parameters.The language in which to display
text on the generated panel(s).
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ProcedureTask

See Generation Options.Generation options for the
module(s).

4 SelectNext.

The Specify Additional Parameters panel is displayed. For example:

Use this panel to define parameters for the related object-browse subprogram and, optionally,
to define screen parameters. The generated object-browse dialog uses this subprogram to re-
trieve records for display.

Specify Additional Parameters

To specify additional parameters:

1 Type the name of the subprogramused to retrieve records for display inObject-browse subp
or select Browse to display the available subprograms for selection.

2 Type the name of the logical key by which scrolling takes place in Input key or select Browse
to display the available logical keys for selection.

The specified key must be defined in the key PDA. For a transformed object-browse dialog
program, the input key begins with A- (Ascending). To preserve the browse ascending and
descending functionality, two keys are generated for the primary browse key: one that begins
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with A- and another that begins with D- (Descending). To expose this functionality to the end
user, variables must be set in the START-OF-PROGRAM user exit.

Optionally, you can define the following parameters:

DescriptionParameter

Object parameter data area (PDA) used by the specified object-browse subprogram.
By default, thewizardwill determine the name of the PDAbased on the subprogram
name. Alternatively, you can type the name or selectBrowse to display the available
data areas for selection (.NSA file extension).

Object PDA

Name of the key PDA used by the specified object-browse subprogram. The key
PDA is comprised of all fields that are components of the logical keys supported
by the subprogram. By default, the wizard will determine the name of the PDA

Key PDA

based on the subprogram name. Alternatively, you can type the name or select
Browse to display the available data areas for selection (.NSA file extension).

Name of the object local data area (LDA) used by the generated dialog program.
The object LDA contains the default field headings usedwhen generating user exits.

Object LDA

Either type the name or selectBrowse to display the available data areas for selection
(.NSL file extension).

Field name displayed for the input key on the generated panel. If a field name is
not provided, the default name will be used. Either type the name or select Browse

Prompt

to display the available SYSERR numbers for selection. For information, see Select
a Message Number.

Specify the language used to display text on the generated panels. See Specify Screen
Parameters.

Screen
Parameters

3 Select Finish.

The modules are generated using the current specifications. When generation is complete,
the available user exits are displayed in theOutline view.

Or:

SelectNext.

The Specify Specific Parameters panel is displayed. For example:
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Use this panel to define the screen layout, map name, and support for exporting records to a
work file or printer. You can also use this panel to change the style of actions used and the
window settings.

Specify Specific Parameters

To specify specific parameters:

1 Define the following optional parameters:

DescriptionParameter

Number of records displayed on the screen at one time (by default, the
generated dialog program displays 10 records at one time).

Records displayed

Natural format and length for the selection column (for example, A1).Natural format/length

Number of horizontal panels used for the generated dialog program
(by default, one panel is used).

Horizontal panels

Maximumnumber of scroll pageswithinwhich users can scroll forward
and backward (by default, 10 scroll pages).

Backward scroll pages

Name of the layout map used by the generated dialog program. Either
type the name or select Browse to display the available maps for
selection (.NSM file extension).

Input using map
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DescriptionParameter

If this option is selected, records are exported to a work file (instead of
the screen).

Export data support

If this option is selected, records are exported to a local printer (instead
of the screen).

Report data support

If this option is selected, the generated dialog program uses the same
actions as those used by a BROWSE-SELECT-generated module.

Note: This option is only relevant for transformed object-browse dialog
programs and is not modifiable by this wizard.

Use BROWSE-SELECT
actions

Specify window parameters. For information, see Change the Window
Settings.

Window Parameters

2 Select Finish.

The modules are generated using the current specifications. When generation is complete,
the available user exits are displayed in theOutline view.

3 Save the generated modules.

At this point, you can:

■ Define user exits for the dialog program. For information, see Defining User Exits.
■ Edit generated source code that is not within user exits. For information about the protected
lines in the generated source code, see Using the Source Editor in Using NaturalONE.

■ Use NaturalONE functionality to upload all generated modules to the server.

Object-Browse-Select-Subp Wizard

This section describes the specification parameters for theObject-Browse-Select-Subpwizard. This
wizard generates a subprogram similar in functionality to a subprogramgenerated by the Browse-
Select-Subpmodel. Both subprograms allowusers to updatemultiple rows at one time. The primary
difference between the two is that an object-browse-select subprogram can accommodate a cli-
ent/server environment and you can use a subprogram proxy to access the generated code as a
business service.

This section covers the following topics:

■ Specify Standard Parameters
■ Specify Additional Parameters

Note: Formore information, refer toObject-Browse-Select-SubpModel,Natural Construct Object
Models.
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Specify Standard Parameters

The Specify Standard Parameters panel is displayed when the wizard is invoked; it is similar for
all Object-Browse wizards.

To specify standard parameters:

1 Open the context menu in theNavigator view for the NaturalONE project in which youwant
to generate the modules.

Or:

Open the context menu in theNavigator view for the library in which you want to generate
the modules.

2 Select Code Generation > New Using Construct Model > Object-Browse-Select-Subp.

The Specify Standard Parameters panel is displayed. For example:
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3 Define the following parameters:

DescriptionParameter

Name of the library in which to store the generated modules. Either type the name or
select Browse to display the available libraries for selection.

Library

Name of the subprogram to be generated. This name must be alphanumeric, a
maximum of eight characters in length, and cannot contain blanks.

Module

Title for the subprogram to be generated. The title is used internally to identifymodules
for the List Generated Modules function on the Generation main menu. You can
customize the title for your application.

Title

Brief description of what the generated module does. This field is used internally for
documentation purposes.

Description
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DescriptionParameter

Name of the subprogram used to browse this object. Either type the name of the
subprogram or select Browse to display the available subprograms for selection.

Note: The object-browse subprogram must be available in the current library.

Object-browse

Name of the parameter data area associated with the static occurrences value for
scrolling parameters. By default, the PDA name contains the first five characters of

PDA

the module name and the number of static occurrences (for example, BCUSTS20).
Either type the name or select Browse to display the available data areas for selection.

Note: To generate the PDA, in addition to the object-browse-select subprogram, select
Generate.

Optionally, you can define:

ProcedureTask

Type the name of the project in Project or select Browse to display
a window listing the existing projects for selection. The project must
currently exist.

A different NaturalONE project
into which to generate the
module(s).

Type the name of the folder in Folder or select Browse to display a
window listing the existing folders for selection. The folder must
currently exist within the selected NaturalONE project.

Note: This option allows you to generatemodules intomore complex
library structures (for example, "Natural-Libraries/my library

A folder into which to generate
the module(s).

(MYLIB)/SRC"). When this option is not specified, the modules will
be generated into the basic library folder (for example,
"Natural-Libraries/MYLIB/SRC",
"Natural-Libraries/MYLIB/Subprograms", etc.).

Type the name of the object-maint subprogram in Object-maint or
select Browse to display a window listing the existing subprograms
for selection. The subprogram must currently exist.

The object-maintenance subprogram cannot process intra-object
relationships. This allows the data presented to the client to be
manageable and all data to be modifiable.

An object-maintenance
subprogram that will be used to
maintain the object.

Note: If you use an object-maint and an object-browse subprogram,
both subprograms must use the same primary file.

De-select Time.

By default, this option is selected and code is generated to time how
long a business service takes to execute. The result is returned in the
business service message.

An option to restrict the
generation of code to time how
long a business service takes to
execute.

Type the new number in Static occurrences. The PDA (parameter
data area) associatedwith the static occurrences hard codes this value

Change the number of rows
processed and sent across the
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ProcedureTask

network at one time (by default,
20, unless the rows are extremely
large).

(which is used to identify the V value in the object-browse
subprogram) in the object-browse-select subprogram.

To identify the number of occurrences in this PDA, the default PDA
name contains the first five characters of the module name and the
number of static occurrences (for example, "BCUSTS20" when the
static occurrences value is "20").

Note: If you change the number of static occurrences, you should
also change this number in the name of the default PDA.

SelectUsemessage numbers. When this option is selected, message
numbers rather than message text will be used for all REINPUT and
INPUT messages.

Note: Use the same technique consistently throughout your
application, since passingmessages betweenmodules using different
techniques will not always produce the desired results.

An option to use message
numbers for all REINPUT and
INPUT messages.

See Generation Options.Generation options for the
module(s).

4 SelectNext.

The Specify Additional Parameters panel is displayed. For example:
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This panel displays the names of the methods and browse keys used to determine the sort
order for records returned by the object-browse subprogram (specified on the first wizard
panel).

Specify Additional Parameters

Use this panel to rename the default methods, if desired.

To rename the default methods:

1 Select the method you want to rename in theMethod parameters section.

2 Select Edit.

The Edit Method Namewindow is displayed. For example:

3 Change the name of the method inMethod name.

4 SelectOK.

The new name is displayed in theMethod parameters section.

5 Select Finish.

The modules are generated using the current specifications. When generation is complete,
the available user exits are displayed in theOutline view.

6 Save the generated modules.

At this point, you can:

■ Use the NaturalONE Testing option to test a subprogram. For information, see Test a Sub-
program Directly in Application Testing.

■ Define user exits for the subprogram. For information, see Defining User Exits.
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■ Edit generated source code that is not within user exits. For information about the protected
lines in the generated source code, see Using the Source Editor in Using NaturalONE.

■ Use NaturalONE functionality to upload all generated modules to the server.

Object-Browse-Subp Wizard

This section describes the specification parameters for theObject-Browse-Subpwizard. Thiswizard
generates the browse subprogram for an object, as well as three parameter data areas:

■ Object PDA (defines the returned row data)
■ Key PDA (defines the search key values)
■ Restricted PDA ( defines private data used internally by the browse object to maintain context)

This section covers the following topics:

■ Specify Standard Parameters
■ Specify Additional Parameters
■ Specify Key Details
■ Specify Logical Key Components

Note: For more information, refer to Object-Browse-Subp Model, Natural Construct Object
Models.

Specify Standard Parameters

The Specify Standard Parameters panel is displayed when the wizard is invoked; it is similar for
all Object-Browse wizards.

To specify standard parameters:

1 Open the context menu in theNavigator view for the NaturalONE project in which youwant
to generate the modules.

Or:

Open the context menu in theNavigator view for the library in which you want to generate
the modules.

2 Select Code Generation > New Using Construct Model > Object-Browse-Subp.

The Specify Standard Parameters panel is displayed. For example:
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3 Define the following parameters:

DescriptionParameter

Name of the library in which to store the generated modules. Either type the name or
select Browse to display the available libraries for selection.

Library

Name of the subprogram to be generated. This namemust be alphanumeric, a maximum
of eight characters in length, and cannot contain blanks.

Module

Title for the subprogram to be generated. The title is used internally to identify modules
for the List GeneratedModules function on theGenerationmainmenu. You can customize
the title for your application.

Title

Brief description of what the generated module does. This field is used internally for
documentation purposes.

Description

Optionally, you can define:
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ProcedureTask

Type the name of the project in Project or select Browse to display a
window listing the existing projects for selection. The project must
currently exist.

A differentNaturalONEproject
into which to generate the
module(s).

Type the name of the folder in Folder or select Browse to display a
window listing the existing folders for selection. The folder must
currently exist within the selected NaturalONE project.

Note: This option allows you to generatemodules intomore complex
library structures (for example, "Natural-Libraries/my library

A folder into which to generate
the module(s).

(MYLIB)/SRC"). When this option is not specified, the modules will
be generated into the basic library folder (for example,
"Natural-Libraries/MYLIB/SRC",
"Natural-Libraries/MYLIB/Subprograms", etc.).

Select Use message numbers. When this option is selected, message
numbers rather than message text will be used for all REINPUT and
INPUT messages.

Note: Use the same technique consistently throughout your
application, since passingmessages betweenmodules using different
techniques will not always produce the desired results.

An option to use message
numbers for all REINPUT and
INPUT messages.

See Generation Options.Generation options for the
module(s).

4 SelectNext.

The Specify Additional Parameters panel is displayed. For example:
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Use this panel to define additional parameters for your object-browse subprogram.

Specify Additional Parameters

To specify additional parameters:

1 Define the following parameters:

Required/Optional/ConditionalDescriptionParameter

RequiredNameof the Predict viewused by the generated subprogram.
The viewmust be defined in Predict. Either type the name or
select Browse to display the available views for selection.

Predict
view

OptionalName of the data definition module (DDM) corresponding
to the primary file. If this field is not specified, theDDMname
defaults to the primary file name. The Predict definition of
the primary file determines which fields are included in the

Natural
DDM

DEFINE DATA section of the generated code. The format of
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Required/Optional/ConditionalDescriptionParameter

the generated code in the DEFINE DATA section has the
following structure:

1 primary-file-name VIEW ↩
OF data-definition-module
  2 fields pulled from Predict ↩
of primary-file-name

OptionalView name of the primary file for the generated subprogram.
This view must be defined in the LOCAL-DATA user exit or
a local data area (LDA).

If this field is not specified, a view is generated containing all
fields in the Predict view. TheMAX.OCCURSvalue in Predict

Program
view

determines how many occurrences of MU/PE fields are
included on the panel.

OptionalUp to six logical keys to determine the sort order for records
returned by the object-browse subprogram. For information,
see Specify Key Details.

Logical
keys

OptionalRetrieves the default key parameters for the specified Predict
view and lists them in the Logical keys table.

Refresh
Default
Keys

RequiredObject parameter data area (PDA) that defines the rows
returned to the object-browse subprogram and the columns

Object
PDA

within each row. Either type the name or select Browse to
display the available PDAs for selection. Alternatively, you
can selectGenerate to have the data area generated by the
wizard.

The generated object PDA contains one column for each field
defined in the specified Predict view (as well as additional
columns). You can remove any fields that are not components
of the primary key.

Note: When creating a new specification, this field is filled in
by default with the first five bytes of the subprogram name,
plus the suffix "ROW".

RequiredKey PDA that contains all of the components contained in the
logical keys, aswell as a unique IDfield. Either type the name

Key PDA

or select Browse to display the available PDAs for selection.
Alternatively, you can selectGenerate to have the data area
generated by the wizard.

Note: When creating a new specification, this field is filled in
by default with the first five bytes of the subprogram name,
plus the suffix "KEY".
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Required/Optional/ConditionalDescriptionParameter

RequiredRestricted PDA that stores data, such as the last sort key, the
last starting value, the last row returned, etc. so that the next

Restricted
PDA

set of consecutive records is returned to the caller. Either type
the name or select Browse to display the available PDAs for
selection. Alternatively, you can selectGenerate to have the
data area generated by the wizard.

Note:

1. The contents of this data area should not be altered by the
calling module.

2. When creating a new specification, this field is filled in by
default with the first five bytes of the subprogram name,
plus the suffix "PRI".

2 Select Finish.

The modules are generated using the current specifications. When generation is complete,
the available user exits are displayed in theOutline view.

3 Save the generated modules.

At this point, you can:

■ Use the NaturalONE Testing option to test a subprogram. For information, see Test a Sub-
program Directly in Application Testing.

■ Define user exits for the subprogram. For information, see Defining User Exits.
■ Edit generated source code that is not within user exits. For information about the protected
lines in the generated source code, see Using the Source Editor in Using NaturalONE.

■ Use NaturalONE functionality to upload all generated modules to the server.

Specify Key Details

Optionally, you can specify up to six logical keys to determine the sort order for records returned
by the object-browse subprogram. The calling program indicates the sort order by assigning CD-
BRPDA.SORT-KEY. If a sort key value is not assigned, the first logical key is used as the default.

The logical key names can map to as many as five components. If a logical key contains only one
component, the logical key name is optional. If you do not specify a logical key name, this field
defaults to the name of the key component.

If the key field contains MU or PE fields, the rows returned also contain an index value that
identifies which occurrence of the MU/PE field satisfies the Read condition.
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This section covers the following topics:

■ Add a Logical Key
■ Delete a Logical Key
■ Edit a Logical Key

Add a Logical Key

To add a logical key:

1 Select Add on the Specify Additional Parameters panel.

The Specify Key Detailswindow is displayed. For example:

2 Define the following parameters for the additional key field:

DescriptionParameter

Name of the logical key for which you are defining details.Logical name

Number of components of a superdescriptor (compound key) to use in the logical
key. Use this optionwhen the relational database table contains a superdescriptor
with many components.

To restrict the number of components, specify the limit in this field. For example,
to use the first two components of the superdescriptor, enter "2".

Limit components

Tip: Using fewer components in the keymaymake accessing the keymore efficient.
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DescriptionParameter

Prefix to use for components of a superdescriptor (compound key), which
optimizes the generated SELECT statements when browsing by compound keys

Prefix components

that have many components. You can use this option to define a browse object
that requires specific values as the leading components.

Note: WhenbrowsingAdabas orVSAMfiles by a single superdescriptor, efficiency
is not affected by specifying prefix key components.

If this parameter is selected, the object-browse subprogram contains an additional
histogram version of one or more logical key values. This allows the calling

Histogram support

program to request a histogram be returned. Rather than returning all of the
predefined columns for the object-browse subprogram, only the specific key
column is returned along with a count of the number of records containing the
key value.

Note: This option is only allowedwhen the associated key has one key component.

Up to five components for a logical key that maps to more than one component.
For information, see Specify Logical Key Components.

Key Component

3 SelectOK to add the field.

Delete a Logical Key

To delete a logical key:

1 Select the field you want to delete on the Specify Additional Parameters panel.

2 SelectDelete.

The key is removed from the Logical keys table.

Edit a Logical Key

To edit a logical key:

1 Select the field you want to edit on the Specify Additional Parameters panel.

2 Select Edit.

Or:

Double-click on the row in the Key Component section.

The Specify Field Detailswindow is displayed, showing the current settings for the field.

3 Edit the field settings.

4 SelectOK to save the changes.
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Specify Logical Key Components

Optionally, you can add up to five components for a logical key that maps to more than one
component.

To add a logical key component:

1 Select Add on the Specify Additional Parameters panel.

The Specify Logical Key Componentswindow is displayed. For example:

2 Define the following parameters for the key component:
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DescriptionParameter

Type the name of the key component in Key component or select Browse to display a
list of components for selection. For example:

You can specify either one superdescriptor or multiple individual descriptors.

Key
component

Note: To display all fields, deselectDescriptors only.

Indicates whether key component values are listed in ascending or descending sequence
in the generated subprogram. To have the key component values listed in descending
sequence, select this parameter. Otherwise, values are sorted in ascending sequence.

Note: For Adabas and VSAM files, all components of a logical key must use the same
sort order.

Descending

3 SelectOK to save the settings.

Object-Maint-Dialog Wizard

This section describes the specification parameters for theObject-Maint-Dialogwizard. Thiswizard
generates a character-based user interface (Natural program) for an object-maintenance process.
The dialog component communicateswith the user and invokesmethods (data actions) implemen-
ted by the object-maintenance subprogram. To generate a complete maintenance process using
Natural Construct’s object-oriented approach, use this wizard in conjunction with the Object-
Maint-Subp wizard (which also generates the object PDA and restricted PDA).

This section covers the following topics:
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■ Specify Standard Parameters
■ Specify Additional Parameters
■ Specify Input Maps for Horizontal Panels
■ Define Horizontal Panel Details
■ Define Scroll Region Details

Note: For more information, refer to Object-Maint-Dialog Model, Natural Construct Object
Models.

Specify Standard Parameters

The Specify Standard Parameters panel is displayed when the wizard is invoked; it is similar for
all Object-Maint wizards.

To specify standard parameters:

1 Open the context menu in theNavigator view for the NaturalONE project in which youwant
to generate the modules.

Or:

Open the context menu in theNavigator view for the library in which you want to generate
the modules.

2 Select Code Generation > New Using Construct Model > Object-Maint-Dialog.

The Specify Standard Parameters panel is displayed. For example:

Code Generation162

Natural Construct Generation



Notes:

1. To change the name of the project, type the name of a new project in Project or select
Browse to display the available projects for selection.

2. For information about theOptions button, see Generation Options.

3 Define the following parameters:

DescriptionParameter

Name of the library in which to store the generated modules. Either type the name
or select Browse to display the available libraries for selection.

Library

Name of the dialog program to be generated. This name must be alphanumeric, a
maximum of eight characters in length, and cannot contain blanks.

Module
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DescriptionParameter

Name of the global data area (GDA) used by the dialog program to be generated.
To allow inter-program communication, generatedmodules require a small number

Global data area

of global variables. The supplied CDGDA global data area contains the global
variables required to test a generated module. Before creating a new application,
copy this GDA from the SYSTEM library and rename it to match your naming
conventions. Then add any additional global variables your applicationmay require.

Note: The MSG-INFO level 1 structure in the GDAmust be identical to MSG-INFO
level 1 structure in CDPDA-M.

Title for the dialog program to be generated. The title is used internally to identify
modules for the List Generated Modules function on the Generation main menu.
You can customize the title for your application.

Title

Brief description of what the generated module will do. This field is used internally
for documentation purposes.

Description

First heading displayed on the generated panel. This heading is centered at the top
of the generated panel and intensified.

First heading

Optionally, you can define:

ProcedureTask

Type the name of the project in Project or select Browse to
display a window listing the existing projects for selection. The
project must currently exist.

A different NaturalONE project into
which to generate the module(s).

Type the name of the folder in Folder or selectBrowse to display
a window listing the existing folders for selection. The folder
must currently exist within the selected NaturalONE project.

Note: This option allows you to generate modules into more
complex library structures (for example, "Natural-Libraries/my

A folder into which to generate the
module(s).

library (MYLIB)/SRC"). When this option is not specified, the
modules will be generated into the basic library folder (for
example, "Natural-Libraries/MYLIB/SRC",
"Natural-Libraries/MYLIB/Subprograms", etc.).

Type the name of the GDA block inWith block. You need only
specify the lowest level block name; the corresponding path

A GDA block for use with the
specified GDA.

name is determined automatically. For more information about
GDA blocks, see the Natural documentation.

Type the heading in Second heading. This heading is centered
under the first heading and intensified.

A second heading for display on the
generated panel(s).

See Specify Common Parameters.Commonparameters, such as support
for direct command processing,
message numbers, and password
checking.

See Generation Options.Generation options for themodule(s).
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4 SelectNext.

The Specify Additional Parameters panel is displayed. For example:

Use this panel to define parameters for the related object-maint subprogram and, optionally,
to define screen parameters.

Specify Additional Parameters

To specify additional parameters:

1 Define the following parameters:

DescriptionField

Name of the subprogram invoked by the generated dialog program. The specified
subprogram must exist in the current library. Name of the object-maintenance
subprogramused by the generated dialog program. Either type the name or select
Browse to display the available subprograms for selection.

Object maint
subprogram
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DescriptionField

Length of the action field. By default, the length is "1" and all action fields except
Former aremarked. If you do not want the generated dialog program to perform

#ACTION field
length

a particular action, deselect the corresponding action field. At least one action
must be selected.

The available actions are:

■ Add (adds the specified object)
■ Browse (name of the generated subprogram that supports the Browse action;
either type the name or select Browse to display the available subprograms
for selection)

■ Clear (clears the specified field values from the panel)
■ Display (displays the specified object)
■ Modify (modifies the specified object)
■ Next (displays the contents of the record having the next higher primary key
value from the current key value)

■ Purge (removes the specified object)
■ Former (displays the contents of the record having the next lower primary key
value from the current key value)

Note:

1. To add user-defined actions, see Add an Action, Natural Construct Generation.

2. When generating an object-maintenance dialog program, this feature works
together with two user exits. For information about these exits, see
SELECT-ADDITIONAL-ACTIONSandADD-ACTION-PROCESSING,Natural
Construct Generation.

Indicates whether the output from the generated object-maintenance dialog
program is displayed in a window instead of on a panel.

Window support

Indicates whether actions can be selected by cursor.Pushbutton support

Name of the field on the map where the cursor is automatically placed by the
generated dialog program.

Mark cursor field

Change the defaultwindowparameters. For information, seeChange theWindow
Settings.

WindowParameters

2 SelectNext.

The Specify Input Map(s) for Horizontal Panel(s) panel is displayed. For example:
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Use this panel to define horizontal panels and layout maps and, optionally, add scroll regions
for the horizontal panels.

Specify Input Maps for Horizontal Panels

By default, the generated dialog program uses one panel and you must specify a layout map for
that panel.

To specify the layout map for panel 1:

1 Select the "1" row in Add Horizontal ....

TheDelete and Edit buttons are enabled.

2 Select Edit.

TheDefine Horizontal Panel Detailswindow is displayed. For information, see Define Ho-
rizontal Panel Details.
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Note: You can also use theDefineHorizontal Panel Detailswindow to add additional
horizontal panels. For information, see Add a Horizontal Panel.

3 Either type the name of the layout map inMap or select Browse to display a list of available
maps for selection.

The Specify Input Maps for Horizontal Panels panel is redisplayed, showing the name of
the layout map in Input Map for panel 1.

4 Select Finish.

The modules are generated using the current specifications. When generation is complete,
the available user exits are displayed in theOutline view.

5 Save the generated modules.

At this point, you can:

■ Define user exits for the dialog program. For information, see Defining User Exits.
■ Edit generated source code that is not within user exits. For information about the protected
lines in the generated source code, see Using the Source Editor in Using NaturalONE.

■ Use NaturalONE functionality to upload all generated modules to the server.

Define Horizontal Panel Details

Optionally, you specify up to nine horizontal panels for the generated dialog (you must specify
aminimumof one panel). Ifmore than one panel is specified, the left and right PF-keys are activated
in the generated program to allow left and right scrolling between panels.

This section covers the following topics:

■ Add a Horizontal Panel
■ Delete a Horizontal Panel
■ Edit a Horizontal Panel

Add a Horizontal Panel

To add a horizontal panel:

1 Select Add on the Specify Input Maps for Horizontal Panels panel.

Define Horizontal Panel Detailswindow is displayed. For example:
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2 Define the following parameters for the horizontal panel:

DescriptionField

Name of the layout map used for the corresponding panel. Either type the name of
the layout map or select Browse to display a list of available maps for selection.

Map

To create a scroll region with a third dimension, specify the maximum depth
occurrences value. For example, for a calendar with the months and days forming
the first two dimensions (horizontal and vertical) and the year forming the third
dimension (depth), you can specify "3" to scroll up to three yearly tables of calendar
months and days, and within each yearly table, scroll vertically through the days.

The Depth occurrences value applies to the 3rd dimension on a panel, which means
that it applies to all 3-dimension arrays on the map when using the #DEPTH index
variable.

Depth
occurrences

To allow the value of the #DEPTH variable to be changed, you can either place the
#NEXT-DEPTH (P3) variable on the specified map or use PF-keys that you process
in the AFTER-INPUT user exit.

Information for up to four vertical scroll regions for each horizontal panel. To define
a scroll region, select Add. For information, see Define Scroll Region Details.

Scroll region
details

3 SelectOK to add the panel.
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Delete a Horizontal Panel

To delete a horizontal panel:

1 Select the panel you want to delete on the Specify Input Maps for Horizontal Panels panel.

2 SelectDelete.

The panel is removed from the Scroll region details table.

Edit a Horizontal Panel

To edit a horizontal panel:

1 Select the panel you want to edit on the Specify Input Maps for Horizontal Panels panel.

2 Select Edit.

Or:

Double-click on the row in the Scroll region details table.

TheDefine Horizontal Panel Detailswindow is displayed, showing the current settings for
the panel.

3 Edit the panel settings.

4 SelectOK to save the changes.

Define Scroll Region Details

Optionally, you can define up to four vertical scroll regions (consisting of vertical arrays) for each
horizontal panel. Scroll regions are only required for array fields. For example, assume you have
an array field called #YEAR and each occurrence contains one month, but there is only enough
space on the screen to display three months. In this case, a scroll region with a screen occurrences
value of "3" is required.

In addition to scrolling through the months, you may also want to display the revenue for each
month and have the revenue data change when the month changes. To do this, the starting index
for #YEAR and #REVENUE must be the same. For example, assume the following:

#YEAR (A4/12)
#REVENUE (N5.1/12)

On the specified layout map, there should be three occurrences of both #YEAR and #REVENUE.
For example, if these fields are in the first scroll region, use #ARRAY1 as the starting index for
both fields. The object-maint dialog program will generate the appropriate code based on the
values defined for the scroll region (for example, top left and bottom right). If the cursor is in the
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area defined by the upper left and bottom right coordinates, then #ARRAY1 will be incremented
appropriately when the forward or backward PF-keys are selected.

Tip: You can think of a two-dimensional (2D) array as a collection ofmany one-dimensional
(1D) arrays. And you can think of a fixed instance of a third dimension of a three-dimen-
sional (3D) array as a 2D array. Therefore, a vertical scroll region on a generated panel can
consist of 1D, 2D, or 3D arrays.

This section covers the following topics:

■ Add a Scroll Region
■ Delete a Scroll Region
■ Edit a Scroll Region

Add a Scroll Region

Note: If you add scroll regions, the specified map should contain array fields that match
the specified values.

To add a scroll region:

1 Select Add on the Define Horizontal Panel Details panel.

Define Scroll Region Detailswindow is displayed. For example:

2 Define the following parameters for the scroll region:
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DescriptionField

Total number of scrollable lines required for the scroll region. This value applies
when the generated dialog program includes a line scroll feature to scroll:

Total occurrences

■ Records in a secondary or tertiary file
■ Multiple-valued fields (MUs)
■ Periodic groups (PEs)

The generated program ensures that the values assigned to the array index
values (#ARRAY1 through #ARRAY4) do not exceed the total occurrences value
for each array.

Total number of lines displayed on the panel at one time (used when the Total
occurrences value is specified).

Screen occurrences

Panel number to force a particular starting from value for a scroll region on a
panel (so it has the same value as another panel). Each panel maintains its own
current values for #ARRAYn, where n is 1, 2, 3, or 4.

Scroll with panel

Location of the top left corner of the scroll region. A scroll region is always
rectangular and is defined by specifying the panel coordinates of the top left

Scroll region location

Top left and bottom right corners. Users can press the bkwrd and frwrd PF-keys to
position the scroll regions backward and forward.

The values for the top left corner are:

■ Line

Starting line number (vertical axis).
■ Column

Starting column number (horizontal axis).

Location of the bottom right corner of the scroll region. These values are:Scroll region location

Bottom right ■ Line

Ending line number (vertical axis).
■ Column

Ending column number (horizontal axis).

3 SelectOK to add the scroll region.
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Delete a Scroll Region

To delete a scroll region:

1 Select the scroll region you want to delete on the Define Horizontal Panel Details panel.

2 SelectDelete.

The scroll region is removed from the Scroll region details table.

Edit a Scroll Region

To edit a scroll region:

1 Select the scroll region you want to edit on the Define Horizontal Panel Details panel.

2 Select Edit.

Or:

Double-click on the row in the Scroll region details table.

TheDefine Scroll Region Detailswindow is displayed, showing the current settings for the
panel.

3 Edit the scroll region settings.

4 SelectOK to save the changes.

Object-Maint-Subp Wizard

This section describes theObject-Maint-Subpwizard,which generates a subprogram thatmaintains
complex data objects. The subprogram updates all entities within an object and contains a full
range of integrity checks (as defined by Predict relationships) and object semantics (in the form
of Predict automatic rules or object manipulation within user exits).

This section covers the following topics:

■ Specify Standard Parameters
■ Specify Additional Parameters
■ Specify Input Parameters

Notes:

1. For information about the Object-Maint-Subp model, refer toObject-Maint-Subp Model,Natural
Construct Object Models.

2. Formore information about creating an object-maintenance process, refer toDesignMethodology,
Natural Construct Generation.
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Specify Standard Parameters

The Specify Standard Parameters panel is displayed when the wizard is invoked; it is similar for
all Object-Maint wizards.

To specify standard parameters:

1 Open the context menu in theNavigator view for the NaturalONE project in which youwant
to generate the modules.

Or:

Open the context menu in theNavigator view for the library in which you want to generate
the modules.

2 Select Code Generation > New Using Construct Model > Object-Maint-Subp.

The Specify Standard Parameters panel is displayed. For example:

Notes:

1. To change the name of the project, type the name of a new project in Project or select
Browse to display the available projects for selection.

2. For information about theOptions button, see Generation Options.
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3 Define the following parameters:

DescriptionParameter

Name of the library in which to store the generated modules. Either type the name or
select Browse to display the available libraries for selection.

Library

Name of the subprogram to be generated. This namemust be alphanumeric, a maximum
of eight characters in length, and cannot contain blanks.

Module

Title for the subprogram to be generated. The title is used internally to identify modules
for the List GeneratedModules function on theGenerationmainmenu. You can customize
the title for your application.

Title

Brief description of what the generated subprogram does. This field is used internally
for documentation purposes.

Description

Optionally, you can define:

ProcedureTask

SelectUse hash-lockingmethod. When thismethod is selected,
theHoldfieldparameter is disabled on the second specification
panel and theObject LDA parameter is enabled. To enable the
Hold field, deselect Use hash-locking method.

The hash-locking method of
optimistic record locking (instead of
the timestamp method).

Select Use message numbers. When this option is selected,
message numbers rather than message text will be used for all
REINPUT and INPUT messages.

Note: Use the same technique consistently throughout your
application, since passing messages between modules using
different techniqueswill not always produce the desired results.

Message numbers for all REINPUT
and INPUT messages (instead of
message text).

See Generation Options.Generation options for themodule(s).

4 SelectNext.

The Specify Additional Parameters panel is displayed. For example:
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Use this panel to define additional parameters for your object-maintenance subprogram.

Specify Additional Parameters

To specify additional parameters:

1 Define the following parameters:

DescriptionParameter

Nameof the Predict viewused by the generated subprogram. The viewmust be defined
in Predict. Either type the name or select Browse to display the available views for
selection.

Predict view

Name of the key in Predict for the primary file. This key becomes the primary key to
access the view for maintenance. The key can be a descriptor, superdescriptor, or
subdescriptor. If the key does not exist in the specified Predict file, an error message
is displayed.

Note: When Predict is used and the primary key is specified in the file, this parameter
is not required.

Primary key

Name of the field used to logically protect the record against intervening update or
delete actions. Because an object-maintenance subprogram does not use the

Hold field

record-holding facilities of the DBMS to lock records during a GET operation, a hold
field must exist in the primary file for the object. Valid data types are:

■ T *TIMX
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DescriptionParameter

■ A10 *TIME
■ B8 *TIMESTMP
■ N7 *TIMN
■ A26 *TIMX (DB2 time stamp format)
■ If the format is none of the above, it must be numeric.

Note: This field is enabled when the timestamp method for record locking is selected
on the Specify Standard Parameters panel (i.e., the Use hash-locking method option
is not selected).

Name of the object parameter data area (PDA) that defines the rows returned to the
object-maint subprogram and the columns within each row. Either type the name or

Object PDA

select Browse to display the available PDAs for selection. Alternatively, you can select
Generate to have the data area generated by the wizard.

The generated object PDA contains one column for each field defined in the specified
Predict view (as well as additional columns). You can remove any fields that are not
components of the primary key.

Note: When creating a new specification, this field is filled in by default with the first
five bytes of the subprogram name, plus the suffix "ROW".

Name of the restricted PDA that stores data, such as the last sort key, the last starting
value, the last row returned, etc. so that the next set of consecutive records is returned

Restricted
PDA

to the caller. Either type the name or select Browse to display the available PDAs for
selection. Alternatively, you can selectGenerate to have the data area generated by
the wizard.

Note:

1. The contents of this data area should not be altered by the calling module.

2. When creating a new specification, this field is filled in by default with the first five
bytes of the subprogram name, plus the suffix "PRI".

Indicateswhether an existing object PDAor restricted PDA is regenerated. Regeneration
is required when fields have changed in the file. If the PDAs do not exist, they will be
automatically generated by the wizard.

Generate

Name of the object local data area generated for the object-maintenance subprogram.

Note: This field is enabled when the Use hash-locking method option for record
locking is selected on the Specify Standard Parameters panel.

Object LDA

2 SelectNext.

The Specify Input Parameters panel is displayed. For example:
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Use this panel to define additional input parameters for your object-maintenance subprogram.

Specify Input Parameters

To specify input parameters:

1 Define the following parameters:

DescriptionParameter

Object description used in messages. If you specify "Person", for example, messages are
displayed as "Person not found" and "Person displayed".

Description

Name of the level 1 structure used to qualify the fields in the object PDA. (It is easier to
identify the source of these attributes when the PDAname is used for this purpose.) The
object name should be kept to a reasonable length.

Note: The object name cannot match the name of a file included in the object, nor any
field in the object.

Name

If you want to log objects, you have to create a log file corresponding to each entity
within the object. The name of the log file is the name of the object file concatenatedwith

Log file
suffix

the suffix specifiedhere. For example, if the object consists of theNCST-ORDER-HEADER
and NCST-ORDER-LINES entities and you specify "-LOG", the log file names are
NCST-ORDER-HEADER-LOG and NCST-ORDER-LINES-LOG.

The following fields are required in the log file that corresponds to the header entity in
the object:

■ LOG-TIME

Assigned with *TIMX for T format or *TIMN for N7 format.
■ LOG-DATE
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DescriptionParameter

Assigned with *DATX for D format or *DATN for N8 format. (If LOG-TIME has an
embedded date, such as *TIMX, this field is not required.)

■ LOG-TID

Assigned with *INIT-ID.
■ LOG-USER

Assigned with *INIT-USER.
■ LOG-ACTION

Assigned with the #ADD, #MODIFY, or #PURGE log action codes, which are defined
in the CDACTLOG local data area. You can initialize the values for these log action
codes within CDACTLOG to suit your environment.

In the log files corresponding to the sub-entities in the object, only the LOG-ACTION
field is required.

Note: For relational databases, use the underscore (_) character instead of the dash (-)
for the logfieldnames (LOG_TIME,LOG_DATE,LOG_TID,LOG_USER,LOG_ACTION).

If the primary key is compound or redefined into various components, supply a value
to limit the number of prefixed components confined on the Next action. This allows
the subprogram to maintain objects with a common prefix value.

For example, if the primary key is made up of Company + Account + Division and you
do not want the Next action to span the Division values, specify "2". Specify "1" if the
Next action is to be limited to the current Company value.

Next action
prefix

2 Select Finish.

The modules are generated using the current specifications. When generation is complete,
the available user exits are displayed in theOutline view.

3 Save the generated modules.

At this point, you can:

■ Use the NaturalONE Testing option to test the subprogram. For information, see Test a
Subprogram Directly in Application Testing.

■ Define user exits for the subprogram. For information about the User Exit editor, see User
Exit Editor, Natural Construct Generation.

■ Edit generated source code that is not within user exits. For information about the protected
lines in the generated source code, see Using the Source Editor in Using NaturalONE.

■ Use NaturalONE functionality to upload all generated modules to the server.
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Specify Common Parameters

This section describes theSpecifyCommonParameterswindow,which defines commonparamet-
ers such as support for direct command processing, message numbers, or password checking.

To define common parameters:

1 Select Common Parameters.

The Specify Common Parameterswindow is displayed. For example:

2 Select one or more of the following options:

DescriptionOption

Select this option to enable direct command processing.Direct command
processing

Select this option to use message numbers rather than message text for all
REINPUT and INPUT messages.

Note: Use the same technique consistently throughout your application,
since passing messages between modules using different techniques will
not always produce the desired results.

Message numbers

Select this option to enable password checking. To include password
checking, you must also set up a password file. For information, see Set
Up a Password File.

Password checking

3 SelectOK to save the settings.
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Set Up a Password File

You can specify password checking for many of the generated modules. Natural Construct builds
the mechanism for password checking into your modules by including the CCPASSW copycode
member. Within this copycode, the CDPASSW subprogram is invoked and passed the module
and library names.

To include password checking, you must set up a password file. The file is keyed on the module
name used to catalog the module and the library name used to generate the module.

The password file can be a viewof any filewithNatural-Construct-Password as the data definition
module (DDM) name. The view must contain the following fields:

FormatField

A40 (32-character library name, plus an 8-character module name)PASSWORD-KEY

A8 (8-character password)PASSWORD

When a user attempts to invoke the module, the CDPASSW subprogram reads the password file.
If the module/library name combination exists in the file and does not have a password, the user
can invoke the module. If the module/library name combination exists and has a password, the
user must enter the correct password before the module is invoked. If a user enters five incorrect
passwords, execution is aborted.

If you specify password checking, youmust modify the CDPASSW subprogram to include a valid
password view and any final processing you want to perform and then catalog the modified
subprogram. For more specific password checking, you can modify the CCPASSW copycode
member (to call a different subprogram) or modify the CDPASSW subprogram (to refine your
security standards).

Change the Window Settings

This sectiondescribes theSpecifyWindowParameterswindow,which defineswindowparameters
such as the height, width and position of the generated window, as well as whether it has a frame
or not.

To change the window settings:

1 SelectWindow Parameters.

The Specify Window Parameterswindow is displayed. For example:

181Code Generation

Natural Construct Generation



2 Define the following parameters:

DescriptionParameter

Number of lines the window will span.Height

Number of columns the window will span.Width

Number of lines from the top of the panel to the top of the window.Line

Number of columns from the left side of the panel to the left side of the window. The line
and column values form the top left corner of the window.

Column

Determines whether the window is displayed with or without a border. Select this option
to display the window without a border (frame).

Frame off

Title used for the window.Title

3

4 SelectOK to save the settings.

Change the Dynamic Attribute Characters

This section describes the Specify the Dynamic Attribute Parameterswindow, which allows you
to define up to four attributes, one ofwhichmust be the return to default display attribute (Default
return field).

Notes:

1. To use some of the attributes listed in this window, special hardware is required.

2. For a description of the attributes and valid parameters for the fields, see the applicable Natural
documentation.

3. Avoid using terminal control, alphabetic, and numeric characters when defining dynamic at-
tributes.
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4. If you are using Com-Plete, or cross-generating applications to run on a platform where Com-
Plete is in use, also avoid using stacking characters.

To change the dynamic attribute characters:

1 SelectDynamic Attributes.

The Specify the Dynamic Attribute Parameterswindow is displayed. For example:

2 Define up to four dynamic attributes, one of which must be the return to default display at-
tribute (Default return field).

3 SelectOK to save the settings.

Specify International Parameters

This section describes the Specify International Parameterswindow, which defines the language
used to display text on generated panels. You can define international parameters for modules
generated using the Object-Browse-Dialog and user exit models.

To specify international parameters:

1 Select International Parameters.

The Specify International Parameterswindow is displayed. For example:
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2 Define the following parameters:

DescriptionParameter

Type of messages used. When this option is selected, the generated code uses
message numbers rather than message text.

Message numbers

Type of prompts used. When this option is selected, the model generates Natural
Construct-style prompts (for example, 1 of 2).

Construct prompts

Code for the language used when generating message text. The default is 1
(English).

Language number

Name of the SYSERRmessage library used to retrieve commonmessage text. The
default is CSTAPPL.

Model library

Nameof the SYSERR library used to retrievemessage text for user-defined SYSERR
references. This parameter is only applicable to modules generated using the

Application library

Object-Browse-Dialog wizard. If you do not specify an application library, the
Model library value is used.

When this option is selected, the generated code supports cursor-sensitive
translation (users can modify or translate panel text dynamically in translation
mode).

Cursor translation

Names of the translation local data areas (LDAs) used by generated modules.
You can specify up to five translation LDAs. Either type the name or selectBrowse
to display the available data areas for selection.

Translation LDAs
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3 SelectOK to save the settings.

Specify Screen Parameters

This section describes the Specify Screen Parameterswindow, which defines how information is
displayed on the generated screen.

To specify screen parameters:

1 Select Screen Parameters.

The Specify Screen Parameterswindow is displayed. For example:

2 Define the following parameters:

DescriptionParameter

Number of screen heading lines displayed on the generated screen (by
default, two panels).

Screen header lines

Number of field heading lines displayed on the generated screen (bydefault,
one line is reserved for each field heading line).

Field heading lines

Number of blank lines inserted after the field heading lines. For example,
if you specify "1", one blank line is inserted below each field heading line.

Blank lines after headings

Indicates whether field headings are underlined. By default, this option is
marked and field headings are underlined on the generated screen.

Underline headings
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DescriptionParameter

Number of screen lines required to display each record and its attributes
(by default, one line is reserved for each record).

Number of lines/record

Number of the screen column in which the selection column begins.Starting column

Number of screen lines required to display the input keys (by default, one
line is reserved for each input key).

Number of input lines

Indicates whether the input key lines are displayed at the bottom of the
generated screen (by default, this option is selected and the input key lines
are displayed at the bottom).

Position Bottom

Indicates whether the input key lines are displayed at the top of the
generated screen. To have the input key lines displayed at the top of the
screen, select this option.

Position Top

3 SelectOK to save the settings.

Select a Message Number

This section describes the SelectMessageNumberwindow,which displays the available SYSERR
numbers for selection.

To select a SYSERR number:

1 Select Browse for Prompt on the Specify Additional Parameters panel.

The Select Message Numberwindow is displayed. For example:
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This window displays the available SYSERR numbers for selection.

2 Define the following parameters:

DescriptionParameter

Number of the SYSERR listing in the specified library (by default, "1"). To display

a different SYSERR listing, type a new number and select to display the SYSERR
numbers in the specified library, beginning at the new number.

Message number

Name of the library containing the SYSERR numbers (by default, "CSTAPPL"). To

change the library, type a new library name and select to display the SYSERR
numbers in the specified library.

Library

Code for the language number (by default, "1" for English). To change the language,

type a new language code and select to display the SYSERR numbers in the
specified language.

Language

Displays additional SYSERRnumbers (whenmore than 100 numbers are available).
To display the next 100 SYSERR numbers, selectMore. Once all numbers have been
displayed, the button is disabled.

More

3 Select the SYSERR number you want to use in the table.
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4 SelectOK.

Example of Generating a Program

This section provides an example of using the QUIT wizard to generate a quit program.

To generate a quit program:

1 Open the context menu in theNavigator view for the NaturalONE project into which you
want to generate the quit program.

Or:

Open the context menu in theNavigator view for the library into which youwant to generate
the quit program.

2 Select Code Generation > New Using Construct Model > QUIT.

First the Progress Informationwindow is displayed, showing progress as themodel specific-
ations are initialized, and then the wizard panel is displayed. For example:
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The names of the project and library from which this panel was invoked are displayed (you
can change these if desired).

3 Type "MYQUIT" inModule.

4 Type "CDGDA" in Global data area.

TheCDGDAglobal data area contains the global variables required to test a generatedmodule.

5 Select Finish.

The generation progress is displayed at the bottom of the panel. For example:
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When generation is complete, the quit program is displayed in theNavigator view. For ex-
ample:

The quit program is also displayed in the editor. For example:
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At this point, you can define additional processingwithin user exits. User exit code is preserved
during regeneration. For information, see Defining User Exits.

Regenerate Natural Construct-Generated Modules

You can regenerate anymodule that was generated using a Natural Construct or client generation
wizard. You can also selectmore than one project, folder, or object to regeneratemultiplemodules.
When regeneratingmultiple modules, a selection window is first displayed to select the resources
to be regenerated.

To regenerate Natural Construct-generated modules:

1 Open the context menu for one or more projects, folders, or modules in theNavigator view.

191Code Generation

Natural Construct Generation



You can use standard selection techniques.

2 Select Code Generation > Regenerate Using Wizard.

The model PDA is uploaded to the mainframe to be populated and then downloaded to the
local Eclipse environment to populate the PDA values before displaying the first wizard
specification panel. You can then edit the specifications and select Finish.

Or:

Select Code Generation > Regenerate.

A progress window is displayed as the wizard locates and loads the regeneratable resources.
Next, a selection window is displayed to choose the resources you want to regenerate. For
example:

Use this panel to:

ProcedureTask

Type a prefix in Filter. For example, if you type "AP",
only the resources beginning with AP are selected.

Filter the list of resources for selection.

Type the generator ID in Generator ID.Use a different code generator to regenerate
the resource.

SelectDeselect All.Deselect all resources.
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After selecting the resources, select Finish. The modules are generated without displaying
the wizard panels.

When regenerating a resource that was generated using a Natural Construct client generation
wizard, the following process occurs:

1. The original generated source code is uploaded to the Natural server.

This allows the **SAG lines to be parsed into the model PDA (and user exits to be processed
later).

2. The Read program is executed to populate the model PDA.

3. The generation process begins, using the downloaded model PDA data.

4. User exits are merged on the server.

5. All generated modules are downloaded from the server to the client.
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This section describes how to use NaturalONE functionality to create and maintain Natural
Construct resources. The following topics are covered:

Note: If you have customized any of the supplied modules on the server, you can either
add them to the current project or add them to the downloaded Construct runtime project
(which will overwrite the supplied modules). For more information, see Add Customized
Modules to the Construct Runtime Project.

Create a New Client Generation Wizard

The most significant difference between Natural Construct in NaturalONE and on the server is
the user interface. Instead of entering "NCSTG" and invoking the Modify server subprogram
panels, a localwizard is used. Thiswizard is created using themodel record file (.cstmdl extension),
themodel PDA, customizable XMLfiles for themodelUI file (.cstmdlui extension) and any reusable
dialog UI files (.cstmdldg extension) or page UI files (.cstmdlpg extension), and a wizard engine.
The engine calls the clear subprogram (called before thewizard is invoked and used to set defaults)
or read subprogram (used to read the specifications for regeneration) on the server, displays the
user interface and populates the PDA with data from the interface, and then calls the validation
subprogram on the server to validate the user input. Themodel record data is identical to the data
on theNatural server andmust exist in the local environment. Thewizard uses this data to determ-
ine the model PDA and clear, validate, and read subprograms for the model.

To create a new client generation wizard:

1 Download the model record from the server installation.

Note: For information on downloading the model record and PDA from the server, see
Download Natural Construct Resources to a Local Project.

2 Use the model record to determine the name of the model PDA.

3 Download the model PDA from the SYSCST library.

4 Create the model UI file and, optionally, the reusable page UI and dialog UI files.

These files include the main model UI file to map the user interface to the model PDA (.cstm-
dlui extension), as well as any reusable dialog UI files (.cstmdldg extension) or page UI files
(.cstmdlpg extension).

This section describes how to create a client generation wizard for a model that has not been im-
plemented locally. The following topics are covered:

■ User Interface (UI) File Examples
■ Page Node
■ Dialog Node
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■ Item Node
■ GUI Controls
■ Add a Tool Tip
■ Set Up a Server Call
■ Bind Data to GUI Controls
■ Error Handling Tips for Field Names
■ Generate NATdoc Documentation

User Interface (UI) File Examples

This section describes the user interface (UI) files used in the client generation framework. The
following topics are covered:

■ Model UI File
■ Reusable Dialog and Page UI Files

Model UI File

This section describes the model UI file (.cstmdlui extension). In the same way the model panels
on the server relate to the model PDA, this file connects the client user interface with the model
parameter data area (PDA) and/or specifications. On the client, these relationships are created
using document nodes that associate the model PDA via the pda: keyword. or specs: keyword
when the required input is not found in the model PDA. This information is then used during the
generation process.

The following example illustrates themodelUI file (.cstmdlui extension) for the supplied STARTUP
wizard:

<model name="STARTUP" constructID="STARTUP" category="Construct">
     <version major="5" minor="3" release="1" />
     <description>Startup Model</description>
         <pages>
              <page id="StartupPage" title="Specify standard parameters">
                   <description>Enter settings for the startup program.</description>
                   <layout class="gridLayout" columns="3" />
              <children>
                   <group text="Target  ">
                        <layoutData class="gridLayoutData" horizontalSpan="3"
                             grabExcessHorizontalSpace="true" />
                        <layout class="gridLayout" columns="3" />
                        <children>
                        <!-- PROJECT -->
                             <label text="Project:" />
                                  <text id="ProjectTextText" text="{specs:project}"
                                       default="selection:project">
                                       <layoutData class="gridLayoutData"
                                            horizontalSpan="1" ↩
grabExcessHorizontalSpace="true" />
                                  </text>
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                                  <cstBrowseProject />
                        <!-- LIBRARY -->
                             <label text="Library:" />
                                  <text id="LibraryText" text="{specs:library}" 
                                       default="selection:library">
                                       <layoutData class="gridLayoutData"
                                            grabExcessHorizontalSpace="true" />
                                  </text>
                                  <cstBrowseLibrary />
                         <!-- MODULE -->
                              <label text="Module:" />
                                   <text id="ModuleText" text="{specs:module}">
                                       <layoutData class="gridLayoutData"
                                            grabExcessHorizontalSpace="true" />
                                   </text>
                              <label></label>
                        </children>
                    </group>
                    <group text="Details  ">
                         <layoutData class="gridLayoutData" horizontalSpan="3"
                              grabExcessHorizontalSpace="true" />
                         <layout class="gridLayout" columns="3" />
                         <children>
                         <!-- GDA -->
                             <label text="Global data area:" />
                                  <text id="ModuleText" text="{pda:CUSTPDA.#PDAX-GDA}"
                                       default="CDGDA">
                                       <layoutData class="gridLayoutData"
                                            grabExcessHorizontalSpace="true" />
                                  </text>
                                  <cstBrowseNaturalObject text="Browse..."
                                       resultType="BrowseResults.NAME" ↩
fileExtension="NSG"
                                       result="{pda:CUSTPDA.#PDAX-GDA}" />
                         <!-- GDA with block -->
                              <label text="With block:" />
                                   <text id="GdaWithBlockText" ↩
text="{pda:CUSTPDA.#PDAX-GDA-BLOCK}">
                                        <layoutData class="gridLayoutData"
                                             grabExcessHorizontalSpace="true" />
                                   </text>
                              <label text="" />
                         <!-- TITLE -->
                              <label text="Title:" />
                                   <text id="TitleText" text="{specs:title}" ↩
default="Startup Program.">
                                        <layoutData class="gridLayoutData"
                                             grabExcessHorizontalSpace="true" />
                                   </text>
                              <label text="" />
                         <!-- DESCRIPTION -->
                              <label text="Description:" />
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                                   <cstMulti id="DescriptionText" ↩
text="{pda:CUSTPDA.#PDAX-DESCS}"
                                        default="This is the main startup program ↩
....">
                                       <layoutData class="gridLayoutData"
                                            horizontalSpan="1" verticalAlignment="4" ↩
heightHint="60" />
                                   </cstMulti>
                              <label></label>
                        </children>
                   </group>
                   <!-- Group for SPECIFIC PARAMETERS -->
                   <group text="Specific parameters  ">
                        <layoutData class="gridLayoutData" horizontalSpan="3"
                             grabExcessHorizontalSpace="true" />
                        <layout class="gridLayout" columns="3" />
                        <children>
                        <!-- MAIN MENU PROGRAM -->
                             <label text="Main menu program:" />
                                  <text id="ModuleText" ↩
text="{pda:CUSTPDA.#PDAX-MAIN-MENU-PROGRAM}">
                                       <layoutData class="gridLayoutData"
                                            horizontalSpan="1" ↩
grabExcessHorizontalSpace="true" />
                                  </text>
                                  <cstBrowseNaturalObject text="Browse..."
                                       resultType="BrowseResults.NAME" ↩
fileExtension="NSP"
                                       result="{pda:CUSTPDA.#PDAX-MAIN-MENU-PROGRAM}" ↩
/>
                        <!-- QUIT PROGRAM -->
                             <label text="Quit program:" />
                                  <text id="ModuleText" ↩
text="{pda:CUSTPDA.#PDAX-QUIT-PROGRAM}">
                                       <layoutData class="gridLayoutData"
                                            horizontalSpan="1" ↩
grabExcessHorizontalSpace="true" />
                                  </text>
                                  <cstBrowseNaturalObject text="Browse..."
                                        resultType="BrowseResults.NAME" ↩
fileExtension="NSP"
                                        result="{pda:CUSTPDA.#PDAX-QUIT-PROGRAM}" />
                        <!-- COMMAND PROCESS -->
                             <label text="Command processor:" />
                                  <text id="CommandText" ↩
text="{pda:CUSTPDA.#PDAX-PROCESSOR}">
                                       <layoutData class="gridLayoutData"
                                            horizontalSpan="1" ↩
grabExcessHorizontalSpace="true" />
                                  </text>
                                  <button style="SWT.CHECK" text="Error transaction ↩
processing"
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                                       selection="{pda:CUSTPDA.#PDAX-ERROR-TA}">
                                       <layoutData class="gridLayoutData"
                                            horizontalSpan="3" ↩
grabExcessHorizontalSpace="true" />
                                  </button>
                            </children>
                      </group>
                 </children>
           </page>
      </pages>
</model>

Reusable Dialog and Page UI Files

The Natural Construct client generation framework supports reusable dialogs and pages. The
dialog UI or page UI code can be created once as a separate file and then included in multiple
model UI files. In this way, changes to the page or dialog UI code will be automatically reflected
in any client generation wizard that includes that page or dialog UI file.

Model UI File

The following example illustrates a model UI file (.cstmdlui extension) for MYMODEL, which
includes reusable page and dialog UI files:

<model name="MYMODEL" constructID="MODELA" category="Construct">
      <version major="5" minor="3" release="1" />
      <description> This model demonstrates reusable page/dialogs.
      </description>
      <pages>
            <page id="Page1" title="Page1 title">
                  <description>Enter settings for this non-reusable ↩
page.</description>
                  <children>
                        ... UI nodes go here ...

                        <cstDialogButton id="button" text="Show a dialog...">
                              <dialog include="MyReusableDialog">
                                    <replacements>
                                          <stringReplacement ↩
target="%DIALOG_PDA_NAME%"
                                                replacement="NEWPDA" />
                                    </replacements>
                              </dialog>
                        </cstDialogButton>

                        ... more UI nodes go here ...
                  </children>
            </page>
            <page include="MyReusablePage">
                  <replacements>
                        <stringReplacement target="%PAGE_PDA_NAME%"
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                              replacement="NEWPDA" />
                  </replacements>
            </page>
      </pages>
</model>

Dialog UI File

The following example illustrates the reusable dialogUI file (.cstmdldg extension) forMYMODEL:

<modelUIDialog>
      <dialog windowTitle="My Dialog" title="My dialog title" message="My dialog ↩
message.">
            <children>
                  <button style="SWT.CHECK" text="My button"
                        selection="{pda:%DIALOG_PDA_NAME%.#PDA-BOOLEAN-FIELD}">
                  </button>

                  ... more UI nodes go here …

            </children>
      </dialog>
</modelUIDialog>

Page UI File

The following example illustrates a reusable page UI file (.cstmdlpg extension) for MYMODEL:

<modelUIPage>
      <page id="Page2" title="Page2 title">
             <description>Enter settings for this reusable page.</description>
             <children>
                   <text id="MyText" text="{pda:%PAGE_PDA_NAME%.#PDA-FIELD}" ↩
required="true" />
          
                   ... UI nodes go here ...

                   <cstDialogButton id="button" text="Show a dialog...">
                         <dialog include="MyReusableDialog">
                               <replacements>
                                     <stringReplacement target="%DIALOG_PDA_NAME%"
                                           replacement="NEWPDA" />
                               </replacements>
                         </dialog>
                   </cstDialogButton>

                   ... more UI nodes go here …

             </children>
       </page>
</modelUIPage>
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Page Node

The page node represents a page displayed through the wizard. Within this node, child nodes
represent SWT GUI controls. This section describes the elements and attributes you can define
within the page node:

■ Description
■ HelpID
■ ID
■ Include
■ Optional
■ Replacements
■ Title

Description

When defined, this attribute provides a brief description of the page. For example:

page id="StartupPage" title="Specify standard parameters">
<description>Enter settings for the startup program.</description>

HelpID

When defined, this attribute enables the help button on the page and links the Eclipse help system
to the applicable help ID. For example:

<page id="StParms" title="Specify standard parameters" helpID="StParmsHelpID">

ID

This attribute defines the name of the page. For example:

page id="StartupPage" title="Specify standard parameters">

Include

When defined, this attribute defines the name of a reusable page used by the model. For example:

<page include="MyReusablePage">
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Optional

When defined as true, this attribute disables validation for the page; if the remaining pages are
also defined as optional, the Finish button will be enabled. For example:

<page id="2" title="TWO" optional ="true">

By default, a page is not optional (i.e., it is mandatory).

Tip: To allow users to select Finishwhen only optional pages remain, group all optional
pages together at the end of the XML file.

Replacements

When defined, this element defines nested stringReplacement elements that allow simple string
replacements to be performed (for example, PDA bindings) for a reusable page. For example:

<replacements>
<stringReplacement target="pda:MYPDA" replacement="pda:MYPDA2" />

</replacements>

In this example, all occurrences of "pda:MYPDA" in the reusable page will be replaced with
"pda:MYPDA2" when a client generation wizard imports and uses the page.

Title

This attribute defines the title displayed on the page.

Dialog Node

The dialog node represents a dialog that will be displayed to a user. For example:

<dialog windowTitle="Edit Row" title="Row Details" message="Enter row details">
<children>

<label text="&amp;Code:" />
<text id="Oms11" text="{pda:CUMNPDA.#PDA-CODE}">

<layoutData class="gridLayoutData" horizontalSpan="2"
grabExcessHorizontalSpace="false">

</layoutData>
</text>

<label text="&amp;Function:" />
<text id="Oms12" text="{pda:CUMNPDA.#PDAX-FUNCTIONS}">

<layoutData class="gridLayoutData" horizontalSpan="2"
grabExcessHorizontalSpace="true">

</layoutData>
</text>

<label text="&amp;Program name:" />
<text id="Omsb13" text="{pda:CUMNPDA.#PDA-PROGRAM-NAME}">

<layoutData class="gridLayoutData" horizontalSpan="1"
grabExcessHorizontalSpace="false" />
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<style type="naturalObject" />
</text>
<cstBrowseNaturalObject text="Browse..."

fileExtension="NSP" result="{pda:CUMNPDA.#PDA-PROGRAM-NAME}">
</cstBrowseNaturalObject>

</children>
</dialog>

This node is similar to the page node; any XML control that can be defined for a page can also be
defined for a dialog; in addition, any stringReplacement can be defined for a reusable dialog. The
following attributes are defined within the dialog node:

DescriptionAttribute

Name of a reusable dialog (only used when the dialog parent node is cstDialogButton). For
information, see Reusable Dialog and Page UI Files.

include

Banner text displayed on the dialog.message

Title displayed on the dialog.title

Internal name used for the dialog.windowTitle

Note: If you do not selectOK to close the edit window, the edits will not be applied (i.e.,
the values in the table will not change).

Item Node

The item node represents a value/display combination to map between the text displayed on a
GUI control and the actual underlying value. For example:

<items>
<item value="1" display="Winter"/>
<item value="2" display="Spring"/>
<item value="3" display="Summer"/>
<item value="4" display="Fall"/>

</items>

The following attributes are defined within the item node:

DescriptionAttribute

Value that will be saved internally.value

Value that will be displayed on the page.display
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GUI Controls

GUI controls are represented by nodes in the client generation framework and are used to bind
user input from the interface to associated fields in the model PDA or specifications. Before the
first specification panel is displayed, the model's clear subprogram on the server is invoked and
typically populates default values in the PDA. These default values will be presented to the user
(unless they have been overridden at the XML node level).

All controls have the following traits in common:

■ Any property of an SWT (Standard Widget Toolkit) control can be modified with an attribute
in the XMLfile. The XML attribute in the XMLmustmap to aGet/Setmethod in the correspond-
ing SWT control.

■ All controls have an ID attribute. Whenever there is an error with a control, the ID attribute will
be displayed to assist in diagnosing the problem. Although there is no checking for duplicate
ID attributes, it is highly recommended that each control have a unique ID.

■ All controls support the tool tip option, which provides information about its use.

Note: Formore information, seeBindData toGUI Controls andDefault Properties Applied
to GUI Controls.

This section covers the following topics:

■ Button
■ Combo
■ Composite
■ cstCombo
■ cstDeriveServerButton
■ cstDialogButton
■ cstRadioGroup
■ cstTable
■ dateTime
■ Group
■ Label
■ Text Box
■ Multi-Line Text Box
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■ Browse Button Controls

Button

This GUI control is a button the user can select to initiate an action.

Attributes

DescriptionAttribute

An SWT constant indicating the style of the button. For example, SWT.CHECK
will create a check box.

style

Text displayed on the button.text

Boolean binding value indicating whether the button is selected or not. If the
button is a check box, this attribute indicates whether the button is marked or
not.

selection

Link to an event to be handled.onWidgetSelected

Example

<button style="SWT.CHECK" text="Check" selection="{pda:CUSTPDA.#PDAX-ERROR-TA}"/>

In this example, the value of the checked box (either true or false) will be placed in the #PDAX-
ERROR-TA Boolean field in the CUSTPDA parameter data area for the STARTUP model.

Combo

This GUI control is a drop-down list that allows the user to either enter text or select a value from
a list of available choices.

Attributes

DescriptionAttribute

Binding property used to bind the text property for the combo box to an underlying field.text

A list of items to display in the combo box, separated by commas.values

Example

<combo id="myCombo" text="{pda:level1.selection}" values="A,B,C,D" />

In this example, the user will be able to select A, B, C, or D as an input value for the specified
PDA field. The field cannot be blank.

Note: If this is not a required field, add a 5th entry to represent a blank (for example,
values=" ,A,B,C,D").
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Composite

This GUI control is an invisible control that hosts other controls.

Child Nodes

DescriptionNode

Defines settings for the layout strategy to use.layout

Defines the child controls.children

Example

<composite>
<layout class="gridLayout" columns="2" />
<children>

<label text="Array 1" />
<text text="{pda:level1.Array(1)}" />
<label text="Array 2" />
<text text="{pda:level1.Array(2)}" />

</children>
</composite>

When the number of columns are defined for a table, the cells are filled from left to right and
top to bottom. In this example, therewill be 2 columns and 2 rowswhere the first row isARRAY
1 and the data is in array(1).

cstCombo

This section describes the cstCombo control. This control is similar to the combo control, except
it allows one value to be displayed on a panel and a second, different value to be stored in the
PDA.

Attributes

DescriptionAttribute

Bound field that stores the value of the combo box.value

Value to use when the bound field is not set.defaultValue
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Child Nodes

DescriptionNode

For information, see Item Node.item

Set Default Values
Unless otherwise specified, the default value is the first item in the list. When a blank is not
acceptable, you can provide a default value. For example:

<cstCombo value="{pda:#INPUT.VALUE}" defaultValue="1">
<items>

<item value="1" display="Ontario"/>
<item value="2" display="Quebec"/>

</items>
</cstCombo>

When a blank is acceptable, you can provide an item for blanks. For example:

<cstCombo value="{pda:#INPUT.VALUE}">
<items>

<item value="" display=""/>
<item value="1" display="Ontario"/>
<item value="2" display="Quebec"/>

</items>
</cstCombo>

Note: The value attribute is used, as opposed to the text attribute, to ensure that the
number (for example, "1") goes into the PDA, while the text in display (for example,
"Ontario") is displayed on the wizard panel.

cstDeriveServerButton

This section describes the cstDeriveServerButton control, which calls a subprogram to derive data
from the server.

Note: For information on using the cstDeriveServerButton control to refresh defaults in the
model PDA or derive values from the server, see Set Up a Server Call. For example, you
can use this control if I wanted to start my first browse row on line 3 and there are 2 lines
of input how many rows could I fit on the screen…the number 3 and 2 the user enters in
and the button goes off and calculates the number of rows that fit on the screen) values for
the model PDA,
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Attributes

DescriptionAttribute

An SWT constant indicating the style of the button. For example, SWT.PUSH will
create a button.

style

Text displayed on the button.text

Call ID for the server call that defines how the data from the proxy PDA (the fields on
the server) gets populated into themodel PDA (the fields on the client) and vice versa.
For more information, see Set Up a Server Call.

serverCallID

Example

<cstDeriveServerButton style="SWT.PUSH"
text="Refresh Default Methods" serverCallID="Default_Methods">

</cstDeriveServerButton>

cstDialogButton

This section describes the cstDialogButton control, which displays a customdialogwhen selected.

Attributes

DescriptionAttribute

Text displayed on the button.text

Child Nodes

DescriptionNode

For information, see Dialog Node.dialog

Example

<cstDialogButton id="button" text="Display Options...">
<dialog windowTitle="Display Options" title="Display Options"

message="Select options for display">
<children>

<label text="&amp;Option Code:" />
<text id="Oms11" text="{PDA:#INPUT.VALUE}">
</text>

</children>
</dialog>

</cstDialogButton>
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cstRadioGroup

This section describes the cstRadioGroup control, which creates a group box containing radio
buttons (one radio button for each item child node).

Attributes

DescriptionAttribute

Bound field that stores the value of the group box.value

Value to use when the bound field is not set.defaultValue

Alignment of the radio buttons. Valid values are horizontal or vertical (the default).orientation

Text displayed on the group box.text

Child Nodes

DescriptionNode

For information, see Item Node.item

Example

<cstRadioGroup value="{pda:#INPUT.VALUE}" text="Province" defaultValue="2" ↩
orientation="horizontal">
     <items>
          <item value="1" display="Ontario"/>
          <item value="2" display="Quebec"/>
     </items>
</cstRadioGroup>

cstTable

This section describes the cstTable control, which provides a table (grid) for an array.

Notes:

1. The bindings in a dialog do not include the array index. The selected row will be added to the
table when the Edit button is selected.

2. You can create a table that uses multi dimensions of an array. For an example of this function-
ality, see the Object-Browse-Subp wizard.
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Attributes

DescriptionAttribute

Name of the field that stores the actual count of rows (©# field). If the count
field is not specified, the table will use the number of elements declared in

countField

the array as the row count. For example, A (A10/1:10) will have 10 rows
displayed in the table.

When this attribute is set to true, the rows in cstTable can only be edited (i.e.,
the Add and Delete buttons will be disabled). By default, rows in cstTable
can be added, deleted, and edited.

editOnly

Maximum number of rows displayed for the table. By default, this number
is the upper bound of the array field.

maxRows

Column header for the row number column; the default is "#".numberColumnDisplay

Column width; the default is 25 pixels.numberColumnWidth

Cascading Deletes
If the first dimension of an array is defined as a Group field and the second dimension is
defined as a group under the first dimension, cstTable will automatically cascade deletes to
the second dimension. In the following example, if Parent-Row(5) is deleted, Child-Row(5,*)
will be deleted as well:

01 Parent-Row (1:10)
02 Field2 (A10)
02 Field3 (A10)
02 Child-Row (1:5)
03 Child1 (A10)
03 Child2 (A10)

Nested Array Indexes
You can nest array indexes within a table. For example, you can create a table on one dialog
that contains the first dimension of an array and pass the indexes for a second and third dimen-
sion to a second table in another dialog. For example:

<statement display="DREW" id="DREW" velocityTemplate="ESCAPE.vm">
      <pages>
            <page id="Start" title="ESCAPE statement">
                  <description>Enter statement options</description>
                  <layout class="gridLayout" columns="1" />
                  <children>
                        <cstTable>
                              <layoutData class="gridLayoutData" ↩
horizontalSpan="1"grabExcessHorizontalSpace="true" />
                              <columns>
                                    <column fieldName="A" display="A" width="75" ↩
/>
                                    <column fieldName="B" display="B" width="50" ↩
/>
                              </columns>
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                              <dialog>
                                    <layout class="gridLayout" columns="2" />
                                    <children>
                                          <label text="A:" />
                                          <text text="{pda:A}">
                                                <layoutData ↩
class="gridLayoutData" horizontalSpan="1"grabExcessHorizontalSpace="true" />
                                          </text>
                                          <label text="B:" />
                                          <text text="{pda:B}">
                                                <layoutData ↩
class="gridLayoutData" horizontalSpan="1"grabExcessHorizontalSpace="true" />
                                          </text>
                                          <label text="C(n,1):" />
                                          <text text="{pda:C(1)}">
                                                <layoutData ↩
class="gridLayoutData" horizontalSpan="1"grabExcessHorizontalSpace="true" />
                                          </text>
                                          <label text="C(n,2):" />
                                          <text text="{pda:C(2)}">
                                                <layoutData ↩
class="gridLayoutData" horizontalSpan="1"grabExcessHorizontalSpace="true" />
                                          </text>
                                    </children>
                              </dialog>
                        </cstTable>
                  </children>
            </page>
      </pages>
      <pda>
      <![CDATA[ 
         01 Group1(1:3)
          02 A (A) DYNAMIC
          02 B (A) DYNAMIC
          02 Group2 (1:2)
           03 C (A) DYNAMIC
           03 D (A) DYNAMIC]]>
      </pda>
</statement>

In this example, the user selected the second row of the table for editing and the first index (2)
is populated; the C field will be generated as C(2,1) and C(2,2).

Group a Nested Table
You can group a nested table, which allows you to place a border around the table and provide
a title for the group. For example:

<group text="Window location">
      <layoutData class="gridLayoutData"horizontalSpan="2" ↩
grabExcessHorizontalSpace="true" />
      <children>
            <cstTable id="table">
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                  <layoutData class="gridLayoutData"horizontalSpan="3" ↩
grabExcessHorizontalSpace="true"grabExcessVerticalSpace="true" ↩
horizontalAlignment="SWT.FILL"verticalAlignment="SWT.FILL" />
                  <columns>
                        <column ↩
fieldName="CUOMPDA.#PDAX-SCROLL-LINE"display="Line" width="150" />
                        <column ↩
fieldName="CUOMPDA.#PDAX-SCROLL-COL"display="Column" width="150" />
                  </columns>
            </cstTable>
      </children>
</group> 

Child Nodes

columns

This node defines attributes for a column within the cstTable control. These attributes are:

DescriptionAttribute

Name of the field in the PDA to which the column is bound.fieldName

Heading used for the column.display

Width of the column. The default is 25 pixels.width

Used to detect empty rowswithin a table. A row is considered emptywhen all the flagged
columns for the row are empty. By default, all columns within a row are flagged as being
part of the blank test. To un-flag a column, set the blankTest attribute to "false".

A field within a specific row/column is considered empty using the following rules for
the value:

blankTest

■ Numeric fields (INPF): zero (0, 0.0, 00.00, etc.)
■ Any other field is blank when its string representation is blank or only contains
whitespace ("", " ", "<tab>", etc.)

In the following example, only the first column is used to determine whether a row is
empty:

<cstTable>
<columns>
<column fieldName="A" display="A" width="75" />
<column fieldName="B" display="B" width="50" blankTest="false"/>
<column fieldName="C" display="C" width="50" blankTest="false" />
</columns>
</cstTable>

dialog

For information, see Dialog Node.
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Example
The following example illustrates a cstTable control for the supplied MENU wizard:

<cstTable id="table" countField="CUMNPDA.#PDA-TOTAL-MENU-LINES">
<layoutData class="gridLayoutData" horizontalSpan="3"

grabExcessHorizontalSpace="true" grabExcessVerticalSpace="true"
horizontalAlignment="SWT.FILL" verticalAlignment="SWT.FILL" />

<columns>
<column fieldName="CUMNPDA.#PDA-CODE" display="Code" width="100" />
<column fieldName="CUMNPDA.#PDAX-FUNCTIONS" display="Function"

width="100" />
<column fieldName="CUMNPDA.#PDA-PROGRAM-NAME" display="Program Name"

width="100" />
</columns>
<dialog windowTitle="Edit Row" title="Row Details" message="Enter row details">

<children>
<label text="&amp;Code:" />
<text id="Oms11" text="{pda:CUMNPDA.#PDA-CODE}">

<layoutData class="gridLayoutData" horizontalSpan="2"
grabExcessHorizontalSpace="false"

>
</layoutData>

</text>
<label text="&amp;Function:" />
<text id="Oms12" text="{pda:CUMNPDA.#PDAX-FUNCTIONS}">

<layoutData class="gridLayoutData" horizontalSpan="2"
grabExcessHorizontalSpace="true"

>
</layoutData>

</text>
<label text="&amp;Program name:" />
<text id="Omsb13" text="{pda:CUMNPDA.#PDA-PROGRAM-NAME}">

<layoutData class="gridLayoutData" horizontalSpan="1"
grabExcessHorizontalSpace="false" />

<style type="naturalObject" />
</text>

<cstBrowseNaturalObject text="Browse..."
fileExtension="NSP" result="{pda:CUMNPDA.#PDA-PROGRAM-NAME}"

>
</cstBrowseNaturalObject>

</children>
</dialog>

</cstTable>
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dateTime

This GUI control is an edit control that accepts a date and/or time, and optionally presents a drop-
down calendar (depending on the SWT style). For information, see:

Class DateTime.

Attributes

DescriptionAttribute

Binding value indicating the location in which to store and retrieve the date value.value

Example

<dateTime style="SWT.DATE \| SWT.DROP_DOWN \| SWT.BORDER " ↩
value="{pda:level1.date}"/>

In this example, the user is restricted to only entering a date; this valuewill go into the specified
field in the model PDA.

Group

This GUI control is a rectangular border/frame that groups related controls and has a group
heading on its border.

Attributes

DescriptionAttribute

Text displayed on the group box border.text

Child Nodes

DescriptionNode

Settings for the layout strategy to use.layout

Node under which the child controls are placed.children

Example

<group text="Arrays">
<layout class="gridLayout" columns="2" />
<children>

<label text="Array 1" />
<text text="{pda:level1.Array(1)}" />
<label text="Array 2" />
<text text="{pda:level1.Array(2)}" />

</children>
</group>
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Note: For more examples of group boxes, such as the target group, see the startup.xml
example inModel UI File.

Label

This GUI control is an SWT (Standard Widget Toolkit) label used to display text.

Note: A label control does not receive focus nor generate input events.

Attributes

DescriptionAttribute

Text displayed for the label.text

Example

<label text="Library:" />

In this example, the label is used as the prompt for the Library input field. For more examples
of labels, see the startup.xml example inModel UI File.

Text Box

This GUI control is a text box that allows users to input a single line of text. The text control can
also be read-only.

Note: As text fields have no description, define a label control to describe their purpose.

Attributes

DescriptionAttribute

Binding property indicating how to bind the text in a text box to an underlying data
source. For example:

<text id="LibraryText" text="{specs:library}" required="false">

text

Default value shown when the text box is first displayed.default

Boolean value indicating whether the text box must be defined. When this attribute is
set to true, an error message will be displayed and the user will not be allowed to
navigate off the page until the text is filled in.

required

When the required attribute is set to true and the field is blank, this name will be
displayed as the field name in the error message. For example:

"<displayName> cannot be blank"

displayName

Code Generation216

Natural Construct Administration



DescriptionAttribute

Note: If displayName has not been specified, the control ID will be used as the field
name in the error message.

Indicates the Eclipse (SWT) style for the text box, such as scroll bars or multi-line. The
following example binds a non-array field to a multi-line text box with scroll bars:

<text text="{pda:LOGICAL-CONDITION}" id="condition"
          SWTstyle="SWT.MULTI | SWT.BORDER | SWT.V_SCROLL | ↩

SWTstyle

SWT.H_SCROLL">
          <layoutData class="gridLayoutData"
          grabExcessHorizontalSpace="true" heightHint="40" />
</text>

Child Nodes

style

The style node allows you to specify the style of the text box. The valid styles are:

DescriptionStyle

Maximum number of characters the text box will accept. For example:

<text id="ModuleText" text="{specs:Module}">
<style maxLength="20"/>

</text>

maxLength

Converts the user input into a particular case. The valid values are: "upper", "lower",
or "mixed" (no conversion takes place). For example:

<text id="ModuleText" text="{specs:Module}">
<style case="upper"/>

</text>

case

Boolean value indicating whether only numbers 0-9 will be accepted. For example:

<text id="ModuleText" text="{specs:Module}">
<style numbersOnly="true" />

</text>

numbersOnly

Note: Signs (+/-) cannot be used.

Boolean value indicating whether only numeric keys will be accepted. For example:

<text id="ModuleText" text="{specs:Module}">
<style numericOnly="true" />

</text>

numericOnly

Note: Signs (+/-) can be used.
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DescriptionStyle

Value indicating a combination of styles. Possible values are "naturalObject" and
"naturalFieldName". For example:

<text id="ModuleText" text="{specs:Module}">
<style type=”naturalObject”/>

</text>

type

Multi-Line Text Box

This GUI control is a multi-line text box that can be bound to an array of string fields.

Attributes

DescriptionAttribute

Binding property indicating how to bind the text in a text box to an underlying data
source. For example:

<cstMulti id="LibraryText" text="{specs:library}" required="false">

text

Default value shown when the text box is first displayed.default

Boolean value indicating whether the text box must be defined. When this attribute is
set to true, an error message will be displayed and the user will not be allowed to
navigate off the page until the text is filled in.

required

When the required attribute is set to true and the field is blank, this name will be
displayed as the field name in the error message. For example:

"<displayName> cannot be blank"

displayName

Note: If displayName has not been specified, the control ID will be used as the field
name in the error message.

Example

<cstMulti id="DescriptionText" text="{pda:CUSTPDA.#PDAX-DESCS}" required="true">

In this example, #PDAX-DESCS is an array in CUSTPDA.
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Browse Button Controls

This section describes the standard Browse button controls, which are used in combination with
the edit field (text box) controls whenever an existing object is referenced within a wizard. The
edit field is used to enter the name of an existing object; the Browse button is used to browse and
select the object from a list of all possible choices.

The standard Browse button controls are:

Message Number
This button displays a dialog to select a message number. The selected message text is stored
in the location indicated by the result attribute.

By default, cstBrowseMessage creates a Browse button that, when selected, will search the
Natural SYSERR library on the server and return all errormessages associatedwith theNatural
Construct application library (CSTAPPL). The user can search formessages in other languages
or libraries by changing the input values, or can start browsing at a different error number.
The user can then select a message to populate the location specified in the result attribute.

Attributes

DescriptionAttribute

Binding attribute indicating where to store the selected message text. If no view or Cancel
is selected, the bound field will not change from its previous value.

result

Example

<cstBrowseMessage result="{pda:level1.Module}"/>

Natural Library
This button displays a dialog to select a Natural library in the local environment. The button
is bound to the ModelSpecs library property.

Attributes

DescriptionAttribute

Boolean value indicating whether the ModelSpecs library value should be set based
on the current user selection in the Eclipse environment. For example, if the user selects

allowDefault

a Natural library (or descendant of the library), that library name can be used as the
default value.

Example

<cstBrowseLibrary allowDefault="true"/>

Note: Since all generated code must be stored in a Natural library, you can define this
node to use the current user library as the default library.
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Natural Object
This button displays a dialog to select one or more Natural objects in the local environment.
The list of modules can be restricted to a specified module type. The selected value is used to
populate the location specified by the result attribute.

Attributes

DescriptionAttribute

File extension used to limit the available selections.fileExtension

Binding attribute indicating where to store the user selection.result

Module Types and Extensions

ExtensionModule Type

NSDDDM

NSGGDA

NSHHelproutine

NSLLDA

NSMMap

NSAPDA

NSPProgram

NSNSubprogram

NSTText

Example

<cstBrowseNaturalObject text="Select PDA" fileExtension="NSA" ↩
result="{pda:level1.PDA}" />

This example illustrates a Browse button for PDA files.

Natural Project
This button displays a dialog to select a Natural project. The selected project is stored in the
location indicated by the ModelSpecs project property.
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Attributes

DescriptionAttribute

Boolean value indicating whether the ModelSpecs project value should be set based
on the user selection in the Eclipse environment. For example, if the user selects a

allowDefault

Natural project (or descendant of the project), that name can be used as the default
value.

Example

<cstBrowseProject allowDefault="true"/>

In this example, the name of the current Natural project is used to populate the project name
in the model specifications.

Predict Field
This button displays a dialog to browse all the fields in a DDM and select a field from the
previously selected Predict view. The selected field is stored in the location indicated by the
result attribute.

Attributes

DescriptionAttribute

Clears the bound result when the associated view value changes. Thiswill prevent
a view from not containing the desired field.

autoClear

Attribute indicatingwhether the Descriptors only field on the field selection panel
is selected by default and only descriptor fields will be displayed. When true, the

descriptorsOnly

Descriptors only field is selected by default; when false or not specified, the
Descriptors only field is not selected.

Binding attribute indicating where to store the selected Predict field. If no field or
Cancel is selected, the bound field will not change from its previous value.

result

Binding attribute indicating the view for which to list fields.view

Example

<cstBrowsePredictField autoClear="true" 
  view="{pda:CUBOPDA.#PDAX-PRIME-FILE}" ↩
result="{pda:CUBOPDA.#PDAX-PHYSICAL-KEY(1,1)}" 
  descriptorsOnly="true"/>

Predict View
This button displays a dialog to select a Predict view. The selected view is stored in the location
indicated by the result attribute.
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Attributes

DescriptionAttribute

Binding attribute indicating where to store the selected Predict view. If no view or Cancel
is selected, the bound field will not change from its previous value.

result

Example

<cstBrowsePredictView result="{pda:level1.#PDAX-PRIME-FILE}"/>

Add a Tool Tip

A tool tip provides information about using a control when the cursor is moved over the control.
All SWT controls have a tool tip text property and all XML control nodes support the tool tip option.
For example:

<text id=”MyTextID” toolTipText="Tool tip ↩
text" displayName="displayName" required="true" text=”{pda:Mypda.MyField}”/>

Set Up a Server Call

While thewizard's clear subprogramprovides default values for themodel PDAwhen thewizard
is started, values that the user specifies, such as the file name, can be used to derive more inform-
ation. The derived information, however, requires a server call, which can bemadewhen awizard
panel is left (onLeave) or entered (onEnter) or via a button. For example, after the user selectsNext
on a wizard panel, a subprogram can be called to fill in the appropriate values on the subsequent
panel. This is particularly useful when input data on the first panel (for example, the name of the
object-browse subprogram or file) is required to derive data for the second screen.

This section describes the two methods used to set values on wizard panels:

■ Set Values Whenever a Panel is Entered or Left
■ Set Values Whenever a Button is Selected

Set Values Whenever a Panel is Entered or Left

A subprogram can be called whenever a wizard panel is left (onLeave) or entered (onEnter) to
provide values for the model PDA. For obvious reasons, the onEnter event will never be called
on the first page. Similarly, the onLeave event will never be called on the last page. In all cases,
the server call must be defined.

This section covers the following topics:

■ Definitions
■ Server Calls
■ Field Mappings
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■ onLeave and onEnter Events

Definitions

DescriptionTerm

Parameter data area associated with the model; it contains fields used for the user interface
(i.e., the PDA specified in the .cstmdl file for the model).

Model PDA

Subprogram on the server that is used to serialize data for any subprogram that was not
generated by the CST-PROXY model.

Proxy

Parameter data area associated with the subprogram called by the proxy subprogram; it
contains fields used to input data into the model PDA fields.

Proxy PDA

Server Calls

The onEnter and onLeave events and the cstDeriveServerButton control call serverCalls, which
are defined as child nodes within the model node in the XML.

DescriptionAttribute

Unique identifier of the server call. This ID is used to identify which server call to invoke from
an onLeave or onEnter event or button control, which in turn identifies which subprogram
proxy to execute on the server.

id

A comma-delimited list of client text files that represents the definitions found in the PDA for
the subprogram the proxy calls.

pdas

The name of the proxy subprogram to invoke on the server.proxyName

The following example illustrates a serverCall to provide default methods for the Object-Browse-
Select-Subp wizard:

<model name="OBJECT-BROWSE-SELECT-SUBP" constructID="OBJECT-BROWSE-SELECT-SUBP"
category="Construct"

>
<serverCalls>

<serverCall id="Default_Methods" pdas="WTCBUDEF-inlinePDA,CSASTD"
proxyName="WTPBUDEF">

>

where:

■ WTPBUDEF is a proxy subprogram (generated with the CST-PROXY model) used to access the
WTCBUDEF subprogram.

WTCBUDEF has the following parameters:

DEFINE DATA
PARAMETER
01 #INPUTS
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02 #OBJECT-BROWSE (A8)
01 #OUTPUTS

02 #METHOD-MAPPING (1:15)
03 #BROWSE-KEY (A32)
03 #BROWSE-COUNT (L)
03 #METHOD-NAME (A32)

02 #METHOD-MAPPING-COUNT (N2)
PARAMETER USING CSASTD
LOCAL USING CUBUPDA

END-DEFINE

■ CSASTD is a .NSA file on the client that contains the parameter data area (PDA) definitions for
the CSASTD PDA (standard messaging parameters used by all models). It passes messages
between subprograms and is typically used for error handling.

■ WTCBUDEF-inlinePDA is a .NSA file on the client that contains all the other variables:

01 #INPUTS
02 #OBJECT-BROWSE (A8)

01 #OUTPUTS
02 #METHOD-MAPPING (1:15)

03 #BROWSE-KEY (A32)
03 #BROWSE-COUNT (L)
03 #METHOD-NAME (A32)

02 #METHOD-MAPPING-COUNT (N2)

In the serverCall example, the pdas attribute defines both .NSA files above. For example:

pdas="WTCBUDEF-inlinePDA,CSASTD"

Field Mappings

Each server call can have one or more field mappings. Field mappings define how data is copied
from and to the model and proxy PDAs. The attributes for the field mappings are:

DescriptionAttribute

Name of the field in the model PDA to be copied.modelField

Name of the field in the proxy PDA to be copied.proxyField

Determines when the field will be copied. Valid values are:direction

■ in

Field will be copied from the model PDA to the proxy PDA before the call to the server is
made (for example, the name of the object-browse subprogram used by an
Object-Browse-Select-Subp wizard).

■ out
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DescriptionAttribute

Field will be copied from the proxy PDA to the model PDA immediately after the server
call is made (for example, the methods derived from the object-browse subprogram).

■ in_out

Field will be copied from themodel PDA to the proxy PDA before the server call and from
the proxy PDA to the model PDA after the server call.

The following example illustrates the field mappings for the serverCalls example above:

<serverCall id="Default_Methods" pdas="DefaultMethods,CSASTD"
proxyName="WTPBUDEF">
     <mappings>
          <mapField modelField="CUBUPDA.#PDAX-OBJECT-BROWSE"
               proxyField="#INPUTS.#OBJECT-BROWSE" direction="in" />
          <mapField modelField="CUBUPDA.#PDAX-BROWSE-KEY" ↩
proxyField="#OUTPUTS.#BROWSE-KEY"
               direction="out" />
          <mapField modelField="CUBUPDA.#PDAX-BROWSE-COUNT"
               proxyField="#OUTPUTS.#BROWSE-COUNT" direction="out" />
          <mapField modelField="CUBUPDA.#PDAX-METHOD-NAME"
               proxyField="#OUTPUTS.#METHOD-NAME" direction="out" />
     </mappings>

The following example illustrates a sample of code from the .cstmdlui file for the Object-Browse-
Select-Subp wizard:

<model name="OBJECT-BROWSE-SELECT-SUBP" constructID="OBJECT-BROWSE-SELECT-SUBP"
     category="Construct">
          <serverCalls>
               <serverCall id="Default_Methods" pdas="DefaultMethods,CSASTD"
                    proxyName="WTPBUDEF">
                   <mappings>
                        <mapField modelField="CUBUPDA.#PDAX-OBJECT-BROWSE"
                             proxyField="#INPUTS.#OBJECT-BROWSE" direction="in" />
                        <mapField modelField="CUBUPDA.#PDAX-BROWSE-KEY" ↩
proxyField="#OUTPUTS.#BROWSE-KEY"
                             direction="out" />
                        <mapField modelField="CUBUPDA.#PDAX-BROWSE-COUNT"
                             proxyField="#OUTPUTS.#BROWSE-COUNT" direction="out" />
                        <mapField modelField="CUBUPDA.#PDAX-METHOD-NAME"
                             proxyField="#OUTPUTS.#METHOD-NAME" direction="in_out" />
                        <mapField modelField="CUBUPDA.#PDA-METHOD-MAPPING-COUNT"
                             proxyField="#OUTPUTS.#METHOD-MAPPING-COUNT" ↩
direction="out" />
                   </mappings>
               </serverCall>
     </serverCalls
     <onLeave serverCallID="Default_Methods" schedule="FIELD_CHANGED"
         fieldNames="CUBUPDA.#PDAX-OBJECT-BROWSE" />
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onLeave and onEnter Events

Once the server call has been defined, it can be connected to:

■ TheNext button via the onLeave event
■ The Back button via the onEnter event
■ A user-defined button via the cstDeriveServerButton control

To eliminate unnecessary calls to the server, the onLeave and onEnter events contain a schedule
attribute that can be set to only call the server when required.

Note: This option is not available for the cstDeriveServerButton control, as it is assumed
that a server call will always be required when this button is selected.

When navigating from one page to another (i.e., by selectingNext), the order of events are:

1. Current page onLeave event.
■ Copy the contents of the model PDA to the proxy PDA using the input mappings.
■ Issue a CALLNAT statement to the server.
■ Copy the contents of the proxy PDA to the model PDA using the output mappings.

2. Next page onEnter event.
■ Copy the contents of the model PDA to the proxy PDA using the input mappings.
■ Issue a CALLNAT statement to the server.
■ Copy the contents of the proxy PDA to the model PDA using the output mappings.

3. Show next page.

Note: SelectingBack on thewizard page has no effect; onLeave and onEnter are only invoked
whenNext is selected.

The onLeave and onEnter events are defined as child nodes within the page node in the XML.
These events specify which subprogram will be called whenever the page is entered or left. The
attributes for these events are:

DescriptionAttribute

Call ID for the server call that defines how the data from the proxy PDA (the fields on the
server) gets populated into the model PDA (the fields on the client) and vice versa.

serverCallID

Determines when the CALLNAT will be issued. Values are "ALWAYS",
"FIELD_CHANGED", "FIRST_TIME_ONLY".

Note: This functionality does not apply to a button.

schedule
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DescriptionAttribute

When schedule is set to "FIELD_CHANGED", this attribute provides a comma-delimited
list of fields in the PDA that the user may have changed. If the user does change one of
the fields, the subprogram will be called.

fieldNames

The following example illustrates the onLeave event:

<page id="StdParms" title="Specify standard parameters"
helpID="com.softwareag.naturalone.gen.doc.code.2acgw100"

>
<description>Enter settings for the standard parameters.
</description>
<onLeave serverCallID="Default_Methods" schedule="FIELD_CHANGED"
fieldNames="CUBUPDA.#PDAX-OBJECT-BROWSE" />

When the user selectsNext on the wizard panel, the subprogram (identified by the serverCallID
attribute) retrieves the method names, key names, and count.

Set Values Whenever a Button is Selected

Server data can be derived using the cstDeriveServerButton control in the client generation
framework. When the user selects this button on a wizard panel, the appropriate subprogram is
called to derive data from the server. Use this GUI control whenever user input is required.

The following example creates a button called Refresh Default Methods:

<cstDeriveServerButton style="SWT.PUSH"
text="Refresh Default Methods" serverCallID="Default_Methods">

</cstDeriveServerButton>

Whenever the user selects Refresh Default Methods on the wizard panel, the subprogram (iden-
tified by the serverCallID attribute) is called to retrieve themethod names, key names, and count.

Note: For more information, see cstDeriveServerButton.

Bind Data to GUI Controls

Within the XML file for a client generation wizard, certain nodes represent the GUI controls to be
created for the screen. To allow data from the parameter data area (pda) or specification (specs)
object to be bound to a GUI control, you can specifywhat data andwhich default values to display
for the control.

Notes:

1. To ensure consistency within the defaulting methods used on the client and the server, set the
default values for the PDA in themodel's clear subprogramon the server. The clear subprogram
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is invoked before the first panel of the wizard is displayed, so typically there is no need to set
default values in the XML file for the client generation wizard.

2. The standard Eclipse SWT controls are used; you can set any property for a control that has a
corresponding Set/Getmethod. To determinewhich properties are available, refer to the Eclipse
documentation.

The following example illustrates how to bind the Mypda.MyField PDA field to a text box control:

<text id=”MyTextID” text=”{pda:Mypda.MyField}”/>

In this example, text=”{pda:Mypda.MyField}” indicates that the text property for the GUI control
is bound to the PDA field calledMypda.MyField, where Mypda is the level 1 structure within the
model PDA and MyField is typically a #PDAX field name within the model PDA. Any changes
to the GUI will be automatically reflected in the underlying PDA field.

Note: For this example, the GUI control must have a text property. If not, an error is dis-
played.

The notation to bind data to a GUI control is:

<source>:<binding>[=<default>]

where:

■ source is the pda or specs keyword
■ binding is the name of a field or property with which to bind

Notes:

1. When binding to a specs object, the field or property must have a corresponding Set/Get
method.

2. The field name is typically fully qualified (i.e., level1.fieldName.
■ default is the default value to display for a field.

The default value (typically set in the model's clear subprogram on the server) has two possible
notations: one for the current selection and one for data settings on the dialog.

Note: If the default value is set in the model's clear subprogram, the =<default> notation
is not required in the XML; if the =<default> notation is specified, this value will override
the value set in the clear subprogram.

This section covers the following topics:

■ Use Logical Data to Enable or Disable Controls
■ Override Default Values
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■ Separate Default Attributes for GUI Controls
■ Default Properties Applied to GUI Controls
■ Default Selection Notation
■ Default Dialog Settings Notation
■ Examples of Binding Notations

Use Logical Data to Enable or Disable Controls

You can bind a control property to a logical field in a parameter data area (PDA).

Example
Assume the following PDA settings:

01 FIELDS
02 LOGICAL (L)
02 TEXT (A) DYNAMIC

And the following syntax:

<text text="{pda:level1.TEXT}" enabled = "!{pda:level1.LOGICAL}"/>

In this example, when the LOGICAL field is true, the enabled property for the text control will
be false (i.e., the text field will be disabled).

Override Default Values

Although default values for the PDA are typically set by the model's clear subprogram on the
server, they can be overridden on the client by a value from cache or by directly assigning a value.
If more than one method is used, the value taken is the last one assigned in the following order:

1. From the model's clear subprogram on the server.

2. From the dialog: notation.

3. From the direct assignment of the default value.

Separate Default Attributes for GUI Controls

Some GUI controls have a separate default attribute, which can be expressed as:

<text text=”{pda:MY.FIELD=A}”/>

or

<text text=”{pda:MY_FIELD} default=“A”/>

The GUI controls with separate default attributes are: combo box, button, text box, andmultiline
text box.
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Default Properties Applied to GUI Controls

The following table describes which properties the default attribute applies to each GUI control:

Default PropertyGUI Control

SelectedButton

SelectedCheck box

TextCombo box

TextText box

Default Selection Notation

When awizard is started from theNavigator view, an item is usually selected in the view.Depend-
ing on which item is selected, you can set default values for GUI controls. For example, the name
of a Natural library on the wizard panels can be defaulted to the name of the library selected in
the view.

Note: If the default value cannot be determined, the value will not be set for the control.

The notation to define the default value for a view selection is:

<source>:<binding>=selection:<selection Type>

where selection Type is the default value to display for the field. The selection types are:

Default ValueSelection Type

Name of the selected Natural project.natProject

Name of the selected project.project

Name of the selected container (package).container

Name of the selected file.file

Name of the selected Natural library.library

Name of the selected file with the specified extension. To define this default value, add the
following notation:

extension=NSN

extension

where NSN is the extension used for the selected file. The selected file must contain the
specified file extension.

For example, the following notation defines a checkbox that is bound and defaulted to unchecked:

<button style=”SWT.CHECK” selected=”{pda:level1.MyBoolean}” default=”false”/>

Code Generation230

Natural Construct Administration



Default Dialog Settings Notation

Data a user has previously specified for a GUI control can be saved and then reloaded as a default
value for the control, which eliminates the need for users to enter repetitive information. Each
piece of saved data is stored as a key value pair, where both the key and the value are strings. The
notation is:

<source>:<binding>=dialog:<key>

where key contains the default value to display for the field.

For example, the following notation defines a text box that is bound and defaulted to the
My.Dialog.Key dialog setting:

<text id=”MyText” text=”{pda:level1.MyField}” enabled=“{pda:level1.MyBoolean}” ↩
default=”{dialog:My.Dialog.Key}”/>

Examples of Binding Notations

The following table illustrates examples of binding notations:

Will bind the GUI control to:Example

APDAfield called INPUT.NAMEwith a default value
of FRED.

pda:INPUT.NAME="FRED"

The project property for the specs object and use the
selected project name as the default value.

specs:project=selection:project

The module property for the specs object and use the
selected file for the default value when its extension is
.NSN.

specs:module=selection.extension="NSN"

A PDA field called INPUT.PREFIX and use the value
stored in My.Dialog.KEY in the dialog settings as the

pda:INPUT.PREFIX=dialog:"My.Dialog.KEY"

default value (i.e., the last value entered in this field
when the wizard was last invoked).

Error Handling Tips for Field Names

When the validation subprogram for a client generation wizard returns a field in error, the field-
MatchHint attribute can be used to provide a "hint" to "match" the error field to one or more re-
definedfields. This allows for the scenariowhere a field is redefined and thewrongfield is returned.
You can also match multiple fields by separating each one with a comma. For example:

<text id="Predict view is required" required="true"
            text="{pda:CUSCPDA.#PDAX-PRIME-FILE}" ↩
fieldMatchHint="FIELDS.DUMMY_BEFORE_REAL_FIELD,CUSCPDA.#PDAX-PFILE">

231Code Generation

Natural Construct Administration



Note: Although the fieldMatchHint applies to all bindable controls, do not use the field-
MatchHint attributewith buttons. Typically, buttons are associatedwith a text box and focus
should be set on the text box instead of the button.

When errors are encountered, the following search order is used to find the bound field corres-
ponding to the field in error:

■ Field match with index
■ Field match without index
■ Field match with hint

Generate NATdoc Documentation

If the NATdoc option is enabled in the supplied CSXDEFLT subprogram, the code generated by
the client generation wizards will include a user exit containing the name of the author, as well
as the date and time the module was generated. Once this exit has been added to the module, it
must be manually maintained. For example:

**SAG DEFINE EXIT NAT-DOCS
/** :author PWRUSR -- Generated Feb 14,2011 at 10:09:17
**SAG END-EXIT

In addition, NATdoc comments will be added to the external PDAs. For example:

DEFINE DATA                                                           
   PARAMETER USING ACUSTK  /** :in /* Search key values                
   PARAMETER USING ACUSTD  /** :out /* Returned row data               
   PARAMETER USING ACUSTP  /** :inout /* Restricted data               
   PARAMETER USING CDBRPDA  /** :inout /* Generic browse object parms  
   PARAMETER USING CDPDA-M  /** :out /* Msg info                       ↩

The runtimemodules on the client also contain external PDAs containing NATdoc comments. For
example:

DEFINE DATA PARAMETER
/* >Natural Source Header 000000
/* :Mode S
/* :CP
/* <Natural Source Header
1 CDHASHA /** used in object maint to calculate hash value
2 #FUNC (I4) /** :inout not required
2 #CTX (B156) /** :inout not required
2 #TEXT (A) DYNAMIC /** :in data to be hashed

END-DEFINE

NATdoc documentation can then use this information to generate documentation based on your
selection. For example, you can generate NATdoc documentation for all the modules in a library.
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Notes:

1. For information about CSXDEFLT, refer to Enable NATdoc Generation in the Natural Construct
Administration guide.

2. For information about NATdoc, see the NaturalONE documentation.

Download Natural Construct Resources to a Local Project

To create a new client generation wizard or customize an existing model or code frame, you must
download the resources from the server.

To download Construct resources to your local project:

1 Locate the Natural Construct installation on the server.

Note: Natural Construct must be installed on the server.

2 Open the context menu for the Construct root node.

Or:

Expand the root node and select one or more model and/or code frame nodes or files using
standard selection techniques.

Note: Children of the selected nodes are automatically included in the download (for
example, selecting theModels root node will download all models from the server).

3 Select Add to existing Project.

For example:
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A list of available projects is displayed.

4 Select the project into which you want to download the models (or code frames).

For example:

5 SelectOK.

A progress window is displayed as the model record is downloaded from theNatural Server
view to the local project in theNavigator view. Expand the Construct root node to display
the downloaded resources. For example:
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Modify an Existing Natural Construct Resource

This section describes how to modify an existing Natural Construct resource from your server
installation, such as amodel or code frame, in the Eclipse environment. Tomodify existingmodels
and/or code frames:

■ Download the resource from your Natural Construct installation on the server to your local
environment. For information, see Download Natural Construct Resources to a Local Project.

■ Modify the resource as desired. For information, seeModify an Existing Model,Modify an Ex-
isting Code Frame, orModify an Existing Model UI.

■ Upload the modified resource to the server using standard NaturalONE functionality.

Create and Maintain a Natural Construct Model

This section describes how to create andmaintain aNatural Constructmodel. The following topics
are covered:

■ Create a New Model
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■ Modify an Existing Model Record

Create a New Model

To create a new Natural Construct model:

1 Open the context menu in theNavigator view for the NaturalONE project into which you
want to generate the model.

Or:

Open the context menu in theNavigator view for the Construct root node or Construct >
Models node into which you want to generate the model.

2 Select Code Generation > New Construct Model.

For example:
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TheDefine model details panel is displayed. For example:

Note: To change the name of the project, type the name of a new project in Project or
select Browse to display the available projects for selection.

3 Type the name of the new model UI file in Name.

4 Type a brief description of the model in Description.

5 Select Finish.

The new model file is listed in theNavigator view and displayed in the editor. For example:
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6 Specify the parameters for the new model.

For information on these parameters, see Creating NewModels in theNatural Construct Admin-
istration guide.

7 Create themodelUI file (.cstmdlui extension), aswell as any reusable dialogUI files (.cstmdldg
extension) or page UI files (.cstmdlpg extension).

For information, see Create a New Client Generation Wizard..

Note: You can only create the XML file after the PDA has been downloaded from the
server. For information, seeDownloadNatural Construct Resources to a Local Project.

8 Upload the new model to your Natural Construct installation on the server.
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Modify an Existing Model Record

A model is comprised of the following components:

■ Model record file (.cstmdl extension)
■ One or more XML files to define the user interface.

For example, themodel UI file (.cstmdlui extension) and any reusable dialog UI files (.cstmdldg
extension) or page UI files (.cstmdlpg extension).

■ Model PDA

Tip: Tomodify themodel PDA, first download themodel record and determine the name
of the PDA. Once you know the name, you can download the PDA from the SYSCST
library on the server, modify it in the local editor, and then upload it to the SYSCST library.

■ Code frames
■ Subprograms

This section describes how to modify a Natural Construct model record in the local environment.

To modify an existing model record:

1 Download the model record from theNatural Server view.

For information, see Download Natural Construct Resources to a Local Project.

2 Expand the Construct > Models root node in theNavigator view.

For example:
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3 Open the model file (.cstmdl extension) in the editor.

4 Modify the model record as desired.

For information about the editor, see Create a New Model.

5 Save the model record changes.

6 Upload the model record to the Natural Construct server installation using standard
NaturalONE functionality.

Create and Maintain a Code Frame

This section describes how to create andmaintain a code frame. The following topics are covered:

■ Create a New Code Frame
■ Modify an Existing Code Frame
■ View a Code Frame in the Outline View

Create a New Code Frame

This section describes how to create a new code frame. The following topics are covered:

■ Use the Code Frame Editor
■ Create the Code Frame

Use the Code Frame Editor

To create a new code frame, use the NaturalONE code frame editor to replicate the code frame
data defined in the standard editor on the server. The NaturalONE code frame editor uses a
combination of special $ variables and line text to represent the server editor columns and input
boxes (for example, type codes, condition codes, description input box, etc.).

The editor allows three types of code frame lines:

Text ColorDescriptionLine

BlueContains a description of the code frame, where n is a description of up
to 45 characters (equivalent to the description line on the server).
Maximum of one $D line per code frame.

$D:n

GreenContains details about user exits included within the code frame
(equivalent to the user exit edit window on the server), where:

$U:n

■ $U:R R (User exit required when a value is specified after :R)
■ $U:G n (Generate as subroutine when a value is specified after :G)
■ $U:S SAMP (Sample subprogram ...... SAMP )
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Text ColorDescriptionLine

■ $U:U GUISAMP (GUI sample subprogram .. GUISAMP)
■ $U:L n (Default user exit code that requires one $U:L line for each
default line)

Black (inserted directly
into the generated

Contains text and optional fields, where { } indicates optional fields and:{$C:n}
{$T:n}
TEXT ■ $C:n, where n indicates the condition code level in the editor on the

server. Valid condition code levels are:
program, based on the
$C: value)

Blue (represents logic,
such as user exit names,

■ 1–9

Indicates a new condition for this level. The conditions are Boolean
combinations of the condition constants specified for the generator. subprogram/parameter

names, boolean values,If the condition specified on the line is True, all subsequent code
with quotation marks (") is included in the generated program. etc., and will not be

inserted directly into the
generated program)Tip: Every $C:n is equivalent to starting another IF statement.

■ $C:"

Indicates that text on this line is a continuation of the previous block
of code and subject to the last condition specified.

■ $C:blank

Indicates that the corresponding line is constant text and is included
unconditionally.

■ $T:n, where n indicates the line type in the editor on the server. Valid
line types are:
■ N

Indicates a subprogram (the text on this linemust follow the format:
Subprogram:name {Parameter:name}, where { } indicates a
parameter is not required (similar to code frames on the server).

■ U

Indicates a user exit
■ F

Indicates a nested code frame
■ *

Indicates a comment line within the code frame, which will not be
generated into code

■ B

Indicates a blank line
■ X
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Text ColorDescriptionLine

Indicates a conditional user exit. The line must also contain a
corresponding $C:n entry to be valid.

■ TEXT represents the code frame logic and maps to columns 1-72 in
the standard editor on the server (maximum 72 characters).

The following example illustrates the CBDBPA9 code frame defined in the local code frame editor:

Note: Formore information on defining a code frame, seeCreatingNewModels in theNatural
Construct Administration guide.

Create the Code Frame

To create a new code frame:

1 Open the context menu in theNavigator view for the NaturalONE project into which you
want to generate the code frame.

Or:

Open the context menu in theNavigator view for the Construct root node or Construct >
Code-Frames node into which you want to generate the code frame.

2 Select Code Generation > New Code Frame.

TheDefine code frame details panel is displayed. For example:
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Note: To change the name of the project, type the name of a new project in Project or
select Browse to display the available projects for selection.

3 Type the name of the new code frame in Name.

4 Type a brief description of the code frame in Description.

5 Select Finish.

The new code frame is displayed in the editor. For example:

6 Define the new code frame.

For information, see Use the Code Frame Editor.

7 Save the specifications for the code frame.

You can now upload the new code frame to your Natural Construct installation on the server.
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Modify an Existing Code Frame

This section describes how to modify a Natural Construct code frame in the local environment.

To modify an existing code frame:

1 Download the code frame from theNatural Server view.

For information, see Download Natural Construct Resources to a Local Project.

2 Expand the Construct > Code-Frames root node in theNavigator view.

For example:

3 Open the code frame file (.cstframe extension) in the editor.

For example:
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4 Modify the code frame as desired.

For information about the editor, see Introduction.

5 Save the code frame changes.

6 Upload the code frame to theNatural Construct server installation using standardNaturalONE
functionality.

View a Code Frame in the Outline View

When editing a code frame in the code frame editor, theOutline view displays the main code
frame editor statements (Condition code lines, Type code lines, User exit lines, etc.) in a tree form,
using the condition codes to determine the parent/child relationships.

The following example illustrates the CBUA9 code frame in the code frame editor:

The code frame is also displayed in theOutline view. For example:
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Expand each node to display the data. For example:

When you select a node in theOutline view, the corresponding item is also highlighted in the
code frame editor. For example, if you select the "Subprogram:CUBUGENParameter: ROW-PDA"
node in theOutline view, the code frame editor will automatically highlight the "$C:" $T:N Sub-
program: CUBUGEN Parameter: ROW-PDA" line. Conversely, when you select an item in the
code frame editor, the corresponding node is highlighted in theOutline view.

TheOutline view does not display all code frame lines in the editor. The following lines are dis-
played:

■ Condition code statements that indicate different levels ($C:1-9).
■ Type code statements that indicate subprograms ($T:N), code frames ($T:F), user exits ($T:U),
and conditional user exits ($T:X).

■ User exit property statements that indicate user exit required ($U:R), generate as subroutine
($U:G), sample subprogram ($U:S), GUI sample subprogram ($U:U), and code frame lines ($U:L).
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Create and Maintain a Natural Construct Model UI

This section describes how to create and maintain the user interface (UI) for a Natural Construct
model. The following topics are covered:

■ Create a New Model UI
■ Create a New Dialog UI
■ Create a New Page UI

Create a New Model UI

This section describes how to generate and maintain a model UI file. The following topics are
covered:

■ Generate the Model UI File
■ Copy a Model UI File
■ Dependencies View
■ Outline View
■ Modify an Existing Model UI

Generate the Model UI File

To generate a new Natural Construct model UI file:

1 Open the context menu in theNavigator view for the NaturalONE project into which you
want to generate the model UI file.

Or:

Open the context menu in theNavigator view for the Construct root node or Construct >
Models node into which you want to generate the model UI file.

2 Select Code Generation > New Construct Model UI.

TheDefine Model UI Details panel is displayed. For example:
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Note: To change the name of the project in which to generate the model UI, type the
name of a new project in Project or select Browse to display the available projects for
selection.

3 Type the name of the model UI file in Name.

4 Type the name of the Construct model file (.cstmdl extension) for which you are creating the
interface model in Construct model.

Or:

Select Browse.

A selection window is displayed, listing the .cstmdl files for the standard models. Select the
name of the Construct model file for which you are creating the interface and selectOK. The
file name is then displayed in Construct model.

Note: Alternatively, you can copy a Natural Construct model UI file and modify it to
suit your requirements. For information, see Copy a Model UI File.

5 Type the name of a category in Category.

Categories are used to sort models for selection.

6 Select Finish.

The XMLfile for themodel is generated and a simplified representation of the file is displayed
in the editor. Each entry displayed in theDesign tab corresponds to an entry in the XML file
for the model. For example:
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In this example, you can expand the version andpagesnodes to viewother nodes and contents:

Note: Any control listed in theDesign tab that is bound to a PDA field has a "~" char-
acter preceding the binding, which forces the binding to be invalid when the field does
not exist in the PDA. To enable the binding, add the field definition to the PDA and
then delete the "~" character.

7 Select the Source tab.

The generated XML file (.cstmdlui extension) is displayed. For example:
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The default settings used to generate the file are based on the Construct model selected on
the Define Model Details panel.

8 Define the settings for the model UI.

For information, see Create a New Client Generation Wizard.

Copy a Model UI File

This section describes how to create a new model UI file from an existing model UI file supplied
with NaturalONE and the Natural Construct plug-in. Using this method is a quick way to create
your own model UI files by modifying existing files to suit your requirements. If the selected
model UI file includes any reusable dialog or page UI files that do not currently exist in the
workspace, these files will also be copied.

To copy a model UI file:

1 Select Copy a Construct model UI file.
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Construct model and Category are disabled and Construct model UI file is enabled. For ex-
ample:

2 Type the path for a Natural Construct model UI file (.cstmdlui extension) inConstruct model
UI file (for example, C:\folder\filename.cstmdlui).

Or:

Select Browse.

A selectionwindow is displayed, listing the .cstmdlui files for the suppliedmodels. Select the
file you want to copy and selectOpen. The location of the file is then displayed in Construct
model UI file.

Note: When this option is not selected, Construct model and Category are enabled and
must be specified.

Dependencies View

This view lists all modules referenced by themodel UI file you are creating, including themodules
shipped with the Construct runtime project. For example:
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In this example, NewModel was created by copying the Natural Construct Browse model UI file
and the Dependencies view displays model UI file, as well as the reusable pages used by that
model. Expand the nodes to view the dependencies. For example:

If <Unknown> is displayed beside the name of a referenced module, the module is not available
within the current project or referenced locally. You must either create the module locally or
download it from the server. Any required compile/runtimemodules are shipped in the Construct
runtime project.

Notes:

1. For more information about the Dependencies view, see the description of the source editor
in Using NaturalONE.

2. To reference modules in a local project, use the Propertieswindow for the current project.

3. To download modules from the server, seeDownload Natural Construct Resources to a Local
Project.
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4. To add the compile/runtime modules in the Construct runtime project, see Add the Construct
Runtime Project.

Outline View

TheOutline view displays an outline of the settings defined in the Design tab. For example:

Expand the model name node. For example:

The model UI file in this example was copied from the BROWSE model UI file, which included
several reusable pages.

Note: For information about reusable pages, see Reusable Dialog and Page UI Files.

Modify an Existing Model UI

This section describes how to modify an existing model UI file.

To modify an existing model UI file:

1 Open the model UI file (.cstmdlui extension) in the editor.

2 Modify the model UI information as desired.

For information, see Create a New Client Generation Wizard.

3 Save the model UI changes.
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Create a New Dialog UI

This section describes how to create and maintain the user interface (UI) for a Natural Construct
dialog UI file, a reusable file that can be included in multiple model UI files. The following topics
are covered:

■ Generate a Dialog UI File
■ Modify an Existing Dialog UI

Note: For more information, see Reusable Dialog and Page UI Files.

Generate a Dialog UI File

To generate a new dialog UI file:

1 Open the context menu in theNavigator view for the NaturalONE project into which you
want to generate the dialog UI file.

Or:

Open the context menu in theNavigator view for the Construct root node or Construct >
Models node into which you want to generate the dialog UI file.

2 Select Code Generation > New Construct Model UI Dialog.

TheDefine Dialog UI Details panel is displayed. For example:
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Note: To change the name of the project in which to generate the dialog UI file, type
the name of a new project in Project or select Browse to display the available projects
for selection.

3 Type the name of the new dialog UI file in Name.

4 Type a title for the dialog in Title.

5 Select Finish.

The XML file (.cstmdldg extension) for the reusable dialog is generated and a simplified rep-
resentation of the file is displayed in the editor in the Design tab. Each entry corresponds to
an entry in the .cstmdldg file. For example:

In this example, you can expand the dialog node to view the contents:

Note: Any control listed in theDesign tab that is bound to a PDA field has a "~" char-
acter preceding the binding, which forces the binding to be invalid when the field does
not exist in the PDA. To enable the binding, add the field definition to the PDA and
then delete the "~" character.

6 Select the Source tab.

The generated skeleton file is displayed. For example:
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7 Define the settings for the dialog UI.

For information, see Dialog Node.

Modify an Existing Dialog UI

This section describes how to modify an existing dialog UI file.

To modify an existing dialog UI file:

1 Open the dialog UI file (.cstmdldg extension) in the editor.

2 Modify the dialog UI information as desired.

For information, see Dialog Node.

3 Save the dialog UI changes.

Create a New Page UI

This section describes how to create and maintain the user interface (UI) for a Natural Construct
page UI file, a reusable file that can be included in multiple model UI files. The following topics
are covered:

The following topics are covered:

■ Generate a Page UI File
■ Modify an Existing Page UI

Note: For more information, see Reusable Dialog and Page UI Files.
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Generate a Page UI File

To generate a new page UI file:

1 Open the context menu in theNavigator view for the NaturalONE project into which you
want to generate the page UI file.

Or:

Open the context menu in theNavigator view for the Construct root node or Construct >
Models node into which you want to generate the page UI file.

2 Select Code Generation > New Construct Model UI Page.

TheDefine Page UI Details panel is displayed. For example:

Note: To change the name of the project in which to generate the page UI file, type the
name of a new project in Project or select Browse to display the available projects for
selection.

3 Type the name of the new page UI file in Name.

4 Type a title for the page in Title.

5 Type a description of the page in Description.

6 Select Finish.

The XMLfile (.cstmdlpg extension) for the reusable page is generated and a simplified repres-
entation of the file is displayed in the editor in the Design tab. Each entry corresponds to an
entry in the .cstmdlpg file. For example:
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In this example, you can expand the page node to view the contents. For example:

Note: Any control listed in theDesign tab that is bound to a PDA field has a "~" char-
acter preceding the binding, which forces the binding to be invalid when the field does
not exist in the PDA. To enable the binding, add the field definition to the PDA and
then delete the "~" character.

7 Select the Source tab.

The generated skeleton file is displayed. For example:

8 Define the settings for the page UI.

For information, see Page Node.
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Modify an Existing Page UI

This section describes how to modify an existing page UI file.

To modify an existing page UI file:

1 Open the page UI file (.cstmdlpg extension) in the editor.

2 Modify the page UI information as desired.

For information, see Page Node.

3 Save the page UI changes.
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Set Construct Preferences

This section describes how to set preferences for Natural Construct resources.

To set Construct preferences:

1 Select Preferences on theWindowmenu.

The Preferenceswindow is displayed.

2 Select Software AG > Construct.

The Construct preferences are displayed. For example:

Using this window, you can:
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ProcedureTask

Type or select the root folder in Root folder.Select the root folder to use for
models.

Deselect Check for existing resource on Natural server.

By default, this preference is selected and the generation of a
new Construct resource will initiate a search for the resource on
the Natural server. If a resource exists on the server, a warning

Disable the search for existing
resources on theNatural serverwhile
generating newConstruct resources.

is displayed and the user can either generate the resource locally
by selectingOK or cancel the generation of the resource by
selecting Cancel.

Deselect Run code formatter/Struct after generating and
Construct-generated code will contain the original indentation
indicated in the code frames.

By default, this preference is selected and all Construct-generated
code is formatted using the Struct option.

Disable the Struct functionality to
format code after generating (and
regenerating) using Construct.

Deselect Check for existing resource locally.

By default, this preference is selected and the download of
Construct resources from the server will initiate a search for the

Disable the search for existing
resources locallywhile downloading
resources from the server.

resources locally. If a resource exists locally, a warning is
displayed and the user can either continue the download process
by selecting Yes or Yes to All, which will overwrite the local
copy, or suppress the download by selectingNo or Cancel.

Deselect Auto download supporting resources from Natural
server.

By default, this preference is selected and the download of
Construct resources from the server will initiate a search for all

Disable the automatic download of
supporting resources from the
Natural server when they do not
exist locally.

supporting resources locally. If a supporting resource (i.e., a code
frame ormodel) does not exist locally, it will also be downloaded.

Note: This setting does not apply to recursive download
operations.

By default, the cache of the clear subprogram is saved (Save
cache of clear subprogram) and will be cleared when Eclipse is

Change options for the results of the
server call by the clear subprogram

shut down (Clear cache on Eclipse shutdown). This allows thewhen starting a client generation
wizard. wizard to start faster on subsequent calls to the same clear

subprogram. To disable this functionality, deselect the options
in Clear subprogram caching.

Select Clear Cache Now.Clear the cache of the clear
subprogram immediately.

By default, a prompt is displayed during startup, generation or
regeneration, asking whether you want to update the Construct

Change whether the version
information for the Construct

runtime project if a newer version is available. Other options are
to:
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ProcedureTask

runtime project is checked or not and
when it is checked.

■ Always update when a newer version is available, select
Always.

■ Never prompt or automatically update the project when a
newer version is available, selectNever.

3 SelectOK to save the preferences.

Set Installation Preferences

To function properly, certain UI functions require a Natural Construct installation on the Natural
server. For example, the Construct root node in theNatural Server view can be used to download
Natural Construct resources from a Natural server to a local Natural project, but only when there
is aNatural Construct installation on the server. By default, theseUI functionswill bemade visible
based on the installation of Natural Construct on the Natural server. To accomplish this, a server
call determineswhich products are installed on the server and the results are cached until Designer
shuts down, which allows for only one server call per host|port|session parameter. An option is
also provided to make these server calls and cache the results upon Designer startup (a server call
for each mapped server in the workspace).

To set installation preferences:

1 Select Preferences on theWindowmenu.

The Preferenceswindow is displayed.

2 Select Software AG > Construct > Installation.

The Preferenceswindow for Installation options is displayed. For example:
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Using this window, you can:

ProcedureTask

DeselectCheckNatural server product installation
at startup.

Delay the server call to determine product
installation until required (just prior to UI
function visibility).

DeselectMake UI functionality visible based on
Natural server installation. No server calls will be
made to determine which products are installed on
the server.

Make all UI functions visible, evenwhenNatural
Construct is not installed on the Natural server.

3 SelectOK to save the preferences.
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This section explains what a user exit is and how to select and define one in NaturalONE. The
following topics are covered:

Introduction

By default, the generated source code is protected from editing and changes can only be made
within user exits, positionswithin the generated codewhere you can insert customized or special-
ized processing. Changes to the user exit code are always preserved upon subsequent regeneration
of the module.

The code generation wizards provide a wide variety of user exits, which vary based on the type
of module you are generating. Some exits contain sample code or subprograms, while others
generate the **SAG DEFINE EXIT and **SAG END-EXIT tags only — you provide the actual code.
You can modify any user exit code generated into the edit buffer.

Notes:

1. For information on the supplied user exits, refer to User Exits for the Generation Models, Natural
Construct Generation.

2. If you require code to be inserted in the generated module where no user exit currently exists,
have your Natural Construct administrator recommend a suitable exit or add a new exit to the
wizard.

Define a User Exit

When a generated module is open in the Eclipse editor, all available user exits for the module are
displayed in theOutline view. This section covers the following topics:

■ Access a User Exit
■ Add Code to a User Exit
■ Generate Sample
■ Clear Exit
■ Modify Code in a User Exit

Tip: If the user exits are not displayed in theOutline view, select on the toolbar.
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Access a User Exit

To access a user exit:

1 Select the user exit in theOutline view.

2 Open the context menu for the user exit.

For example:

3 Select one of the options listed.

The user exit is displayed in the editor view. For example:
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The **SAG EXIT POINT tag indicates that the exit does not exist and youmust use theOutline
view to add code or generate sample code.

Add Code to a User Exit

To add code to a user exit:

1 Open the context menu for the user exit.

2 Select Add Code.

The exit is displayed in the editor view. For example:
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The **SAG DEFINE EXIT and **SAG END-EXIT tags indicate that the user exit exists, evenwhen
there is currently no code in it, and you can define or modify the exit directly in the editor.

3 Move the cursor to the end of the **SAG DEFINE EXIT user-exit-name line.

4 Select Enter.

5 Add the code on the lines provided.

Generate Sample

To add code to a user exit:

1 Open the context menu for the user exit.

2 SelectGenerate Sample.

The **SAG DEFINE EXIT and **SAG END-EXIT lines are displayed with sample code. For ex-
ample:
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3 Move the cursor to the end of the **SAG DEFINE EXIT user-exit-name line.

4 Modify the sample code as required.

Clear Exit

To clear code from an existing user exit:

1 Open the context menu for the user exit in theOutline view.

2 Select Clear Exit.

All lines of code within the selected exit are deleted and the comment line that identifies the
insertion point for the exit within the editor is restored.
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Modify Code in a User Exit

To modify code in a user exit:

1 Select the user exit in theOutline view.

The user exit is displayed in the editor.

2 Modify and save the user exit.

Note: You canmake changes to user exits equivalent to theAddCode andClear Exit options
by modifying these lines in the editor view — without using the context menu for the
Outline view. If you do this, ensure you do not change the ** SAG comment lines.
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This section describes how to generate an Ajax page that takes advantage of the capabilities of a
subprogram generated by an Object-Browse-Subp wizard (Object-Browse-N1 or Object-Browse-
Subp) or an Object-Maint-Subp wizard (Object-Maint-N1 or Object-Maint-Subp). The following
files are generated:

■ page layout (.xml extension)
■ adapter (.NS8 extension)
■ main program (.NSP extension)

This section covers the following topics:

Generate an Ajax Page for an Object-Browse Subprogram

This section describes how to generate an Ajax page for an Object-Browse subprogram. The fol-
lowing topics are covered:

■ Access the Wizard
■ Specify Source and Target Details
■ Configure Column Details

Access the Wizard

The section describes how to access the Ajax Object-Browse Page wizard. Before accessing the
wizard, the following conditions must be met:

■ The wizard must be started from a project that has been enabled for Ajax Developer.
■ A user interface component must be available locally.

Note: For more information about the generated files and general Ajax architecture, refer
to the Natural for Ajax documentation.

To access the Ajax Object-Browse Page wizard:

1 Open the context menu in theNavigator view for a subprogram that was generated by either
the Object-Browse-N1 or Object-Browse-Subp generator.

2 Select Code Generation > New Ajax Object-Browse Page.

For example:
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The Specify Source and Target Details panel is displayed. For example:
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Specify Source and Target Details

To specify source and target details:

1 Define the following parameters:

DescriptionParameter

Name of theObject-Browse-generated subprogram forwhich you are creating
the page. To change the name of the subprogram, either type the name of a
new subprogram inObject-Browse subprogram or select Browse to display
the available subprograms for selection.

Object-Browse
subprogram

Name of the user interface component for the page. Either type the name of
an existing component inUser interface component or selectBrowse to display
the available components for selection.

User interface
component

Name of the page layout file to be generated. This namemust follow standard
xml naming conventions (do not include the .xml extension).

Tip: Avoid using spaces in the page name as it may cause problems during
generation.

Page layout

Name of the adapter file to be generated. This name must follow standard
Natural naming conventions (do not include the .NS8 extension).

Adapter

Name of the main program file to be generated. This name must follow
standard Natural naming conventions (do not include the .NSP extension).

Main program

2 Select Finish.
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The page is generated using all fields in the PDA, as well as all default column headings and
search keys.

Or:

SelectNext.

The Configure Column Details panel is displayed. For example:

Note: Array fields are not currently supported.
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Configure Column Details

This panel allows you to select which fields are generated for the page andwhat column headings
will be displayed. The Key and Field Name columns show parameters that are read-only. "Yes"
in Key indicates that the corresponding field is used as a search key on the generated page; Field
Name displays the fully qualified name of each field in the PDA.

To configure column details:

1 Define the following parameters:

Required/Optional/ConditionalDescriptionParameter

OptionalIndicates whether the corresponding field is generated or not.
To exclude a field, deselectGenerate for that field. Aminimum
of one field must be selected.

Generate

OptionalHeading displayed on the generated page for the corresponding
field. You can change this heading as desired.

Heading

2 Select Finish.

The page is generated using the selected fields, column headings and search keys. The gener-
ated main program (.NSP extension) file is displayed in the editor. For example:
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The available user exits are displayed in theOutline view. For example:

For every event in the page layout file, a BEFORE-EVENT and AFTER-EVENT user exit is
generated (for example, "BEFORE-EVENT-nat:nat:page.end" above).When you add an event
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to the page layout file, a BEFORE-EVENT and AFTER-EVENT user exit is also generated.
Code within these exits is preserved during regeneration.

The generated adapter (.NS8 extension) andpage layout (.xml extension) files are also displayed
in the editor. For example:

The following example shows the generated page layout file displayed in the Layout tab.
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Note: For more information about these files, refer to the Natural for Ajax documenta-
tion.

Select the XML tab to display the generated xml file. For example:
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The generated files are displayed in theNavigator view. For example:

3 Open the context menu in theNavigator view for the generated main program and adapter
files.
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4 SelectNaturalONE > Update.

At this point, you can:

■ Test the main program. For information, see Test the Generated Main Program.
■ Define user exits. For information, see Defining User Exits.
■ Edit generated source code that is not within user exits. For information about the protected
lines in the generated source code, see Using the Source Editor in Using NaturalONE.

Generate an Ajax Page for an Object-Maint Subprogram

This section describes how to generate an Ajax page for an object-maintenance subprogram. The
following topics are covered:

■ Access the Wizard
■ Specify Source and Target Details
■ Configure Field Details

Access the Wizard

The section describes how to access the Ajax Object-Maint Page wizard. Before accessing the
wizard, the following conditions must be met:

■ The wizard must be started from a project that has been enabled for Ajax Developer.
■ A user interface component must be available locally.

Note: For more information about the generated files and general Ajax architecture, refer
to the Natural for Ajax documentation.

To access the Ajax Object-Maint Page wizard:

1 Open the context menu for a subprogram that was generated by either the Object-Maint-N1
or Object-Maint-Subp generator.

2 Select Code Generation > New Ajax Object-Maint Page.

The Specify Source and Target Details panel is displayed. For example:
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Specify Source and Target Details

To specify source and target details:

1 Define the following parameters:

Required/Optional/ConditionalDescriptionParameter

RequiredName of the Object-Maint-Subp-generated subprogram
forwhich you are creating the page. To change the name
of the subprogram, either type the name of a new
subprogram in Object-Maint subprogram or select
Browse to display the available subprograms for
selection.

Object-Maint
subprogram

RequiredName of the user interface component for the page.
Either type the name of an existing component in User

User interface
component

interface component or select Browse to display the
available components for selection.

RequiredName of the page layout file to be generated. This name
must follow standard xml naming conventions (do not
include the .xml extension).

Tip: Avoid using spaces in the page name as itmay cause
problems during generation.

Page layout

RequiredName of the adapter file to be generated. This namemust
follow standard Natural naming conventions (do not
include the .NS8 extension).

Adapter
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Required/Optional/ConditionalDescriptionParameter

RequiredName of the main program file to be generated. This
namemust follow standardNatural naming conventions
(do not include the .NSP extension).

Main program

2 Select Finish.

The page is generated using all fields in the PDA, as well as all default field labels.

Or:

SelectNext.

The Configure Field Details panel is displayed. For example:

Note: Array fields are not currently supported.
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Configure Field Details

This panel allows you to select which fields are generated for the page and what labels will be
displayed. The Field Name column displays the fully qualified name of each field in the PDA;
these parameters are read-only.

To configure field details:

1 Define the following parameters:

Required/Optional/ConditionalDescriptionParameter

OptionalIndicates whether the corresponding field is generated or not.
To exclude a field, deselectGenerate for that field. Aminimum
of one field must be selected.

Generate

OptionalLabel displayed on the generated page for the corresponding
field. You can change this label as desired.

Label

2 Select Finish.

The page is generated using the selected fields, column headings and search keys. The gener-
ated main program (.NSP extension) file is displayed in the editor. For example:
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The available user exits are displayed in theOutline view. For example:
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For every event in the page layout file, a BEFORE-EVENT and AFTER-EVENT user exit is
generated (for example, "BEFORE-EVENT-nat:nat:page.end" above).When you add an event
to the page layout file, a BEFORE-EVENT and AFTER-EVENT user exit is also generated.
Code within these exits is preserved during regeneration.

The generated adapter (.NS8 extension) andpage layout (.xml extension) files are also displayed
in the editor. For example:

The following example shows the generated page layout file in the Layout tab.
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Note: For more information about these files, refer to the Natural for Ajax documenta-
tion.

Select the XML tab to display the generated xml file. For example:
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The generated files are displayed in theNavigator view. For example:

3 Open the context menu in theNavigator view for the generated main program and adapter
files.
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4 SelectNaturalONE > Update.

At this point, you can:

■ Test the main program. For information, see Test the Generated Main Program.
■ Define user exits. For information, see Defining User Exits.
■ Edit generated source code that is not within user exits. For information about the protected
lines in the generated source code, see Using the Source Editor in Using NaturalONE.

Generate an Ajax Main Program from an Adapter File

There are two ways to create an Ajax main program:

■ Using standard Natural for Ajax functionality.
■ Using the AjaxMain Programwizard and an existing adapter file (.NS8 extension). This wizard
creates a main program that is similar to the standard one, except it includes support for user
exits (for protected code) and regeneration when the Ajax UI changes (which allows the fields
on a page to be updated without overwriting the user interface logic).

This section describes how to use theAjaxMain Programwizard to generate amain program from
an adapter file, as well as how to regenerate the generated program.

To generate an Ajax main program from an adapter file:

1 Open the context menu for the adapter file in theNavigator view.

2 Select Code Generation > Generate Ajax Main Program.

The Specify Ajax Program Details panel is displayed. For example:
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3 Type the name of the main program in Name.

Optionally, you can:

ProcedureTask

Type the name of the folder in Folder or selectBrowse to display awindow
listing the existing folders for selection. The folder must currently exist
within the selected Ajax project.

Note: This option allows you to generate modules into more complex
library structures (for example, "Natural-Libraries/my library
(MYLIB)/SRC"). When this option is not specified, the modules will be

Select a folder into which
to generate the program.

generated into the basic library folder (for example,
"Natural-Libraries/MYLIB/SRC", "Natural-Libraries/MYLIB/Subprograms",
etc.).

Type the name of the library in Library or select Browse to display a
window listing the existing libraries for selection. The library must
currently exist.

Note: The libraries listed for selection are based on the current project.

Select a library into which
to generate the program.

4 Select Finish to generate the main program.

The generated main program is displayed in the editor view. For example:
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The available user exits are displayed in theOutline view. For example:
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The generated program is also displayed in theNavigator view. For example:

5 Open the context menu for the generated main program in theNavigator view.

6 SelectNaturalONE > Update.

At this point, you can:
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■ Test the main program. For information, see Test the Generated Main Program.
■ Define user exits. For information, see Defining User Exits.
■ Edit generated source code that is not within user exits. For information about the protected
lines in the generated source code, see Using the Source Editor in Using NaturalONE.

Regenerate the Ajax Main Program

This section describes how to regenerate themain programfile (.NSP extension) thatwas generated
using the Ajax Main Program wizard.

To regenerate the main program:

1 Open the context menu for the program in theNavigator view.

2 Select Code Generation > Regenerate Using Wizard.

TheSpecifyAjax ProgramDetailspanel is displayed.After selecting Finish, themain program
is regenerated.

Or:

Select Code Generation > Regenerate.

The main program is regenerated without displaying the wizard panel.

Note: You can use standard selection techniques to select more than one file.

Test the Generated Main Program

To test the generated main program:

1 Open the context menu in theNavigator view for the generated main program file (.NSP ex-
tension).

2 SelectNaturalONE > Execute.

The page is displayed in the editor. For example:
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By default, the generated page displays row data in a table, where each field in the row PDA
is a column. All search key fields are displayed at the top of the page.

3 Select Search.

The results of the search are displayed. For example:
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Regenerate the Main Program

This section describes how to regenerate the main program file (.NSP extension).

To regenerate the main program:

1 Open the context menu for the main program in theNavigator view.

2 Select Code Generation > Regenerate Using Wizard.

For information, see Regenerate Using Wizard.

Or:

Select Code Generation > Regenerate.

For information, see Regenerate.

Regenerate Using Wizard

Use this option when you want to make changes to the wizard parameters before regenerating
the Ajax page.

To regenerate using the wizard panel(s):

1 Select Code Generation > Regenerate Using Wizard.

The first specification panel for the wizard is displayed. For example:
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2 Edit the specifications as desired.

If the page layout file (.xml extension) has changed since the previous generation, you can
selectGenerate to regenerate the page layout file as well.

3 Select Finish to regenerate the main program, adapter and, optionally, the page layout files.

4 Open the context menu in theNavigator view for the regeneratedmain program and adapter
files.

5 SelectNaturalONE > Update.

Regenerate

Use this option when the object-browse or object-maintenance subprogram has changed and you
want to incorporate the changes in the Ajax page.

To regenerate without using the wizard panels:

1 Select Code Generation > Regenerate.

Note: You can use standard selection techniques to select more than one file.

The main program (.NSP) file is regenerated without displaying the wizard panels and the
Generation Progresswindow is displayed. For example:
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2 Select Save to save the details.

3 Open the context menu in theNavigator view for the regenerated file(s).

4

5 SelectNaturalONE > Update.
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